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Welcome Message

Dear   Common First Year Students
Peace Be Upon You

We are pleased to present the revised edition of  the Computer Skills 
CT 101 book. We have tried to implement the recent best practices in 
curriculum designing while developing this book, and that comes in harmony 
with the KSU principles to pursue development and quality continuously.

You as a Common First Year student, the main target audience of this book, 
are responsible  for constructing your future, community and the country. 
This book can fulfill your requirements and exceed your expectations.

In order to gain the most of benefits of studying this course, you have to 
remember that your success depends on your strong will, persistence and 
accomplishment of all the activities of the curriculum. It also depends on 
your motivation through participation in your classroom, positive interaction 
with the Trainers, participating in individual activities and group work. Your 
success also depends on your punctuality and following up with all schedules 
and activities on the Deanship website. Thus, you are expected to actively 
participate in LMS and PCA classroom activities as well as completing the 
Self-Learning Project and other course tasks on time.

Dear Students,
While you are studying Computer Skills, please keep in mind that if you 

apply these skills in the appropriate way in your university studies and 
professional life, you will play an important role in developing your career 
and the nation. 

       Common First Year Deanship
       King Saud University
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In this Session you will get introduced with the Computer 
Skills Course (CT 101).

Introduction 
Session

INTRODUCTION OF COMPUTER 
SKILLS COURSE (CT 101)

OBJECTIVES

General Objectives

Specific Objectives

At the end of this session, you will understand:
 

•	 Introduction to Computer Skills Course  CT 101

• The Course Hours of CT 101 
•  Learning Resources for Computer Skills Course 
•  Assessment 
•  Grades 
•  Course Calendar
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 INTRODUCTION

Self-development skills department is pleased to issue this brief to students 
about computer skills course (CT 101). The introduction session includes 
details about the course, assessment and self-learning projects. Hence it is 
advised that students refer to this introduction session in case they have any 
queries about this course.

1. The Course Hours of CT 101

The table below shows the number of study hours and credit hours of the 
course.

Course Name Credit 
Hours

Total 
Classroom

Hours

Total Number 
of Weeks Hours/Week

CT 101 3 Hours 60 hours 15 weeks 4 Hours in 2 Sessions; 
2 Hours/Session

Students’ attendance is regularly conducted during the CT 101 sessions. As 
per the pledge signed by students in the very beginning of academic year 
that the attendance is mandatory for all students. Students are advised to 
abide this regulation and not to be late for the session and also to avoid 
exceeding the number of absence hours which will debar students to appear 
for the final examination.
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 2. Learning Resources for Computer Skills Course

2.1 The CT 101 Book

The primary resource is CT 101 book which covers the basic concepts 
and gives a very lucid and highly illustrated introduction to information 
technology. It also covers practical topics like Word Processing, Spreadsheets 
& Presentation graphics. Practical skills are demonstrated step by step in the 
form of pictures and screenshots with guidelines.
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2.2 The LMS and The Interactive Learning Electronic Package

It is one of the interactive learning resources for the Computer Skills Course 
(CT 101) which provides computer skills learning in a fun style. It provides the 
theoretical content of the course organized into units. As well as it presents 
the practical content in the form of recorded videos to enhance the students’ 
understanding for the required skills. It also provides questions, activities, 
and exercises. The student can visit the Interactive Learning Electronic 
Package and benefit from it at any time. It also provides discussion boards 
and forums in which the student can participate and ask questions or share 
their opinions. The Interactive Learning Electronic Package can be accessed 
through the following link:
                                                      
http://lms.ksu.edu.sa/ 
                                                   
or the link: 
http://lms.ksu.edu.sa/webapps/login

 

Fig: The Homepage for the LMS



23

In
trod

u
ction

The following screenshot shows the homepage for the Interactive Learning 
Electronic Package displaying the courses in which the student is registered.

  

Fig: The Homepage for the LMS showing the Courses Registered

As seen on the following screenshot, the Interactive Learning Electronic 
Package for the Computer Skills Course (CT 101) allows the student to see 
basic information about the course, course description, course objectives, 
study plan, theoretical and practical content of the course, study sessions 
as well as downloading them into the student’s computer. It also provides 
discussion boards and forums, as well as downloading/uploading assignments, 
solving practice exams, and checking results and grades.

Fig: The Homepage for the Interactive Learning Electronic Package in the LMS
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 3. ASSESSMENT

The overall Assessment includes:

1. Two Online Exams ( Mid-Term = 30 Marks  and  Final Term = 50 Marks)
2. Practical Continuous Assessment (PCA = 10 Marks)
3. Self Learning Project  ( 10 Marks )
 
The Following table elaborates the complete Assessment parameters.

Exam Pattern Details Marks

Mid-Semester Exam
(Online Exam)

Module 1 - All About Computers, 
             Internet & Microsoft Edge

30
Module 2 - Operating Systems               
                  (Windows 10)

Final Exam
(Online Exam)

Module 3 - Word Processing
                  (Word 2016)
Module 4 - Spreadsheets
                  (Excel 2016)
Module 5 - Presentation Graphics
                  (PowerPoint 2016)

50

Classroom Activity Practical Continuous Assessment 
(See section 3.2) 10

Self-Learning Project SL Project  (See section 3.3) 10

Total 100

Pass Percentage is 60% Overall
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3.1 Online Examinations

1. The Mid Semester Exam (30 marks) will be based on Module 1 & 2.
2. The Final Exam (50 marks) will be based on Modules 3, 4 & 5.

3.2 Practical Continuous Assessment (PCA)

These assignments are based on the content of the course and are very 
simple to complete. 
Table below is the distribution of total number of PCA questions for each 
module.

Topic No. of Questions

Module 1 - All About Computers & Internet 05

Module 2 - Windows 10 10

Module 3 - Word 2016 15

Module 4 - Excel 2016 15

Module 5 - PowerPoint 2016 10

Total 55

3.3 Self-Learning Project

Computer skills curriculum encourages students through self-learning to 
develop themselves and acquire additional skills. The trainer plays the role 
of a guide, he also urges students to search for the skill, information and 
teaches them basic concepts in an interesting way. At the end of this activity 
students have to submit a project based on the selected topic along with the 
project report document in MS Word format.

Students can work in group or individually based on their choice, they will be 
asked to select one of the following SL projects: Web Designing, Database 
Management System, Image Editing or another advance topic of student’s 
choice. 
The student project will be evaluated based on three parts:

•	Project’s	Report	(03	Marks)
•	Project’s	Content	(03	Marks)
•	Oral	Exam	(04	Marks)
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Project Report Evaluation Parameters:

The Project Report (Word 2016) will be evaluated on the basis of below 
given rubric;

Project Report – In Word

Description Marks

Cover Page (1 Page) 2

Auto-Table of Contents (1 Page) 2

Abstract / Introduction (1 Page) 2

Procedure and Project Description (At least 3 pages) 2

Result and References (1 Page) 2

Important Note: Total marks in the above rubric for project report is shown 
10, however it will be scaled down to 3 (i.e.; 30%)

Project Content Evaluation Parameters:

The Project Content will be evaluated based on the rubric given below for 
each topic;

Topic 1: Web Designing (Using HTML or Publisher)

Website Development

Description Marks

Web Pages (At least 5 Pages) 2

Appropriate Website Title 1

Relevant Web Page Background (Color/Image) 1

Images (At least 3 Images) 1

Forward and Backward buttons on each page 1

Home link on each page 1

Marquee effect (At least 1) 1

Tables (At least 1 table  with Appropriate content) 2
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Topic 2: DBMS (Using MS Access 2016)  
                          

Database Management System

Description Marks

Tables (At least 1 table) 2

Use of Primary key 2

Queries (At least 1 Query) 2

Forms (At least 1 Form) 2

Report (At least 1 Report) 2

 
Topic 3: Image Editing

Image Editing

Description Marks

Submission of Raw/Base image 1

Final copy of the file xcf format 2

Use of at least one blending option 1

Pictures Layers (At least 2 layers) 1

Adding a text layer (At least 1 layer) 1

Final processed image in JPEG/PNG Format 2

Black & white conversion of output image in PNG/JPEG format 2

Other Topic of Choice
Based on the recommendation from trainer and approval from dept. the 
rubric for other topic of students’ choice will be informed to students.

Important Note: Total marks in the above rubric for project content is 
shown as 10, however it will be scaled down to 3 (i.e.; 30%).
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Oral Exam Evaluation Parameters:

The Oral Exam will be conducted based on the following rubric;

Oral Exam

Description (Four questions for each student) Marks

To explain their part in documenting the project report 1

To describe their role/part in preparing the project 1

Technical Question 1 (based on topic) 1

Technical Question 2 (based on topic) 1

Time Plan for Project Preparation Phases

Number of Hours Week
 Phases of Project

Preparation

2 HoursWeek 5Project Introduction

2 HoursWeek 12Project Submission

Regulations for accepting late projects

Late Submission Consequences

Submission on Week 13 Deduction of 20% of the project marks, 
students get graded from 80%

Submission on Week 14 Deduction of 40% of the project marks, 
students get graded from 60%

After Week 14 Projects will not be accepted
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 4. Grades

Below table shows the grade with relevance to the range of marks scored at 
the end of the semester.

Total Marks (Out of 100) Equivalent Grade

95 to 100 A+

90 to 94 A

85 to 89 B+

80 to 84 B

75 to 79 C+

70 to 74 C

65 to 69 D+

60 to 64 D

Less than 60 F
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 5. Course Calendar
W

ee
ks

1
st

2
nd

3
rd

4
th

5
th

6
th

7
th

8
th

9
th

1
0

th
1

1
th

1
2

th
13

th
1

4
th

15
th

C
ou

rs
e 

S
es

si
on

s
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4
1

2
3

4

In
tr

od
uc

ti
on

 S
es

si
on

M
od

ul
e 

1 
A
ll 

A
bo

ut
 C

om
pu

te
rs

, 
  

In
te

rn
et

 &
 M

ic
ro

so
ft

 E
dg

e

M
od

ul
e 

2
O

pe
ra

ti
ng

 S
ys

te
m

s
(W

in
do

w
s 

10
)

IT
IC

 V
is

it
 (

B
as

ed
 o

n 
sc

he
du

le
 

st
ar

ti
ng

 f
ro

m
 w

ee
k 

3)

M
od

ul
e 

3 
W

or
d 

Pr
oc

es
si

ng
  

(M
S
 W

or
d 

20
16

)

R
ev

ie
w

 &
 P

ra
ct

ic
e

(M
id

-T
er

m
 E

xa
m

)

M
id

-T
er

m
 E

xa
m

S
el

f-
Le

ar
ni

ng
 I

nt
ro

du
ct

io
n

M
od

ul
e 

4 
S
pr

ea
ds

he
et

s
(M

S
 E

xc
el

 2
01

6)

S
el

f-
Le

ar
ni

ng
 P

ro
je

ct
 

S
ub

m
is

si
on

M
od

ul
e 

5 
Pr

es
en

ta
ti
on

 G
ra

ph
ic

s
(M

S
 P

ow
er

Po
in

t 
20

16
)

R
ev

ie
w

 &
 P

ra
ct

ic
e 

(F
in

al
 

Ex
am

)

Pr
ac

ti
ca

l C
on

ti
nu

ou
s 

A
ss

es
sm

en
t 

(P
C
A
) 

Fi
na

l E
xa

m



31

S
e
ssio

n
 1

 
GENERAL CONCEPTS ABOUT COMPUTERS & HARDWARE

Module One

ALL ABOUT COMPUTERS,
 INTERNET AND MICROSOFT EDGE

Session 1: General Concepts About Computers & Hardware

Session 2: Computer Networks, Internet & Information Security

Session 3: Microsoft Edge & Using Email
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GENERAL CONCEPTS ABOUT COMPUTERS & HARDWARE

GENERAL CONCEPTS 
ABOUT COMPUTERS & HARDWARE

Session
1

In this session, you will get introduce to General Concepts 
about Computers and Computer Hardware.

General Objectives

At the end of this Session, you should be able to understand:

•	General Concepts about Computers.
•	What is a Computer?
•	Special Features of a Computer
•	How does a computer work? 
•	Types of Computers
•	Common Uses of Computers in everyday life

•	Computer Hardware.
•	What is Computer Hardware?
•	Input/Output Devices
•	The System Unit
•	 Secondary Storage Devices

Specific Objectives

OBJECTIVES
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 GENERAL CONCEPTS ABOUT COMPUTERS

Today, Computers play an increasingly important role 
in our daily life. Computers are affecting every sphere 

of human activity and bringing about many changes in 
industry,	 government,	 education,	 medicine,	 scientific	
research, arts, painting and even entertainment and 
gaming. 

Therefore,	 it	 is	 beneficial	 for	 every	 person	 to	 know	
about	computer,	its	uses,	benefits	and	how	to	utilize	it	in	
personal & professional life.

 WHAT IS A COMPUTER ?

A Computer is an electronic device that accepts Input (data and instructions),  
Processes it, and produces Output as required.

Thus a computer is capable to receive user instructions, process the instructions, 
and provide the desired results back to the user. The diagram below depicts the 
operation of a computer system.
When we enter : 1 , + , and 2 as Input. The computer will process the input and 
display 3 as output.

 SPECIAL FEATURES OF A COMPUTER 
The interesting feature of a computer is that it is programmable, i.e., it can be 
programmed and used for a variety of tasks that usually require human resource. 
Thus a computer can be thought of as a replacement for many of the human 
tasks. Further, these tasks are done with following features that make computers 
so special:

•	 Speed – Computers perform tasks in less than a millionth of a second.
•	 Accuracy – Computers perform tasks without any mistake.
•	 Attentiveness – Computers perform tasks and repeat them thousands of 

times without getting bored or tired unlike human beings.
•	 Huge Storage – Computers facilitate storing huge amount of data/ 

information in highly compact devices.

LEARNING
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GENERAL CONCEPTS ABOUT COMPUTERS & HARDWARE

HOW DOES A COMPUTER WORK?
Computers	are	multipurpose,	amazingly	fast	&	accurate;	
but how do they do that? Computers are built to carry out a 
variety of instructions, such as Add, Subtract, Divide (that 
even a basic Calculator does), Read/Write a character, 
Compare numbers/characters, Logical operations like 
AND, OR, NOT, etc. Capability of performing even a 100 
such instructions makes a powerful computer.
A computer system has various components that work 
together to  accomplish a task.
It has two main components:Hardware and Software.

HARDWARE
Hardware consists of all the physical equipments 
that are tangible in a computer system.

These are the actual physical devices that perform the 
tasks. Hardware includes Keyboard, Mouse, Screen, 
Microprocessor, Memory, Hard disk, etc. Different 
Hardware parts will be discussed later in this session.

otware
SOFTWARE

Computers	can’t	do	anything	on	their	own,	they	need	specific	step-by-step	
instructions or directions to perform any task.

Software is a Set of Instructions (Programs) that 
tells the computer what to do. It directs and controls 
operations of the computer so that the desired task 
is done.
 
Whatever you do on a computer, a particular 
Software is required for that purpose.

For example, if you want to write a letter using 
computer, you need a Word Processing Software 
like MS Word 2016. Similarly, Windows 10 
Software is required to entirely control and manage 
the operations of the computer. 

Unlike hardware, software is not a physical entity.
It is set of instructions processed by computer hardware.

There are two types of software: System software and Application 
software. 
A software specially designed to Control and Manage hardware devices is 
called System software. In Module 2, it is discussed in detail.
Application software is a program, or group of programs, designed for end 
users	to	perform	specific	tasks.
In Module 3, it is discussed in detail.
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 TYPES OF COMPUTERS

Based	on	 its	speed	and	size,	computer	systems	are	usually	classified	 into	 three	
types:

•	 Super Computers.
•	 Mainframe Computers.
•	 Microcomputers.

In  this section, you will learn about Supercomputer and Mainframe computer, 
followed by Microcomputers in detail.

SUPERCOMPUTERS

A Supercomputer	 is	a	computer	 that	has	complex	hardware	configuration	
with	high-level	computational	capacity.	 It	 is	useful	when	a	huge	amount	of	
data needs to be processed in a short time.

A	Supercomputer	is	mostly	used	for	scientific	and	engineering	purposes,	such	
as	weather	forecasting,	bio-medical	research	and	large-scale	chemical	analysis	
in laboratories, etc.

MAINFRAME COMPUTERS

A Mainframe computer is a large central computer with 
more memory, storage space, and processing power, but is 
generally less powerful than a supercomputer. 

Mainframes	are	used	by	large	organizations	for	large-scale	
jobs.For example, insurance companies use mainframes to 
process information about millions of policyholders.

A Mainframe computer is capable of supporting hundreds, 
or even thousands, of users simultaneously.

Supercomputer Shaheen-II - The Pride of Saudi Arabia
Cray XC40 Shaheen-II is the seventh fastest supercomputer in the world according to the TOP500 list in 
July 2015. Shaheen-II is the most powerful supercomputer in the Middle East. It’s owned and operated by 
King Abdullah University of Science and Technology (KAUST). Built in partnership with Cray Inc.Shaheen II 
is intended to enable KAUST Faculty and Partners to research both large and small-scale supercomputing 
projects, from inception to realization.

TIP



37

S
e
ssio

n
 1

 
GENERAL CONCEPTS ABOUT COMPUTERS & HARDWARE

MICROCOMPUTERS

The Microcomputer	has	a	compact	Hardware.	It	is	small	in	size	and	the	most	
commonly used type of computer. It is affordable and very useful for almost 
every business and individual for a variety of tasks.

Microcomputers	are	further	categorized	as	below,	
based	on	the	size	of	hardware:	

•	 Desktop Computer or Personal Computer 
(PC). 

•	 Laptops or Notebooks.
•	 Tablets and Smartphones.

In 1981, IBM came up with first personal computer known as IBM 5150.projects, from inception to realization.

TIP

Desktop Computer or Personal Computer (PC)
A Desktop Computer is designed for use by one 
person at a time on a desk. A typical Desktop 
Computer system hardware consists of a System 
Unit Cabinet and Input/ Output devices attached 
to it. It is also called as Personal Computer (PC) 
as	it	can	be	personalized	and	used	according	to	
an individual user either at home or in business. 
It is used for general purposes, which range 
from	office	 tasks	 to	browsing	 the	 internet	and	
playing games. 

Laptop Computer or Notebooks
A Microcomputer, small enough to be carried and 
used anywhere keeping on laps, is known as a 
Laptop. Also commonly known as Notebook, it 
has similar hardware components as a desktop 
computer, but in a compact form. 

Tablets and Smartphone 
Tablets are thin mobile computers in the form 
of	a	single	hand-held	device	with	a	touchscreen	
display.

The touchscreen display uses recognition of a 
finger	or	a	stylus	touch	(gestures)	to	receive	user	
input, thus replacing the mouse and keyboard, 
used in desktops or laptops.

A Smartphone is similar to a tablet PC, but smaller 
in	size	and	has	the	functions	of	a	cellular	phone	
as well.
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It	provides	easy	Internet	browsing,	personal	organizer,	checking	emails	and	
many useful everyday applications. Nowadays, a smartphone has many 
features to match the ability of a microcomputer.

Tablets	are	typically	larger	than	smartphones	with	a	screen	size	of	7	inches	
(18 cm) or larger.

COMMON USES OF COMPUTERS IN DAILY LIFE
Computers have entered into almost all areas of our life and are greatly helpful 
in	various	fields.	Following	examples	brief	how	computers	are	changing	our	lives.

USE OF COMPUTERS IN EDUCATION
Computers	 have	 become	 essential	 in	 the	 field	 of	 Education;	 for	 Students,	
Instructors and Educational Administrators. Computer Based Training (CBT) 
is now very common in education. CBT is also being used in business and 
other	organizations	for	various	purposes,	such	as	training	employees	on	new	
products or procedures.

Following are some of the uses of computers in education:

•	 Teachers use computers for instructing students to achieve easy 
understanding of concepts, such as using PowerPoint slides.

•	 Use of the Learning Management System (LMS) e.g., Blackboard, for 
excellent	management	of	Teaching-Learning	Processes,	such	as:

•	 Planning and keeping track of learner progress.
•	 Collecting student’s assignments. 
•	 Enabling students to learn new skills at any time on their own pace.
•	 By the use of graphics, audio, video, etc., learning contents are more 

interesting, interactive and easy to understand.
•	 Computers are especially transforming the Testing & Evaluation process 
from	 traditional	 paper-based	 examinations	 to	 the	 advanced	 Online	
Examinations.

•	 E-libraries	 and	 Computer	 based	 Library	 Management	 System	 have	
changed the studies, research and teaching approach.
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USE OF COMPUTERS IN GOVERNMENT SERVICES
Government	 offices	 use	 computers	 to	 manage	 different	 office	 tasks	 like	
documentation, calculation, analysis, generate reports, online communications 
and various government transactions. Some common examples of 
Government transactions using 
computers are:

 • Absher System	 –	 to	 facil- 
itate online Government 
services like Passport services, 
MOI	Services,	etc.	Govern- 
ment Services Registration 
System.

•	 Government	License	Managem- 
ent Services.

•	 Electronic Payment of various 
government fees. 

The use of computers in government services has  made various transactions 
with government very easy and perfect.

USE OF COMPUTERS IN AIRLINE SERVICES
The use of computers in Airlines has made the travel easy, quick & economic. 
Many Airlines and other Web Services offer easy online Flight Search with 
various facilities, like:

•	 You	can	compare	&	choose	the	best	suitable	flight.
•	 Manage your reservation, e.g. seat selection or other services.
•	 Online	Web	check-in. 

USE OF COMPUTERS IN BANKING SERVICES
Computers play a vital role in banks. They are reliably used by bank employees, 
eliminating	the	use	of	paper	files.	
They are conveniently used by 
bank customers reducing the 
need of physically going to the 
bank. 

Online	banking	has	revolutionized	
most banking transactions with 
just	on-screen	clicks.
Following are common uses of computers in Banks:

•	 Banks use computers to keep track of customers and their account 
information.

•	 Computers	help	tellers	to	record	all	banking	transactions,	analyze	them	
and prepare reports.
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USE OF COMPUTERS IN MEDICAL SERVICES
Computers are used in hospitals due to their reliability and accuracy. Several 
things	in	medical	field	have	been	simplified	with	the	help	of	computers	such	
as Open Heart Surgery.

Examples of the use of computers 
in medical services are:

•	 Diagnosis
•	 Prescription & Treatment
•	 Surgeries
•	 Monitoring and Analysis
•	 Hospital Management, 

Patient Records & Health 
status,etc. 

•	 Billing and Financial System.

COMPUTER HARDWARE

You know that a computer system comprises of Hardware & Software. In this 
section, you will explore basic microcomputer hardware parts.

WHAT IS COMPUTER HARDWARE?
As discussed, the Computer Hardware is the actual physical equipment that 
performs dedicated tasks. It is important to know about each part of computer 
system, how it works and its features.

A typical computer system 
hardware includes:

•	 Input/ Output 
devices

•	 The System Unit
•	 Storage devices

INPUT/OUTPUT DEVICES

How do you give data to a computer? How do you get information from it? How do 
computers interact with people? We input text and even speech into a computer, 
but never think about the relationship between what we enter and what the 
computer processes. We understand languages that consist of letters, numbers, and 
punctuation marks. However, computers can understand only the Binary Machine 
Language consisting of only 0 and 1. 
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INPUT DEVICES
Input devices translate numbers, letters, and actions that we understand 
into a form that computers can process.

For example, while writing a letter on a computer, you use the Keyboard to 
enter text and the Mouse to give commands.

While there exists a variety of input devices, the following are some of the 
basic and commonly used input devices.

Keyboard
A computer keyboard resembles a common 
typewriter style device. It is an input device 
used to enter alphabets, numbers and special 
characters,	as	well	as	keys	for	specific	functions.	
A keyboard is connected to a computer system 
using a cable or a wireless connection.
Keyboards on Notebook Computers are usually inbuilt. They are smaller in 
size	and	normally	do	not	have	a	separate	numeric	keypad	as	available	in	the	
desktop keyboards.

Mouse
A	Computer	Mouse	is	a	small	hand-held	pointing	
device which controls movement of a Cursor or 
Pointer on a display screen. It allows users to 
control	 and	 direct	 computers,	 select	 on-screen	
options, etc.

A  Mouse usually has two buttons, a scroll wheel 
and uses laser or a ball, to control the movement 
of the pointer. While the mouse is usually connected to a system unit with a 
cable, wireless mouse have become common these days.

Scanner
Scanner is used to scan information such as 
photographs and documents and translate it 
into a digital image. 

There are different types of scanners, but the 
flatbed	 scanners,	 as	 shown	 in	 the	picture,	 are	
commonly used.

Microphone
A Microphone is an audio input device that 
converts sound signals into a form that can be 
processed by a computer.

A mic is commonly used with computers to record 
audio or communicate over the Internet.

Further, it can also be used to direct & control computers (to some extent) 
using a Voice Recognition System. It also enables us to enter text into 
computers by directly speaking into it, which is termed as ‘Speech-to-text.
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OUTPUT DEVICES
Output devices are used by the computer 
system to give us the output. They receive 
data from a computer and produce output 
through monitors, speakers, printers, etc. 
For example, a printer produces information 
in the form of a hard copy printout.  Another 
example of an output device is a computer 
monitor, which displays an image that is 
stored in a computer.

Monitors and printers are two of the 
most common output devices used with a 
computer.

Monitor
A Monitor is similar to a TV screen. It 
converts the information processed by the 
computer into visual images and displays it 
to the user.

The output of a Monitor is referred to as a 
soft copy. 

Printer
A printer enables you to take the information 
processed by the computer on to paper.
Printer output is called a hard copy.

Speakers/Headphones
Speakers or Headphones are the audio 
output devices, that play sound output from 
a computer.For example, playing an audio 
file,	text-to-speech,	system	notifications,	etc.
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THE SYSTEM UNIT
The System Unit, also known as System Cabinet, is 
a container housing most of the electronic components 
that make up a computer system. It has three important 
components i.e., A Motherboard, Central Processing 
Unit (CPU) and Memory.

MOTHERBOARD
Motherboard, also known as system board, is the 
communication medium for the entire computer 
system.	 It	 is	 a	 flat	 circuit	 board	 where	 every	
hardware component, such as CPU, Memory, Hard 
disk, etc. are connected. 
All hardware devices communicate with one another 
through the motherboard.

CENTRAL PROCESSING UNIT (CPU)

The Central Processing Unit (CPU), also known as 
Microprocessor of a computer,  is an electronic 
chip that carries out the instructions of a computer 
program. It performs the basic arithmetical, logical, 
and input/output operations of a computer system. 
The CPU is like the brain of the computer.

It consists of two parts: Control Unit (CU) and 
Arithmetic-Logic Unit (ALU).

Control Unit (CU)
The	Control	Unit	controls	the	rest	of	the	computer	system	to	carry	out	specified	
instructions. It controls the movement of signals among CPU, memory, and 
other devices.

Arithmetic-Logic Unit (ALU)
The	 Arithmetic-Logic	 Unit	 performs	 arithmetic	 and	 logical	 operations.	
Arithmetic operations are the basic mathematical operations like Addition, 
Subtraction, Multiplication, and Division. Logical operations of ALU 
include logical comparisions such as Greater than (>), Less than (<), Equal to 
(=)	and	also	True	or	False	statements	-	AND,	OR,	NOT,	etc.
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PRIMARY MEMORY
Before instructions can be processed by a CPU, 
they are stored along with other data in computer 
memory. Computer memory is the storage space 
in a computer where data is processed and stored. 
All computers have some amount of memory 
consisting of chips. Memory is measured in terms 
of bytes.

What are Bytes, KB, MB, GB, TB, PB?

As discussed earlier, computers understand only Machine Language or Binary 
Language consisting of only 0s and 1s. A ‘0’ or a ‘1’ is called a Binary digit 
or Bit in short. 8 Bits make 1 Byte: similarly 1,024 bytes make 1 KiloByte 
(KB). Please refer the table below for all units of memory measurement .

Units of Memory Measurement

Unit Description
Bit (Binary Digit) 0 or 1
Byte (B) 1 B = 8 bits
KiloByte (KB) 1 KB = 1024 B
MegaByte (MB) 1 MB = 1024 KB
GigaByte (GB) 1 GB = 1024 MB
TeraByte (TB) 1 TB = 1024 GB
PetaByte (PB) 1 PB = 1024 TB

TYPES OF PRIMARY MEMORY
There	are	two	well-known	types	of	memories	available	in	computer	systems:	
Random-Access	Memory	(RAM)	and	Read-Only	Memory	(ROM).

RAM
Random-Access	Memory	(RAM)	holds	programs	
(instructions) and data currently required by 
the CPU to process. RAM is called temporary or 
Volatile storage as everything in RAM is lost 
when the computer is switched off. When we save 
a	file	in	a	computer	(e.g.	a	letter)	it	is	copied	from	
the RAM and stored onto a permanent storage 
device, like the hard disk of the computer. Thus, 
the RAM functions as a scratch pad memory to 
save the information temporarily.

Most computers today are equipped with at least 4 GB of RAM. Extra memory can 
be added to a computer by plugging new memory chips inside the system unit.
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ROM
Read-Only	Memory	(ROM)	is	a	permanent	memory	
having	built-in	programs	from	the	manufacturer.	
ROM chips contain instructions for booting of the 
computer.

Unlike RAM, ROM is non-volatile i.e., data in 
ROM is not lost when the computer is turned 
off. The information in ROM can’t be deleted or 
modified.

Comparison of RAM vs ROM 

RAM ROM

Currently running programs 
(instructions) and data are kept in 
RAM by the CPU

It comes with your computer 
and	is	pre-written	to	hold	special	
instructions for starting the 
computer.

It	requires	flow	of	electricity	to	
retain data.

It	retains	data	without	flow	of	
electricity.

It is a volatile memory. It	is	a	non-	volatile	memory.

SECONDARY STORAGE DEVICES
Every computer should have the ability to store 
information for long period of time even after the 
computer has been switched off. This is achieved by 
the Secondary Storage devices. There is a variety of 
such secondary storage devices, like Hard disks, CDs, 
Flash Drives, etc.

HARD DISK 
The hard disk is the main secondary storage device 
in the computer system. It permanently stores 
software	 and	 data	 files.	 There	 are	 two	 types	 of	
Hard Disks:

•	 Internal Hard Disk (Installed within the 
System Unit) and

•	 External (Portable) Hard disk
Usually, a Hard Disk has a storage capacity of 500 
GB or more.
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COMPACT DISC (CD)
Compact Disc (CD) is one of the most widely 
used secondary storage media based on optical 
format. There are three basic types of CDs: CD-
R, CD-ROM, and CD-RW. 

CD-R (Compact Disc – Recordable)
These are CDs, which are recordable only once, 
can be read several times,  but can’t be erased. 
It	is	used	to	save	data	files	and	programs.	Their	
storage capacity ranges between 650 MB to 700 
MB.

CD-ROM (Compact	Disc-Read	Only	Memory)
CD-ROM	 has	 the	 data	 imprinted	 by	 the	
manufacturer. These are used to distribute 
large software applications, video games, 
user guides, etc.

CD-RW	(Compact	Disc-Rewritable)
CD-RW	 allows	 erasing	 of	 previously	 recorded	
information and writing (recording) of new 
information on the same physical location.

DIGITAL VERSATILE DISC (DVD)
DVDs are similar to CDs, except that they have 
a different format with high storage capacity 
ranging from 4.7 GB to 17 GB. Like CDs, DVDs 
are also in the form of DVD-R, DVD-ROM & 
DVD-RW.

FLASH DRIVE
These are removable and rewritable storage 
devices, which allow you to copy, transfer and 
erase data several times.

Flash drives are available in different storage 
capacities. Generally, its storage capacity ranges 
from 1 GB to 2 TB.
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Choose the correct option for the following statements.
1. Another name for a desktop computer is________. 

a.   Mainframe computer

b.   Tablet PC

c.   Personal computer

d.   Parallel computer

2. Which one of the following is not an input device? 

a.   Scanner

b.   Mouse

c.   Keyboard

d.   Speaker

3. This	 part	 tells	 the	 rest	 of	 the	 computer	 system	 to	 carry	 out	 specified	
instructions.

a.   Arithmetic Logical Unit

b.   Control Unit

c.   Microphones

d.   Read Only Memory

4. RAM stands for ________.

a.   Random Active Memory

b.   Random Access Memory

c.   Read Access Memory

d.   Real Access Memory

ACTIVITIES

Activity 1
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Fill in the blanks with the appropriate words provided in 
the box.

RAM CPU CD-R CD-RW ROM

1.		________has	built-in	programs	from	the	manufacturer.	

2. ________ is recorded once but can be read several times.

3. ________is often termed as the “brain” of a computer.

4. Everything in ________ is deleted when the computer is switched off.

Choose TRUE or FALSE for the following statements.
1.	A	Microcomputer	 is	used	for	 large-scale	chemical	analysis	 in	 laboratories.

(  ) TRUE

(  ) FALSE

2. The next unit of data storage after the Petabyte (PB) is the Terabyte (TB).

(  ) TRUE

(  ) FALSE

3. RAM is called temporary (or volatile) storage because everything in RAM is 
lost when the computer is switched off.

(  ) TRUE

(  ) FALSE

4. Microcomputers are the fastest and the most powerful computers in the 
world.

(  ) TRUE

(  ) FALSE

Activity 2

Activity 3
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In this session, you will be introduced to Networks, the 
Internet and Information Security.

General Objectives

At the end of this session, you should be able to understand:

•	Computer Networks
•	What is a Computer Network? 
•	Benefits	of	Networking	
•	Classification	of	Networks

•	Internet 
•	Overview of the Internet
•	Uses of the Internet

•	Information Security
•	Passwords
•	Malicious Software
•	Backup
•	Copyrights

Specific Objectives

COMPUTER NETWORKS, 
INTERNET & INFORMATION SECURITY

Session
 2

OBJECTIVES
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In this session, you will be presented with information about computer networks, their 
benefits	and	types.

WHAT IS A COMPUTER NETWORK? 
A Computer Network is a communication system that 
connects two or more computers so that they can 
exchange information and share resources. The most 
well-known	computer	network	is	the	Internet.

BENEFITS OF NETWORKING 
The	 two	main	 benefits	 of	 computer	 networks	 are	 exchanging	 information	 and	
sharing of resources.
•	 Exchanging Information – This is the process of sending and receiving 

information in a computer network. For example, sending and receiving 
e-mails,	business	and	other	documents	etc.

•	 Sharing of Resources – This means sharing of software resources like 
applications,	files,	data	and	information	or	sharing	of	hardware	devices	such	as	
printers, storage devices, etc. For example, if there is a printer connected to a 
computer network, all the computers in the network can use the same printer.

CLASSIFICATION OF NETWORKS
Computer	networks	are	 classified	 into	different	 types,	based	on	 the	 following:
•	 According to the network’s Transport Media (Wired and Wireless).
•	 According to the network’s Geographical Area (PAN, LAN, MAN and WAN).
•	 According	to	the	network’s	Management	System	(Peer	to	Peer,	Client-Server).

TYPES OF NETWORKS - ACCORDING TO TRANSPORT MEDIA  
There are two types of networks based on the medium used to transport the 
data: Wired Networks and Wireless Networks.

Wired Networks
These computer networks are connected by 
wires or cables to transfer data, information and 
files.	
For	example,	fiber	optic	cable,	co-axial	cable,	etc. 

COMPUTER NETWORKS

LEARNING
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Wireless Networks
These computer networks do not use wires or 
cables for connection. Instead, these networks use 
air as the transport medium to transfer information, 
data	and	signals.	For	example,	Wi-Fi	networks,	the	
Cellular networks, etc.

TYPES OF NETWORKS - ACCORDING TO GEOGRAPHICAL AREA

Networks can cover anything from a handful of devices within a single room to 
millions of devices spread across the entire globe. Based on the geographical 
area a network is serving, there are four types of networks: PAN (personal 
area network), LAN (local area network), MAN (metropolitan area network) 
and WAN (wide area network).

Personal Area Network (PAN) 
A personal area network (PAN) is the interconnection 
of devices within the environment of an individual, 
for example, connecting cell phones, PC’s and 
printers	 through	 Wi-Fi,	 Bluetooth	 or	 infrared	
signals.

Local Area Network (LAN)
A local area network (LAN) is a computers network 
that interconnects computers within a limited area 
such as a residence, school, laboratory, university 
campus	 or	 office	 building.	 LAN	 can	 span	 over	 a	
limited distance up to one mile.

Metropolitan Area Network (MAN)
These networks are considered larger than LAN as 
they connect several LANs in the same city and are 
usually	used	to	connect	organizations,	companies,	
banks and government agencies. MAN can span 
over a distance up to 100 miles.

Wide Area Network (WAN)
Wide area network (WAN) is a countrywide or 
worldwide network, which covers distances greater 
than 100 miles. It uses microwave relays and 
satellites to reach users over long distances. The 
widest of all WANs is the  Internet, which spans the 
entire globe. 
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TYPES OF NETWORKS - ACCORDING TO
THE NETWORK MANAGEMENT SYSTEM
Network	 management	 is	 the	 process	 of	 managing,	 organizing,	 controling	
and monitoring the network system. Based on network management, there are 
commonly	two	types	of	networks:	client-server	networks and peer to peer networks.

Client-Server Network
Client-server	 network	 systems	 use	 one	
computer (server) to coordinate and supply 
services to other computers (clients) in 
the network. The server provides access to 
resources such as web pages, databases, 
application software, and hardware. 

Peer-to-Peer Network
	A	peer-to-peer	network	system	doesn’t	have	
a central computer (server). All nodes have 
equal authority and can act both as clients 
and	servers.	For	example,	when	a	file	passes	
through many computers on a network, these 
computers act as both server and client.

 
OVERVIEW OF THE INTERNET  

The	term	“Internet”	 is	derived	from	the	word	inter-networking,	which	means	
connecting different networks together.

WHAT IS THE INTERNET?
The Internet can be termed as a network of 
networks. The Internet is the global network 
system of private, public, academic, business and 
government networks.

HISTORY OF THE INTERNET

The origin of the Internet dates back to between 1960 and 1970, when the 
United States Department of Defense began a project on computer networks. 
This project was named ARPANET (Advanced Research Projects Agency 
Network). Gradually, after 1970, universities, government departments and 
research centers also began using this network.
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MODERN INTERNET
By 1993, the concept of the Internet had 
changed completely. Instead of having a central 
system of limited machines, new independent 
centers were created in different places. This led 
to the birth of the modern Internet.

USES OF THE INTERNET
There	are	a	large	number	of	uses	of	Internet	for	various	purposes,	such	as	e-mail	
(electronic	mail),	e-commerce	and	e-banking,	instant	messaging	and	many	more.	
The following are some of the common uses of Internet.

AS A SOURCE OF INFORMATION
Today the Internet has become the main source for information in almost 
all areas of life. Information about everything can be accessed through 
the Internet. Business, education or any activity in everyday life relies on 
internet for information.

SHOPPING
Online	shopping	 is	one	of	the	fastest-growing	Internet	applications.	Using	
the Internet, you can purchase products and services from different websites 
and	online	stores	such	as	Amazon,	Souq,	E-Bay,	etc.

ENTERTAINMENT
Entertainment in different forms is available over the Internet. You can 
choose from a variety of entertainment options available on the Internet that 
suit your interests, such as playing online games, social networking, etc.

EDUCATION
E-Learning,	or	education	with	the	Internet,	has	made	it	possible	for	everyone	
to	learn	flexibly	from	anywhere	anytime.	Online	courses,	virtual	classrooms,	
online discussions and online learning management systems (LMS) are 
commonly-used	nowadays.

COMMUNICATION
Communication	 is	 the	 most	 commonly-used	 application	 of	 the	 Internet.	
Electronic	communication	(e-communication)	refers	to	sending	and	receiving	
information electronically through electronic devices. The information can be 
text messages, documents, images, audios, videos, etc.
Some	 examples	 of	 e-communication	 are	 e-mail,	 instant	 messaging	 
(or chatting), social media messaging, and image sharing.
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INFORMATION SECURITY

We have information stored in our computers or 
on the Internet, but is it safe and private?

There are various information security procedures 
to ensure that  our information is safe, protected, 
private, accurate and available. 

The following are some of the information security 
procedures that we should understand and practice.

THE PASSWORD
A Password is a set of characters (letters, numbers and special characters) used 
to get access to a computer, web page, network resource or data.

TIPS FOR CREATING PASSWORDS
Creating a strong password is the responsibility 
of the owner. Below are the recommendations for 
creating a strong password:

•	 The	password	should	be	difficult	to	guess.
•	 The password should not be less than the 

length of 8 characters.
•	 The password should contain a mixture of numbers, letters and special 
characters	(such	as	*	,	-	,	/	,	!	,	@	,	#	,		etc.).

•	 The password should not contain the user's name.
•	 The password should not contain the user’s personal information, such 

as name, street address, phone number, date of birth etc. 

TIPS FOR THE USE OF PASSWORDS

•	 Do not share your passwords with others.If you are provided with a 
new	password,	change	it	immediately	after	you	use	it	for	the	first	time.

•	 Change your passwords periodically.
•	 Do	not	use	the	same	password	everywhere	such	as	e-mail,	bank	account,	etc.
•	 Do not keep a written record of passwords	on	a	paper	or	in	an	e-mail	message.
•	 Avoid using the “Remember Password” option everywhere.

MALICIOUS SOFTWARE
Malicious software, also known as Malware, is any 
program	or	file	that	is	harmful	to	a	computer	or	the	
privacy of users. The harm done by malware can vary 
from something slight as changing the author’s name 
on a document to full access of your machine without 
being traced.
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TYPES OF MALICIOUS PROGRAMS
Malware	types	can	be	categorized	as	follows:

•	 Viruses
•	 Worms
•	 Spywares
•	 Trojan Horse

Viruses
A computer virus is a malicious program that 
attaches	itself	to	a	file	or	a	program,	enabling	it	
to	 spread	and	 infect	different	files.	Viruses	 can	
be	 transmitted	 as	 attachments	 to	 an	 e-mail	 or	
in	 a	 downloaded	 file.	 Viruses	 are	 attached	 to	
an	 executable	 file,	which	means	 the	 virus	may	
exist on a system but will not be active or able to 
spread until a user runs or opens the malicious 
host	file	or	program.

Worms
Worms are standalone malicious software and 
do not require a host program or human help to 
spread. It replicates its functional copies and can 
consume system memory and network bandwidth, 
which in turn slows down or causes failure of the 
computer/network system.

Spywares
Spyware	is	classified	as	privacy-invasive	software.	The	most	common	spyware	
function is to steal personal information and address book (identity theft and 
keystroke-logging).	It	hijacks	the	browser	and	redirects	it	to	advertising	web	
pages.

Trojan Horse
A Trojan is another type of malware. It is a harmful 
piece of software that looks genuine. Users are 
typically tricked into loading and executing it on 
their systems. After it is activated, it can achieve 
any number of attacks on the host, from irritating 
the user (popping up windows or changing 
desktops)	 to	 damaging	 the	 host	 (deleting	 files	
or activating and spreading other malware). 
Trojans are also known to create back doors to 
give malicious user access to the system.
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HOW MALICIOUS SOFTWARE ENTERS YOUR COMPUTERS 

Malicious software usually enters our computers through the following ways:

•	 Removable storage devices.
•	 Email attachments.
•	 Internet downloads.

Other Malicious Activities
Hoaxes
A hoax is a false warning about a computer virus. Typically, the warning arrives 
in	an	e-mail	note.	These	kinds	of	email	notes	pretend	that	they	are	from	IBM,	
Microsoft or other genuine companies. A number of hoaxes have warned users 
that	vital	system	files	are	viruses	and	encourage	them	to	delete	those	files,	
possibly damaging the system.

Phishing
Phishing	 is	 an	 un-authorized	 attempt	 to	
obtain vital information such as usernames, 
passwords, and credit card details by hackers 
masked as  trustworthy entities in an electronic 
communication. Often the attackers use fake 
e-mails	or	websites	in	an	attempt	to	scam	the	
user into surrendering private information.

HOW TO PROTECT YOUR COMPUTERS FROM MALICIOUS SOFTWARE

To stay protected from malicious software: 

•	 Be aware of common virus symptoms and the ways they attack.
•	 Be aware of suspicious, new process names in the list of running processes.
•	 Avoid	using	 the	 “auto-run”	option	 in	Windows	OS	 for	portable	drives.
•	 Use	 anti-spyware	 software,	 anti-virus	 software and scan and update 

regularly.
•	 Always	be	wary	of	strange	e-mails,	especially	ones	with	attachments.
•	 While	browsing	the	 internet,	always	confirm	what	you	click,	download	

and install.
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THE BACKUP
Backup is the activity of storing multiple copies of 
important	 files,	 databases	 or	 software	 so	 that	 the	
information is preserved in case of computer failure, 
hard disk crash or other disasters.

WHERE CAN I BACKUP MY FILES
Personal computer users can back up important data in two ways: Local 
Backup & Internet Backup (cloud storage).

Local Backup
This is backing up data on an external hard disk, 
CD,	flash	drives,	etc.

Internet Backup (Cloud Storage)
This is backing up of data onto several servers on the internet.
Many cloud storage services offer a free limited storage space, which is 
commonly enough for most users.

The	following	are	the	benefits	of	backing	up	data	on	a	cloud	storage:

•	 The	ease	of	sharing	files.
•	 The	ease	of	managing	files	&	data	through	
hand-held	mobile	applications.

•	 Reducing the costs of backups and data 
maintenance.

•	 Examples of cloud storage service providers:
•	 Drop Box – offers up to 2 GB free space 

from DropBox
•	 Google Drive- offers up to 15 GB free 

space from Google
•	 OneDrive-	 offers	 up	 to	 15	GB	 free	 space	

from Microsoft
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 COPYRIGHT
Copyright is the ownership of an intellectual property within the limits prescribed 
by a national or international law. This ownership protection is available for both 
published and unpublished works.A copyright law grants ownership rights to the 
owner exclusively. These rights include:

•	 To reproduce the work.
•	 To prepare derivative works.
•	 To distribute copies.
•	 To perform the work.
•	 To display the work publicly.

A copyright notice should contain the following three elements:

•	 The symbol ©  (the letter C in a circle), the word “Copyright” or the abbreviation 
“Copr.”

•	 The year of the copyright.
•	 The name of the owner of the copyright.

Example:  © 2018 King Saud University
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.

1. A ________ is the interconnection of devices within the environment of      

an	individual	through	Wi-Fi,	Bluetooth	or	infrared	signals.

a. Personal Area Network (PAN)

b. Local Area Network (LAN)

c. Metropolitan Area Network (MAN)

d. Wide Area Network (WAN)

2. A ________ connects within a limited area such as a residence, school or 

office	building.

a. Personal Area Network (PAN)

b. Local Area Network (LAN)

c. Metropolitan Area Network (MAN)

d. Wide Area Network (WAN)

3. ________	is	classified	as	privacy-invasive	software.

a. A Virus

b. A Worm

c. A Trojan Horse

d. Spyware

4. ________is a harmful piece of software that looks genuine.

a. Trojan Horse

b. Spyware

c. Phishing Scam

d. Hoax
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Activity 2

Fill in the blanks with the appropriate words provided in 
the box.

  Worms Trojans Peer-to-Peer Spyware Password

1.  A ________ is a set of characters used to get access to a computer, web page 
or network resource.

2. 	 ________are	known	to	create	back-doors	to	give	malicious	users	access	to	
the system.

3.  ________ are standalone malicious software and do not require a host 
program to spread.

4.  A ________system doesn’t have a central computer.

Activity 3

Choose TRUE or FALSE for the following statements.
1. Wireless Networks do not use wires for connection. 

(  ) TRUE

(  ) FALSE

2.		Malicious	software	is	any	program	or	file	that	is	not	harmful	to	your	
computer.                                    

(  ) TRUE

(  ) FALSE

3.		A	peer-to-peer	network	system	has	a	central	computer	 to	coordinate	and		
supply services to other computers in the network.                                          

(  ) TRUE

(  ) FALSE

4.  Internet Backup involves backing up of data onto several servers on the
    internet.

(  ) TRUE

(  ) FALSE
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MICROSOFT EDGE & USING EMAIL

 In this session, you will learn about Microsoft Edge and
Using Email.

General Objectives

At the end of this Session, you should be able to understand:

•	Microsoft Edge
•	What is WWW?
•	What is a Browser?
•	Introduction to Microsoft Edge
•	Navigating the web using Edge
•	Features of Microsoft Edge
•	Finding Information on the Web

•	 Using Email
•	What	is	an	E-mail?
•	Spam

Specific Objectives

MICROSOFT EDGE AND USING EMAILSession
 3

OBJECTIVES
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Before you start working with Microsoft Edge, you should understand some 
basic concepts about WWW, URL, browsers, etc.

WHAT IS WWW?

The World Wide Web (WWW) is a network of interlinked pages of information, 
spread all over the world and accessible through the Internet.
Information on the Internet is presented as webpages. 

A Webpage consists of text, graphics, audio, video, etc.

A Website is a group of webpages related to a subject 
and resides full time on the Internet.

A web page has links or hyperlinks to other web 
pages of the same or different websites.

A home page is the main page or the opening screen of a website and provides 
brief overview of its contents.

UNIFORM RESOURCE LOCATOR (URL)

Each website or a webpage has a distinct and unique address on the internet. 
This address or name of the website is known as the Uniform Resource 
Locator or URL in short. An example of a URL is  

http://www.google.com

Parts of a URL
A URL starts with the name of communication Protocol (http://) followed by 
the Sub-domain (www.), then the Domain name (google) and ends with 
the Domain code (.com).

Common Domain Codes:

.com  :  Commercial website

.org		 :	 	Organization	website

.edu  :  Education website

.gov  :  Government website

.sa  :  Saudi Arabia (country)

LEARNING

MICROSOFT EDGE
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WHAT IS A BROWSER?
Generally, users access the Internet and browse 
through World Wide Web (WWW) with a Web Browser. 
A Browser is a Software that connects to the Internet 
and brings information from several parts of the world 
to your computer screen. 

Commonly used browsers include Microsoft Edge, 
Google Chrome, Safari, Mozilla Firefox, etc.

Thus, to open a website on your computer, you 
have to provide its name or URL to the Browser. The 
Browser takes this URL from its address bar, locates 
the website on the Internet and displays the home 
page onto your screen.

INTRODUCTION TO MICROSOFT EDGE
Microsoft Edge is the latest web browser released 
with Windows 10 by Microsoft. Speed, Security, and 
Simplicity are the main features of Microsoft Edge. 

Edge is in fact a Universal Application, which means 
you can use it on any Windows		device;	your	PC,	tablet	
or on your smartphone.

It has many interesting and useful features that give 
you an enjoyable browsing experience.
 

Starting Edge

To Start Edge,
1  Simply Click on the Edge tile from 

the Start Menu, Or
2  Click on Microsoft Edge from the all 

programs list in the Start Menu.
A  The Edge Start window comes up 

on your screen.

1

2
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EDGE USER INTERFACE

Edge is designed to provide a simple and clean user interface with minimal 
distractions. The picture shows the sleek user Interface of Edge. It mainly has:

A  A Search or Address box 
in the middle,

B  Edge Controls Toolbar at 
the top, and

C  Top site tiles for handy 
access to the widely 
used websites.

NAVIGATE THE WEB USING EDGE

This section will guide you to browse and navigate the web pages using Microsoft 
Edge.

OPENING A WEBSITE IN EDGE

To open a website, follow the steps given below:

1  Enter URL of the website 
into the Address box, and

2  Hit the Enter Key or Click 
on the Go button 
( ) at the right end of 
the box.

A

A
B

C

1 2



65

S
e
ssio

n
 3

 
MICROSOFT EDGE & USING EMAIL

For example, open the King 
Saud University website by 
entering the URL 

 www.ksu.edu.sa 

EDGE CONTROLS TOOLBAR

Once a webpage is displayed, the Edge Controls Toolbar becomes Active on 
the top. It helps you to navigate through webpages easily.
Edge Controls Toolbar has the following:

A  Back, Forward Buttons         Allows you to navigate back and forth through 
                                            the visited pages.

B  Refresh Button               Allows you to update and display the latest
                                             contents of the webpage.

C  Address Box                  Displays the URL of the current webpage. 
                                              You can also click  and type to open another  
                                             URL from here.

D  Reading View                    Opens the current webpage in Reading view,     
                                             if it supports.

E  Add to Favorites                Add to favorite icon.

F  Favorites Hub           Opens the Favorites Hub pane.

G  Web Note                        Allows you to annotate (write notes) on the    
                                             current webpage.

H  Share                      Allows you to share the webpage with others.

I  More Actions                Opens the More Actions pane.

A B C D E F G H I



66

Module One: ALL ABOUT COMPUTERS, INTERNET & MIRCROSOFT EDGE

FAVORITES HUB 

If you often visit a web page, you can add it to your Edge Favorites for easier 
and quicker access.

Adding a webpage to Edge Favorites

To add a webpage to Edge Favorites, follow 
the steps given below:

1  Open the webpage, Click the Add to 
Favorite icon ( ) on the Edge toolbar.

2  Choose a Name.
3  Choose Save In – Favorites

     or Favorites Bar.
4  Click the Add button.

Opening the Edge Favorites List

To open Edge Favorites List, follow the steps 
given below:

1  Click the Hub icon ( ) on the Edge 
toolbar.

A  The Favorites Pane appears on the 
right side, which contains all your 
favorite webpages. 

Delete or Rename an item from the Edge 
Favorites List

To Delete (or Rename) an item from the Edge 
Favorites list, follow the steps given below:

1  Just Right Click on the item,
2  Choose Delete (or Rename.) 

1

2

3

4

1

A

1

2
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Pinning a webpage as tile in Start Menu
To Pin a web page as tile in the Start Menu, follow 
the steps given below:

1  Click on the More Actions Icon ( ) on the 
right end of the Edge toolbar

2  Choose the Pin this page to start.

SETTING A HOME PAGE IN EDGE

By default, Edge starts with its Start Screen. You can change Edge to open 
with	Previous	Pages	or	a	specified	page	or	pages.

To change the homepage in Edge, follow the 
steps given below:

1  Click on More Actions icon.
2  Choose Settings.
3  In the Open Microsoft Edge with box, 

choose one of the following:
          Start page
          New tab page
          Previous pages
										A	Specific	page	or	page
4  If you choose A	Specific	page	or	pages,	

Enter a URL in the a text box that appears 
and Click on the Save icon ( ) next to it.

To open multiple webpages in different tabs, at the startup (Home 
page), you can click on " + Add new page" button, which appears after 
adding a specific webpage as Homepage.

TIP

1

2

1

2
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 A  Similarly, you can decide whether to “Open new tabs with” either  
Topsites,  Suggested contents, or simply A blank page.

FEATURES OF MICROSOFT EDGE
This section will guide you through some of the new and useful features of Microsoft 
Edge.

TABBED BROWSING

Edge provides the Tabbed browsing interface, which is now a common feature 
in most of the web browsers. This allows you to open multiple websites in 
the same Microsoft Edge window. So you open each website in a tab and can 
quickly switch between open websites by simply clicking on the tabs at the top.

Creating a New tab
To create a new tab, follow the step given below:
1  Click the New tab plus sign “+” in the tabs bar at the top of the Edge window.
A  The new tab appears with the default contents.

You can enter the URL to open the website.

Keyboard Shortcut 

To create a new tab, Hit  → Ctrl + T

TIP

3

4

A

1

A
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Opening a Link in a New Tab
To open a link in a new tab, from within an open webpage tab, follow the 

step given below:
1  Right-Click on the link, and choose Open in new tab.

      A new tab will be added in the tabs bar and the link will be opened in it,
					while	you	continue	surfing	on	the	same	webpage	tab.
     You can click on the newly created tab to view its contents. 

Opening a link in a new Edge Window
To open a link in a new Edge Window, from within an open webpage tab, 

follow the step given below:
2  Right-Click on the link, 

and choose Open in 
new window. 

The link will be opened on 
a new Edge window 
and it becomes your 
active Edge window. 

Closing a tab
To close a tab, follow the 

step given below:
1  Click the Cross sign  “ X ” to the right side of the tab. 

     The tab will be disappear and you go to the previous tab.

 

If you have multiple open 
tabs and you are closing the 
Edge window, it will ask you 
for	confirmation	
“Do you want to close all 
tabs?”.
You can disable it by choosing 
Always close all tabs.

1

2

1
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IN-PRIVATE BROWSING

Web browsers keep track of the websites you visit, information you enter 
and even your credentials, in order to provide a faster browsing experience. 
To ensure your information and credentials aren’t available to other people 
who use the same computer, Edge provides the InPrivate browsing session.
In other words, you can restrict Edge from tracking your browsing and 
credentials information by using an InPrivate browsing session. When using 
InPrivate browsing, Edge opens a separate window, which doesn’t track your 
browsing info or credentials. Even the sites you visit do not appear in the 
history list.

To start an InPrivate browsing session, 
follow the steps given below:

1  In the Edge window, click the More 
actions icon to open the More 
actions menu.

 2  Click the New InPrivate window.
A new InPrivate Browsing window 

appears.

      Keyboard Shortcut : To open a new InPrivate Browsing window, Hit  → Ctrl + Shift + P

TIP

WEB NOTE

An exciting feature of Edge is the Web Note. It allows you to annotate (draw 
and write on) a snapshot of the webpage by using the annotate tool. You can 
then save or share the annotated webpages. 

To create a Web Note, follow the step given below:

1  On the Edge toolbar, click the Make a Web Note button.

Edge converts the webpage to a screenshot and displays an annotation 
toolbar at the top of the page.

Although	 the	 buttons	 on	 the	 Annotation	 toolbar	 are	 self-explanatory,	 the	
following is a short summary of the functions of each button. 

1

2

1
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A  Pen      Allows you to draw on the webpage with desired ink color         
																					and	point	size.
B  Highlighter	Allows	you	to	highlight	with	desired	ink	color	and	size.																
C  Eraser        Allows you to erase any ink you have drawn or “Clear all ink”  
D  Add a note  Allows you to add a typed note on any area in the webpage
E  Clip      Allows you to take a screen clipping of an area of the  

                     webpage.
F  Save          Allows you to save your web note in your Edge favorites 

                     hub or  any Notes application.
G  Share        Allows you to share your web note
H  Exit       Allows you to end your annotation on the page and continue
                     browsing.

                      

READING VIEW

Edge has a Reading view that hides the detracting elements and displays the 
current	webpage	as	it	might	appear	in	an	e-book	reader	so	that	you	can	focus	
on the contents.
 
Reading view becomes available only after Edge loads all the webpage content, 
including advertisements. Reading view is available only for some webpages. 
It isn’t usually available for website homepages, online commerce sites, or 
webpages that don’t contain much text.

The reading view icon on the 
Edge toolbar becomes activated 
or deactivated based on whether 
the reading view is supported for 
the current webpage.

You can also change the Reading view style or Reading	view	font	size from 
the Edge Settings pan.

FINDING INFORMATION ON THE WEB
As you know, there is a vast ocean of information available on the World Wide 
Web.	Searching	for	a	specific	information	is	often	a	challenge.	Search	Services	
such as Google or Bing search, help you to quickly locate what you are looking 
for on the web. 

A B C D E F G H
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SEARCH SERVICES

A web search can be done either by providing a keyword 
(or a phrase) to a Search Service or by browsing through 
a directory of topics it provides. However, the keyword 
search is the most common, easiest and quickest.

In a keyword Search, you enter a keyword or a phrase that 
describes what you are looking for on the web, to a Search Service.

The Search Service has a special 
program, called Search Engines, which 
accesses the databases of World 
Wide Web around the world.
It then matches the websites that 
has the information related to the 
keyword you have provided and gives 
you a list of such websites.
You can then identify the most 
suitable website from the list.

Google Keyword Search provides an 
option of Advanced Search, which 
allows	you	to	be	more	specific	in	search	
and get only the appropriate results. In 
advanced search, you can provide the 
Search Engine with different values in 
addition to a keyword, such as region 
or country,	 language,	 file	 type,	 etc.

USING THE SEARCH BOX OF EDGE

The Address bar of Edge serves as a “Search Box” as well i.e., you can perform 
a web search right from the Edge address bar. This eliminates the need to 
open	a	Search	Engine	specifically	for	that	and	enter	the	keyword.	

When you enter a URL in Edge address bar, Edge opens the website. If you 
enter a search keyword (or an incorrect URL) in the address bar, Edge initiates 
an online web search by using its default Search Engine and displays the 
result of the web search.
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Setting the default Search Engine in Edge
You can change the default search engine of Edge to any Search Service that 
uses the OpenSearch technology.

In Microsoft Edge, open the website of the Search Engine you want and 
follow the steps given below:

1  Click on the More actions icon.
2  Choose Settings. The Settings pane appears.
3  Scroll down and Click on View advanced settings button.
4  Scroll down and Click on the Change search engine to display the list 

of search engines.
5  Select your search engine from the list and Click on Set as default button.

If the list doesn’t include your Search Engine, make sure that you have opened 
the Search engine site in Edge and that it uses OpenSearch technology.

 

USING EMAIL

You know that the Internet is widely used for communication. 
Although there are different forms of communications possible 

over	 the	 internet,	 e-mail	 (Electronic Mail) is, by far, the most 
reliable method. 

It	provides	a	fast	and	efficient	alternative	to	the		traditional	mail.

WHAT IS E-MAIL?
E-Mail,	short	for	Electronic	Mail,	is	an	electronic	form	of	sending	and	receiving	
letters across the Internet. It is a modern way to communicate with friends, 
family, and colleagues.

An email message is like a regular letter, but it’s composed electronically and 
delivered almost immediately via the Internet.

1

2
3

4
5
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 BENEFITS OF EMAIL

The	following	are	some	of	the	various	benefits	of	using	email	for	communication.

•	 Accessible Anywhere at Any Time, You can access it from any 
computer or mobile device that has an Internet connection.

•	 Privacy Your email is delivered to your own personal and private account 
(mailbox) and a password is required to access and view emails.

•	 Easy Mail Management Email service providers have tools that allow 
you	to	file,	label,	prioritize,	find,	group,	and	filter	your	emails	for	easy	
management. You can even easily control spam, or junk email. 

•	 Communication with Multiple People You can send an email to multiple 
people at once, which gives you the option to include as many people as 
you	want	in	an	e-mail	conversation.	

•	 Productivity Tools Email is usually packaged with a calendar, address 
book, instant messaging, and more offer convenience and productivity.

•	 Access to Web Services If you want to sign up for an account like 
Facebook	or	order	products	from	services	like	Amazon,	you	will	need	an	
email	address	so	you	can	be	safely	identified	and	contacted.

      ACCESSING AND MANAGING E-MAIL

A variety of email service providers are available over the internet. Most of 
them provide access to email through Web Mail Service or by Email Client 
Application. 

Web Mail Service
The most popular is the Web Mail Service, which offers to manage all your 
emails online through web based access. The basic email management is 
free by almost all email service providers whereas you need to pay for some 
advanced email management features. Some of the examples of web mail 
services are Gmail, Hotmail, Yahoo Mail, AOL mail, etc.

To	use	the	web	e-mail	service,	you	need	
to register with the email provider. This 
is commonly referred to as the Sign 
Up process, which involves choosing a 
username & password for your email 
account, entering your general information 
to the email provider, and accepting the 
Service Agreement with the email provider.
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Email Client Application
Another way to access your emails is by 
downloading all your emails to your 
computer by using a special email 
software which provides a variety of email 
management features as well. The email 
software	 uses	 the	 Post	 Office	 Protocol	
(POP3) Service provided by the email 
provider to access and manage emails.
 
The	email	software	allows	you	to	work	offline	on	your	emails	and	can	connect	
to the Internet only to Send and Receive emails.
 
Examples of such email software are MS Outlook 2016 and Windows Mail 
which	offer	to	configure	and	manage	your	multiple	email	accounts	at	one	
place.

E-MAIL ADDRESS

To receive emails, you need an email account and an email address. Also, if 
you want to send emails to other people, you will need to obtain their email 
addresses.

An email address has a standard format which everyone has to follow. The 
format	of	the	Email	addresses	includes	a	Username,	the	@	symbol,	and	the	
Domain name.

The Username is a unique name that you choose to identify yourself with 
the email provider.

The Domain name is the website name of 
the email provider that hosts your email 
account. 

For example, if gmail is your email 
provider and your user name is ksu1957, 
your email address will be:  

BASIC ELEMENTS OF AN E-MAIL MESSAGE

A	 typical	 e-mail	message	 has	 three	 basic	 elements:	 Header,	 Message	 and	
Signature.

Header
The header of an email message consists of the following elements:

 • Address
   This section includes the email addresses of the Sender and the Receivers. 

It usually has “To” box where we enter the primary receiver’s email 
address. You can enter multiple email addresses if you have to send an 
email to multiple recipients.

 • Subject
		This	is	a	one-line	description	used	to	present	the	topic	of	the	message.
 • Attachment
		You	can	attach	files	such	as	documents	and	pictures	to	a	mail	message.
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Message body
This is the actual message for the recipient.

Signature
The	signature	line	at	the	bottom	of	the	message	identifies	the	sender.

You can set a signature that is automatically inserted at the bottom of every 
message you send.

Typically,	in	official	emails,	Signature	includes	the	sender’s	name,	designation	
and contact information. 

SPAM    
Email spam, also known as junk email or unsolicited bulk email (UBE), refers to 
the use of electronic messaging systems to send out unrequested or unwanted 
messages in bulk. It may be advertising goods or services, or even warning of a 
new supposed “virus”. Spam email may also include malware as scripts or other 
executable	file	attachments.

SPAM BLOCKER

Spam Blocker is computer software that is 
designed to identify and eliminate spam or junk 
mail and prevent those messages from getting 
to	a	user’s	inbox.	The	Mozilla	Thunderbird	e-mail	
program which is available for free download at 
“www.mozilla.com”	 comes	 with	 built-in	 spam	
blocking software. Spam blocker is also known 
as	spam	filter.

CAN-SPAM ACT

In	the	United	States	of	America,	the	CAN-SPAM	
Act has been enacted which requires that every 
marketing-related	 e-mail	 provides	 an	 opt-
out option. When the option is selected, the 
recipient’s address is to be removed from future 
mailing lists.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.

1. WWW stands for __________________.

a. Wide World Web

b. World Wide Web

c. Web Wide World

d. World Wide Website

2. URL stands for____________________. 

a. Uniform Resource Locator

b. Universal Resource Locator

c. Universal Receive Location

d. Uniform Rescue Locator 

3. Which one of the following is not a web browser?  

a. Microsoft Edge

b. Mozilla	Firefox

c. Microsoft Word

d. Safari

4. Which of the following is the keyboard shortcut for creating a new tab?

a. Ctrl + T

b. Ctrl + Shift + T

c. Ctrl + Shift + P

d. Ctrl + N
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Fill in the blanks with the appropriate words provided in the 
box.

Web Note Microsoft Edge Reading View Edge Toolbar Home Page

1. A _______ is the main page or the opening screen of a website.

2. _______ is the latest web browser released with windows 10 by Microsoft.

3. _______ feature of Edge lets you annotate a snapshot of the webpage.

4. The ______ feature of Edge displays the current webpage as it might 

appear	in	an	e-book	reader.

Activity 3

Choose TRUE or FALSE for the following statements.
1. You cannot Delete or Rename items from the Edge Favorites list.

(  ) TRUE

(  ) FALSE

2. While using InPrivate browsing, Edge opens a separate window that 

doesn’t track your browsing info or credentials.

(  ) TRUE

(  ) FALSE

3. Post	Office	Protocol	(POP3)	email	service	can	download	mails	onto	your	

computer.

(  ) TRUE

(  ) FALSE

4. Spam Blocker is designed to identify and eliminate spam or junk mail.

(  ) TRUE

(  ) FALSE

Activity 2
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Windows 10 & Exploring Windows 10
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Windows

Session 6: Managing Folders, Files, and Computer Settings
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OVERVIEW OF OPERATING SYSTEM,
GETTING STARTED WITH WINDOWS 10 

& EXPLORING WINDOWS 10 
Session

4

OBJECTIVES

In this session, you will learn about the Overview of 
Operating Systems and Getting Started with Windows 10.

General Objectives

At the end of this session, you should be able to understand 
and practice:

•	The Overview of Operating Systems
•	System Software
•	Operating System(OS)
•	Popular Operating Systems 

•	Getting started with Windows 10
•	Introduction to Windows 10 
•	New features of Windows 10

•	Exploring Windows 10
•	Signing in to Windows 10
•	Exploring the Windows 10 PC Screen
•	Exploring the Taskbar
•	Exploring the New Start Menu
•	Exploring the Windows 10 Tablet Screen

Specific Objectives

OBJECTIVES
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OVERVIEW OF OPERATING SYSTEMS         
In Module 1, you learnt that there are two types of Software; System Software 

and Application Software. In this section, you will learn about the System 
Software. Application Software will be discussed in detail in Module 3.

 SYSTEM SOFTWARE
A software specially designed to Control and Manage hardware devices is called 
System Software. It is usually a collection of programs that handle technical 
details of computer operations. It mainly works in the background and requires 
little or no user interference.

Operating System is the most common System Software, which entirely controls 
and manages a computer system, such as PC, Laptop, Tablet, Smartphone, etc.

Another example of System Software is a Device Driver software, which controls 
the operations of a particular device, such as Printer Driver software.

 OPERATING SYSTEM (OS)
An Operating System is like a backbone of a computer 
system. It controls and manages the entire operations 
of a computer. All computers, tablets and smartphones 
need an Operating System to function properly.  

Windows 10, MAC and Android are common examples of 
Operating Systems.

MAIN FUNCTIONS OF OPERATING SYSTEM
Every computer has an Operating System that performs a variety of tasks to 
manage and facilitate its operations. Some of the common functions of an 
Operating System are as follows: 

  Manage Resources
An Operating System coordinates all the resource (or devices) of a computer 
system such as; Memory, Processor, Storage devices, Monitors, Printers, etc.  
It also monitors system performance, scheduled jobs, provides security and 
starts up the computer.

LEARNING
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Provide User Interface
While working on computers, mostly you 
interact with the Operating System that 
provides a way to control computers. 
The way you interact with computers 
is termed as the User Interface. 
Almost all newer operating systems use 
a Graphical User Interface (GUI), 
which involves the use of a pointing 
device to point and select from the on 
screen graphical elements such as icons, 
buttons, menus, dialog boxes, windows, 
etc. GUI makes it easier to work on a 
computer, even for a novice user.

Many older operating systems use 
a character based interface called 
Command Line Interface (CLI), 
which involves typing written commands 
to computers.

Run Applications   
The Operating System loads and runs 
applications (or apps), such as Microsoft 
Edge or MS Word. Most Operating systems 
support multitasking, which allows to 
run multiple apps simultaneously and 
switching between them. 
                                          

 POPULAR OPERATING SYSTEMS
There are several Operating Systems developed by various Companies and 
Individuals. They are being used widely for Micro and Mainframe computers. Some 
of the popular Operating Systems in the world are as follows:

MICROSOFT WINDOWS

Microsoft’s Windows is by far the most 
popular operating system for PCs. Most 
of the desktop applications are developed 
to run under windows as compared to any 
other OS. Windows comes in different 
versions and was initially designed to run 
with Intel or Intel-compatible processors.

Windows 10 is the latest release from 
Microsoft, which has a modern user interface and supports the tablet computing 
as well.



Module Two: Operating Systems (WINDOWS 10)

84

APPLE MACINTOSH (MAC)
Apple Macintosh, commonly known as 
MAC OS,	 is	actually	the	first	Operating	
System to provide the GUI. It is designed 
to run with Apple computers. It is not as 
widely used as the Windows OS; thus 
fewer applications have been developed to 
run on MAC OS. It is a powerful, easy-to-
use operating system that is popular with 
professional graphic designers, desktop 
publishers, and many home users.

LINUX

Another famous name in the operating 
systems category is Linux. The specialty 
of Linux is that it’s an Open Source OS, 
which means it is freely distributable. 
It can be customized and used with 
different types of computers, tablets or 
smartphones.

ANDROID
Android is one of the Linux based 
operating systems developed by Google 
and the Open Handset Alliance (OHA), 
a coalition of more than 30 hardware, 
software and telecom companies. It is 
designed primarily for mobile and touch 
screen devices such as Smartphones 
and Tablets. Android’s User Interface 
is mainly based on touch gestures that 
correspond to real world actions, such as 
swiping, tapping and pinching along with 
a Virtual keyboard for text input.

Android is now the most popular mobile OS providing lots of exciting 
features. Its open nature has encouraged a large community of developers 
to develop android based applications (or apps). Thus, Google Play Store has 
over a billion of android apps.
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GET STARTED WITH WINDOWS 10

By now, you have got a basic understanding of an operating system and 
information about the different operating systems available in the market. In 

this section, you will study and work with Windows 10 Operating System.

INTRODUCTION TO WINDOWS 10  
Windows 10 is the latest version of Microsoft’s Windows operating system. It 
is a major shift from the previous versions of Windows. It has been essentially 
modernized to support the touch devices and pen input. Lots of enhancements 
and useful new features have been added to it. The following parts will take you 
through the Windows 10 Operating System.

SIGNING IN TO WINDOWS 10 
 To	interact	with	Windows	10,	you	need	to	first	pass	through	a	security	gate	
– the Sign-In screen or Welcome Screen. You need to have a user account, 
which can be a local account that exists only on your computer or an online 
Microsoft account.

Usually, you have a Lock 
screen, when you turn ON 
or return back to your PC. 
To sign in to Windows, 
you need to dismiss the 
Lock Screen by clicking 
anywhere or pressing any 
key on the keyboard. You 
get the Welcome screen 
with the Username and 
Picture of the most recent 
user account in the center 
along with a Password 

entry box. A list of user 
accounts on the computer are shown in the lower left corner. You can click on 
any of these to choose and bring it to the center.

To Sign In, enter your password in the box below the account name and press 
Enter key (or click on the Arrow button to the right of the password box.)
If you have not set a password for your user account, a Sign in button will 
appear below your account name.

 NEW FEATURES OF WINDOWS 10 
Once	you	Sign	in,	you	are	in	the	all	new	Windows	10	environment.	You	should	first	
go through the new features Microsoft has come up with. Some of the interesting 
and exciting new features of Windows 10 are as follows:
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NEW START MENU
Windows 10 has a new Start menu. Microsoft 
has changed the Start Menu based on the 
experiences and feedbacks from the users. 
The Start Menu is now more comprehensive, 
efficient	and	modern.
The new Start Menu has a tile based Start 
screen along with the classic features of Start 
Menu. The tiles on the Start menu can display 
live contents making it an intuitive Start.
You can customize the new Start Menu right on its 
place, such as resizing tiles or start menu itself, 
and Pin or Unpin applications to Start Menu.

WINDOWS INK
As the world is moving towards the mobile 
and touch based computing, Windows 10 has 
introduced the Windows Ink feature. It allows 
you to use pen input in different apps or 
annotate on snapshot of your current screen. 
If you have a touch screen device, the 
Windows	Ink	icon	appears	in	the	Notification	
Area of the Taskbar by default. Otherwise, 
to activate it, you need to Right-Click on 
the Taskbar and choose “Show Windows Ink 
workspace button.”
When you click on Windows Ink icon, a side 
bar of the Windows Ink workspace appears, 
which usually has the following options: 

A  Sticky Notes: Allows you to create brief 
sticky notes by using pen tools such 
as adding a schedule reminder. Windows 
uses character recognition (or handwriting 
recognition) to read your sticky notes.

B  Sketchpad: Enables you to create free 
hand drawings with pen tools and save 
it	as	an	image	file.

C  Screen Sketch: Allows you to draw or 
annotate on snapshot of the current screen.

    Get More Pen Apps: You can click on 
“Get more pen apps” link to open the 
windows store and download desired 
pen apps.

D

B

A

C

D

TIP
If you don't have a touch screen device, you can't create handwritten Sticky 
Notes by using mouse.
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VIRTUAL DESKTOPS
Another useful feature Microsoft 
has provided with Windows 10 is 
the Virtual Desktops. This gives 
you the experience of working 
with multiple screens; although 
having just one.

So while you work on multiple 
apps, you can better organize 
them with multiple Virtual 
Desktops. You can group your 
personal apps together in 
one desktop and work apps 
in another. You can Add New 
Desktops as you want and switch 
between them easily.

The Task View button on the taskbar helps you manage your Virtual Desktops. 
You can easily move running apps from one desktop to another with just  the  
Right Click of the mouse.

Interestingly, if you close a Virtual Desktop, the apps that were running on it 
won’t be closed, rather they will be shifted to the previous available desktop.

LOCK SCREEN
When you turn on your computer, 
the	first	screen	you	meet	is	the	
Lock Screen. It is a new style of 
Windows 10 to have a pleasant 
curtain over the Log In Screen. 
When your computer is locked, 
instead of just showing the 
boring Log In Screen, Windows 
10 has made it more attractive 
and useful with the new Lock 
Screen.

Once you click or hit any key from  
the keyboard, the Lock Screen 
goes off and the Log In Screen 
appears, where you enter your credentials to get access to the computer.

By default, the Lock Screen displays the system Time and Date.
You can customize the Lock Screen in different ways.
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NOTIFICATION & ACTION CENTER
Windows 10 provides you a new way to manage 
all	 your	notifications	 in	one	place.	The	Notification	
and Action Center is the place where Windows 10 
displays	 notifications	 about	 recent	 events	 on	 your	
computer.  

These events can be an incoming email message, 
security alerts, updates and more.  It collects alerts 
from	apps	and	then	smartly	notifies	you.

The Action Center also offers a quick way to toggle 
connectivity options and other settings such as 
display brightness and contrast. 

CORTANA OR SEARCH

Cortana is another enhancement in Windows 
10. Cortana is a voice-activated personal digital 
assistant, which provides relevant suggestions 
and alerts. The more you use Cortana, the more 
personalized your experience will be.

For	example,	you	can	use	Cortana	to	find	files/apps	on	computers,	search	the	
internet, send emails, help out with navigation, setting reminders, and more.

Cortana is available only in certain countries or regions. Cortana is accessible 
from the Search box at the taskbar right next to the Start button. You can 
command Cortana by either typing in the search box or by clicking on the 
mic button to talk to Cortana. You can also say “Hey, Cortana” to activate mic 
input for Cortana. 
 
When Cortana is not available, it’s replaced with the Windows Search, helping 
you	to	search	for	apps,	files,	folders,	and	settings	on	your	computer.
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 EXPLORING WINDOWS 10 

You are now ready to explore Windows 10 more closely. The topics in this 
section will help you to explore each user interface element of Windows 10, 

such as Desktop, Taskbar, and Start Menu.

EXPLORING THE WINDOWS 10 PC SCREEN
Once you Sign In, you land on the Windows 10 PC Screen. It is the place where 
you interact with Windows 10. It hosts the tools you use most often while working 
with your PC. Basically, the Windows 10 PC Screen has: 

A  The Desktop: The major part of the Windows 10 interface screen is 
the Desktop. As the name suggests, it is like your home or work desk, 
where you organize your stuff. Similarly, on Windows 10 Desktop, you 
can	organize	your	files,	folders	or	apps	in	the	form	of	Icons.			

     You can personalize your Windows 10 desktop to suite your preferences, 
as you personalize your home or work desk. Thus, you can auto arrange 
Icons on the Desktop, change the Desktop Wallpaper, etc. You will learn 
to personalize the Desktop later in Session 5.

B  Icons: The Desktop has several Icons. An Icon is a small graphical 
picture	that	is	linked	to	a	file,	a	folder,	or	an	application.	Double	clicking	
an Icon opens the object it is linked with. If you want to place an Icon 
on your Desktop, you can drag it from its location to the Desktop.

     By default, the Windows 10 desktop has a Recycle bin icon. The Recycle 
Bin	is	like	a	system	folder	on	your	computer.	When	you	delete	a	file	or	
folder on your PC, it is usually shifted to the Recycle bin. You can double 
click on the Recycle bin icon to open and manage its contents. The 
items you see in the Recycle bin cannot be directly opened or used, but 
they can be Restored to their original locations. 

B

A

C
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C  The Taskbar: At the bottom of the Desktop, a wide horizontal bar, which 
has a Windows Start button to the left and time and date to the right is 
the Taskbar. The name Taskbar explains itself, it is the place where you 
keep track of all your running tasks. 

 

 EXPLORING THE TASKBAR 
When you start a task in Windows 10, its icon appears on the Taskbar with an 
underline. For easy access, you can permanently pin an Icon to the Taskbar by 
right clicking on it. The icons without underline on the taskbar are the ones pinned 
but are not currently running.

Moving mouse pointer over an underlined Taskbar Icon shows a Snap of the 
current contents of the task window.

The contents of the Taskbar from the left are:
A  Start Button: It allows you to open the Start Menu. 
B  Search button:	It	opens	the	Search	box	where	you	can	Search	for	files,	

folders, apps or settings on your computer or interact with Cortana.
C  Task View button: It opens the Task View display, which shows all the 
running	tasks/	apps	in	small	windows.	It	allows	you	to	easily	switch	
amongst	the	running	tasks/apps.	You	can	close	an	app	directly	in	the	
task view as well.

The Task View is also the place where you can create and manage your 
Virtual Desktops.

Whereas,	the	right	side	of	the	taskbar	has	the	Notification	Area,	containing:

 D  Notifications	icon:	It	notifies	you	of	the	system	and	app	events	such	
as new emails arrived or system updates are installed. Clicking on the 
Notification	icon	opens	the	Notification	and	Action	Center	pane.

 E  Time & Date display: It shows the current Time and Date. Clicking on 
it	displays	the	Calendar	pane.	To	Adjust	date/time	of	your	computer,	
you can click right on the Time & Date icon. This will open the Date 
and Time settings.

F  Active Language icon: It shows the currently active language. Clicking 
on	it	allows	you	to	switch	between	available	languages	or	to	configure	
Language preferences.

     Keyboard Shortcut to switch between available languages: Windows 
Key + Spacebar or Alt + Shift.

A B C DEG
H

F
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TIP

TIP

G  Sound icon: It allows you to change sound level of your PC. You can click 
right on it to access different Sound settings.

H  Network icon: It indicates the status of your network connection. 
Clicking it shows more information about your network connection and 
the Network settings option.

 
 EXPLORING THE NEW START MENU
In Windows Operating System, the Start Menu is the main point of access to your 
Applications and Settings. As discussed, Windows 10 has a renewed start menu, 
which is a combination of traditional Start Menu and the tile based Start Screen.

OPENING NEW START MENU
You can open Start menu in multiple ways directly from any screen you are 
working on.    

1  To open the Start Menu, Click 
on the Start button on the 
taskbar.

The new Start Menu can be 
categorized in to three sections as 
given below:  

A  Basic Start Menu: The left part 
of the Start menu contains 
the User Account icon, File 
Explorer icon, Settings icon, 
and Power button.

B  All Apps List: Besides the 
basic Start Menu, there is a 
list of all apps available on 
your PC.

C  Tile Based Start Screen: The right side of the new Start Menu has the 
whole new colorful tile based Start Screen. Tiles represents the apps you 
use frequently. Clicking on a tile opens the respective app or link.

Keyboard Shortcut: To open Start Menu   
press the Ctrl + Esc Keys.

Start Menu can be opened by pressing the 
Windows logo key on the keyboard from 
any Screen.

TIPS

 
   

B

C
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THE BASIC START MENU
The basic Start Menu has the classic features so that you can have easy access 
to the basic operations such as opening the computer settings, lock, sign out, 
or shut down the computer. 
By default, the basic Start Menu 
has: 

A  User Account Icon
B  File Explorer Icon
C  Settings Icon
D  Power Button

User Account Icon
The User Account Icon shows which user is currently Signed In. It usually 
shows a picture for the User Account, if already set.

Clicking on the User Accounts Icon gives you following options:

E  Sign Out: This allows you to close 
all your work , apps and sign out 
from your user account safely. 
If	 you	 have	 any	 unsaved	 file,	
Windows prompt you to save it.

F  Lock: This allows you to take a 
break by keeping all your work 
and apps open in the same state 
and just lock the computer. So 
your work is private and safe. To 
return back and resume work, 
you need to sign in with your 
password (if you have set.)

G  Change Account Settings: This 
allows you to open the Account's 
Settings, where you can Set or 
Change Picture for your User 
Account, Change Password, etc.

File Explorer Icon
The File Explorer Icon allows you to open the new Windows 10 File Explorer 
Application right from the Start Menu. The File Explorer Application is a modern 
file	management	tool	 in	Windows	10,	which	allows	you	to	organize	all	your	
files	on	your	computer.	Session	6	discusses	 the	File	Explorer	Application	 in	
detail.

B

C
D
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Settings Icon
The Settings Icon allows you to open the Windows Settings App. Windows 10 
has	a	new	approach	to	configure	various	settings	of	your	computer.	Windows	
Settings App provides an easy way to set your computer according to your 
preferences. It has Settings Categories such as Personalization, Accounts, etc. 
Personalization Settings are discussed in Session 5 and different Computer 
Settings are discussed in Session 6.

Power Button
As the name suggests, the Power Button allows you to Shut Down, Restart or 
put your computer to Sleep State.

Clicking the Power Button gives you the following options: 
A  Sleep: This allows you to 

put your computer to Sleep 
Mode. Sleep Mode keeps 
your	 work,	 files,	 apps	
active in its state, turns off 
the monitor and puts the 
computer in a Power Saving 
State. When you wake the 
computer up, the monitor 
turns on and Lock Screen 
appears. By signing in you 
can resume your work from 
the same state.

B  Shut Down:	This	closes	all	open	apps,	files,	processes,	signs	out	all	the	
users in an orderly manner and then turns off the computer.

C  Restart: This shuts down the computer and starts it again. Restarting 
is sometimes necessary after installing Windows

     updates.

C

B
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THE APPS LIST
The All Apps List provides access to all of the apps available on your PC. This 
include the apps installed as part of Windows 10 and the apps you have installed. 

The All Apps List has the following:
A  Recently added: The apps that are 

recently installed are listed here.
B   Most used: The apps that you use 

most are listed here. The list is 
updated based on your usage of 
apps.

C  Alphabetical apps list: This presents 
all the apps available on the PC in 
alphabetic order allowing you to 
quickly locate the apps.

To open an app, scroll the All Apps List 
to locate the app and click on it. The 
app opens in its window. If an app has 
multiple tools or there is an apps suit, a small arrow is shown next to it.

TILE BASED START SCREEN
The Tile Based Start Screen is inspired from the tablet and touch based 
computing interface. Tiles can be considered as replacement for Icons in the 
tablet or touch based interfaces. Tiles are more attractive and visual than 
icons. Thus, Windows 10 has integrated the tile based screen along with the 
standard features of the Start menu.

Tiles can display contents from an app it is representing or can show live contents.

By default, the tiles have two groups on the Start screen, Life at a glance 
(having tiles of apps, such as Calendar or Weather) and Play and explore 
(having the tiles of apps, such as Games or News).

You can drag the tiles in Start screen, Resize 
or Turn live tile off. You can Unpin a tile or Pin 
more new tiles for your apps.

Pin Tiles to Start Screen
To pin an app to the Start screen, follow the 
steps given below: 

1  Open the Start menu.
2  Locate the app in the All Apps list and 

Right Click on it.
3  Choose Pin to Start in the shortcut 

menu that appears.

A

B

C
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Unpin Tiles from Start Screen
To Unpin a tile from the Start screen, follow 
the steps given below:

4  In the Start Menu, Right Click on the 
tile you want to Unpin.

5  Choose Unpin from Start in the shortcut 
menu that appears.

Resize Tiles
Tiles can be square or rectangular in shape. 
You can resize tiles to be Small, Medium, 
Large, or Wide.

To resize a Tile, follow the steps given below:
1  In the Start Menu, Right-click on the 

tile you want to resize.
2  Point to the Resize option in the shortcut 

menu that appears.
3  Choose the desired size for the tile.

Resize Start Menu
Windows 10 allows you to resize the Start 
Menu easily right there. You can adjust the 
height and width of the Start menu. Resizing 
the Start menu can move the app tiles from 
their positions.

To change the width or height of the Start 
menu, follow the steps given below: 

4  Open the Start Menu, Point to the right 
border (or the top border) of the Start Menu.

5  The mouse pointer changes to a two 
-headed arrow, Drag the border to 
resize the Start menu as desired.

 EXPLORING THE WINDOWS 10 TABLET SCREEN

Microsoft is highly focused in incorporating mobile and touch based features into 
Windows, in order to meet and exceed user requirements. The recent versions of 
Windows have shown major shifts in this direction. In Windows 10, it has been 
given a dual mode interface – Desktop mode and the Tablet mode. 

4 5
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If you are using Windows 10 on a touch based PC or on a tablet, it will automatically 
load into the tablet mode. The Tablet mode is specially designed to navigate 
and launch items by using touches and gestures. In tablet mode, most of the 
Windows interface components will be more visual and user friendly. You might 
find	using	the	new	interface	difficult	at	first.	However,	a	little	practice	makes	it	
more enjoyable. The Tablet mode screen is briefed here.

A  Tile Based Start Screen: In the 
tablet mode, the Tile Based 
Start Screen takes the whole 
screen and you don’t see the 
desktop as in the desktop mode. 
As discussed, it has the tiles of 
the apps you use frequently. 
Whenever you close an app, you 
usually come back to this screen. 
Thus, in tablet mode, the Tile 
Based Start Screen becomes like 
your desktop. 

      You can pin or unpin tiles as you do in the desktop mode.

B  Basic Start Menu: The Basic Start Menu in the tablet mode remains 
almost same as in the desktop mode, except the All Apps icon is added 
to it on top. You need to click on it to see your apps. The All Apps list 
is also tile based now, instead of a simple list of All Apps as in desktop 
mode.

C  The Back Key: Another important change in the tablet mode is the Back 
Key. Usually you use this key to return to either the previous app or to 
the Start Screen.

TOGGLE TABLET MODE ON/OFF
If you have the mouse and keyboard 
connected and would like to work in 
the classic way, you can switch the 
Tablet Mode OFF and return to the 
Desktop mode.

To	 toggle	 the	 Tablet	 mode	 ON/OFF,	
follow the steps given below: 

1  Click the	Notifications	and	Action			
Center icon to open the Action 
Center.

2  Click on the Tablet mode option.

A

C

B

1

2



97

S
e
ssio

n
 4

OVERVIEW OF OPERATING SYSTEM, GETTING STARTED WITH WINDOWS 10, AND EXPLORING WINDOWS 10

ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. Which one of the following is not an Operating System?

a. Microsoft Word. 

b. Android

c. Windows 10

d. MAC OS

2. ________ is a character-based interface, which involves typing written 
commands to computers.

a. Graphical User Interface

b. Command Line Interface

c. Graphical Line Interface

d. User Command Interface

3. The________displays notifications about recent events on your computer 
such as incoming email messages, security alerts, updates, etc.

a. Action Center

b. Task view

c. Windows Ink

d. Virtual Desktops

4. _______ allows you to use pen input in different apps or annotate on 
snapshot of your current screen.

a. Action Center

b. Windows Ink

c. Task View

d. Virtual Desktops
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Fill in the blanks with the appropriate words provided in the box.

Back Key Windows Key + L Lock Screen Icon Ctrl + Esc

1. An________ is a small graphical picture on the desktop that is linked to a 
file,	a	folder	or	an	application.	

2. The keyboard shortcut to open the Start Menu is ________. 

3. _______ is the screen that appears when you turn on your computer or 
when your computer is locked.     

4. In the Tablet Mode, you use the ________ to return to the previous app or 
to the Start Screen.   

Activity 3

Practice the following tasks on your computer.
1. Pin the Calculator app to the tile based start screen. (Hint: Pin it to the 

right side of the Start Menu.)

2. Open the Start Menu and resize the Microsoft edge tile to large size. (Hint: 
From the tile based start screen.)

3. Unpin the Mail app tile from the tile based start screen. (Hint: From the tile 
based start screen.) 

4. Put your computer to sleep mode. (Hint: From the power button of the 
start menu.

Activity 2
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PERSONALIZING WINDOWS 10 AND
MANAGING CONTENT & APP WINDOWS

Session
5

In this Session, you will learn about Personalizing Windows 
10 and Managing Content and App Windows.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	Personalizing Windows 10
•	Personalize the Desktop
•	Themes
•	Personalize the Lock Screen
•	Personalize the Start Menu
•	Personalize the Taskbar 

•	Managing Content and App Windows
•	A Window and an Active window
•	Common Characteristics of windows
•	Arranging Multiple windows
•	Switching between windows  

Specific Objectives

OBJECTIVES
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LEARNING

PERSONALIZING WINDOWS 10

Having explored the Windows 10, you might be excited with the pleasant design 
and colors it has by default, or you might want to customize it to your own 

preferences. 

Windows 10 offers great personalization options for your windows environment. 
You can personalize the Desktop, the Start Menu, the Taskbar, and even the 
Lock Screen. Now you will go through the Personalization options in windows 10.

PERSONALIZE THE DESKTOP
As discussed, you use the Windows 10 Desktop as your personal desk. Windows 
10 Desktop is the place you see often while you work on your PC. Therefore, it’s 
a good idea to personalize your desktop the way you wish.

You can personalize your desktop in many ways such as Resizing Icons, 
Arranging Icons, or Changing the Desktop Background.

RESIZING DESKTOP ICONS
Windows 10 provides three views for the desktop icons; Large icons, 
Medium icons and Small icons.

To change the view of the Desktop 
Icons, follow the steps given below:

1  Right Click on an empty area of 
the desktop, the shortcut menu 
appears.

2  Point to View option. 

3  Choose the desired view option 
for the icons from the menu that 
appears.

  ARRANGING ICONS(SORT BY)
To have a decent desktop, you should arrange  the icons on it. This also 
makes it easier to access them. You can arrange icons manually by dragging 
icons as you want or you can let windows arrange (or Sort) it automatically. 

You can also choose to sort icons automatically by their Name, Size, Item 
type	or	Date	modified.

2 3

1
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To automatically sort the desktop icons,follow the steps given below:
1  Right Click on an empty area of the 

desktop, the shortcut menu appears.
2  Point to Sort by option.
3  Choose the desired sort option from 

the menu that appears.

PERSONALIZE THE DESKTOP BACKGROUND
The appearance of desktop background is usually important. As discussed, 
you often return back to the desktop while working on a PC. A cheerful 
desktop makes you feel excited.

Open Personalization Settings
You can personalize the desktop background from the Windows Personalization 
Settings.  

To open the Personalization Settings, follow 
the steps given below:
   1  Click on Start Button.

2  Click on Settings icon in the Start menu. 
This opens up the Windows Settings.

3  Click on the Personalization category.
A  The Personalization Settings window 

appears.

In Windows 10, you can personalize your 
desktop background by choosing a Picture, a Solid color, or a Slideshow of 
pictures.

Keyboard Shortcut: You can also open the Personalization Settings by by right-clicking on the 
desktop and choosing Personalize.

TIP

1

2

1

32

3
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Set a Picture as Background
If you prefer to have a picture as the desktop 
background, you can choose a picture from 
the default pictures provided by Windows 10 
or you can browse your computer to locate 
the picture.

To set a Picture for your desktop background, 
open the Personalization settings and follow 
the steps given below: 

1  Click the Background option in the 
Personalization pane on the left.

2  Click the Background menu in the right 
and choose Picture option from the list that appears.

3  Choose a picture from the pictures shown under the Choose your picture.

B  The preview of the selected picture appears in the Preview area.

Set a Solid Color as Background
If you prefer to have a simple desktop 
Background, you can choose a Solid color 
from a variety of available colors.

To set a Solid color for your desktop 
Background, open the Personalization 
settings and follow the steps given below: 

1  Click on the Background option in the 
Personalization pane on the left.

2  Click on the Background menu in the 
right and choose Solid color from the list that appears.

3  Choose a color of your choice from the Background colors grid that 
appears below.

C  Preview of the selected color appears in the Preview area.

Set a Slideshow as Background
If you want the desktop background picture to be changed automatically 
after	a	specific	time	period,	you	can	choose	the	Slideshow	option	for	your	
desktop background. This is quite an exciting feature, which gives you a 
beautiful new desktop background, every morning, for example.

1

3

2

A

B

1

3

2

C

If you want to choose a picture from your computer, 
click on Browse button, the file Open dialog box 
appears.Locate and select your picture and click on 
the Choose Picture button.

You can also right-click on the picture file and 
select Set as desktop background.

TIPS
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All you have to do is organize all your favorite 
pictures into a folder and set it as a source 
for the Slideshow.
To set a Slideshow for your desktop 
Background, open the Personalization 
settings and follow the steps given below:

1  Click on the Background option in the 
Personalization pane on the left.

2  Click on the Background menu in the 
right and choose Slideshow from the 
list that appears.

3  Click on the Browse button to locate the 
pictures folder. The Select Folder dialog 
box appears.

4  Locate and select the pictures folder and 
click on the Choose this folder button.

5  Click on Change picture every box and  
choose how often you want the pictures should be changed in the 
slideshow.

 THEMES   
The Themes option in Personalization settings 
allows you to change the appearance of various 
user interface elements of Windows at once. A 
Theme is like a personalization package containing 
the desktop backgrounds, colors, screen savers, 
and even system sounds. Applying a theme 
instantly changes the look and feel of the Windows 
environment.

To change the Theme, open the Personalization 
settings and follow the steps given below: 

1  Click Themes option from the Personal
     -ization pane in the left.
2  Click Theme settings link under the 

Themes option in the right. This opens 
up the Theme settings window.

3  Choose a Theme of your choice from 
the available themes.

4

1

2

3 5

1

2
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You can set the Shuffle option ON to display the pictures in the Slideshow in random order.

TIP

The link “Get more themes online” allows you to download more themes from the Microsoft website.

TIP
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 PERSONALIZE THE LOCK SCREEN
You learned about the new Lock Screen feature of 
Windows 10 in session 4. You can also personalize 
the Lock Screen with various options.

You can set a Picture or a Slideshow on the Lock 
Screen in the same way you do it for the desktop 
background i.e., from the Personalization settings.

Additionally, you can show the status of 
different apps right on the Lock Screen. Getting 
the status of apps right on the Lock screen 
makes	it	beneficial,	so	you	can	decide	whether	
or not you should unlock and pay immediate 
attention. There are two types of app status on the Lock Screen: detailed status 
and quick status. 

TIP
Windows 10 allows you to show detailed status of any one app and quick status of up to seven apps on 
the Lock Screen.

            
        

SHOW DETAILED APP STATUS ON LOCK SCREEN
Setting an app to show detailed status 
on the Lock Screen gives a bit more 
information from the app. For example, 
the detailed status of Calendar app shows 
the upcoming event details which includes 
the event title, location, time, etc.

To set an App to show detailed status on 
Lock Screen, open the Personalization 
settings and follow the steps given below: 

1  Click Lock Screen option from the 
Personalization pane in the left.

2  Click on the icon under the Choose 
an app to show detailed status; the 
list of supported apps appears.

3  Choose the app of your choice to 
show the detailed status.

SHOW QUICK APP STATUS ON LOCK SCREEN
The Choose apps to show quick status option from the Settings app 
displays	 the	 app	 icons	 for	 the	new	notifications	 on	 the	 Lock	Screen.	 The	
count	of	the	notifications	is	also	displayed	on	the	app	icon,	which	is	called	
badges of the apps. For example, quick status of email app shows just the 
number of new emails arrived.

1

2
3
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To set an App to show quick status on Lock Screen, open the Personalization 
settings and follow the steps given below: 

1  Click Lock Screen option from the 
Personalization pane in the left.

2  Click on any of the plus sign icon or 
existing app icon under the Choose  
apps to show quick status. The list 
of supported apps appears.

3  Choose the app of your choice to show the quick status.

 PERSONALIZE THE START MENU
In Session 4, you explored the new Start Menu of Windows 10 along with 
some quick and handy customizations, such as resizing tiles.There are a lot more 
customization options that Windows 10 offers for the Start Menu. You can choose 
which folders to appear on the Start; whether to show Most Used apps, Jump 
lists, or to show the full screen Start Menu as in the tablet mode.

The	Settings	app	of	Windows	10	has	made	configuring	the	Start	menu	quick	and	
simple,	by	providing	the	ON/OFF	toggle	buttons	for	most	of	the	options.	Moreover,	
various	 Start	menu	 settings	 can	 be	 configured	 from	 the	 same	 settings	 page.

To personalize Start menu contents, open the Personalization settings and follow 
the steps given below: 

1  Click on the Start option in the 
Personalization pane in the left.

A  The Start Menu settings appear in the 
right.

2  Show more tiles: Turn this option ON 
if you want to make the Start screen 
a bit wider to occupy more tiles.

3  Show most used apps: Turn this 
option ON to see a list of apps you use 
most but are not pinned to the Start 
screen, at the top of the All Apps list.

4  Show recently added apps: Turn this 
option ON to see a list of recently installed apps, at the top of the All 
Apps list.

5  Use Start full Screen: Turn this option ON to see the full screen Start 
Menu as in the tablet mode. 

6  Show recently opened items in Jump Lists on Start or the Taskbar: Turn 
this option ON to show the list of recently opened items in an app as a 
Jump list so that you can right-click and reopen it directly.

    Choose which folders to appear on start: Clicking this option opens a 
list	of	folders	with	ON/OFF	toggle	buttons.	You	can	turn	any	folder	ON	
to have it right in the basic start menu for direct access.

7

1

2

3

1

2
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 PERSONALIZE THE TASKBAR
You learned about the importance and working of the Windows 10 taskbar 
in session 4. You can personalize the taskbar in many ways such as locking, 
automatically hiding, or changing its location on screen. 

Windows	10	has	 also	 simplified	 the	 Taskbar	 personalization	 by	providing	 it	 all	
together	at	one	place	and	in	the	form	of	ON/OFF	toggle	buttons	for	most	of	the	
options. 

To personalize the Taskbar, open the Personalization settings and follow the steps 
given below:

1  Click on the Taskbar option in the 
Personalization pane in the left.

A  The Taskbar settings appear to the 
right.

2  Lock the Taskbar: Turn this option 
ON if you want to prevent any 
accidental relocation or resizing of 
the Taskbar.

3  Automatically hide the taskbar in 
desktop mode: Turn this option 
ON if you don’t want the taskbar 
to be always visible. Instead, it will 
appear only when you move your 
mouse pointer over the taskbar 
location

4  Use small taskbar buttons: Turn this 
option ON if you want the buttons 
on the taskbar to be a bit smaller. 
This reduces the size of the taskbar 
as well.

5  Show badges: Turn this option ON 
if you want to get the count of any 
new	notifications	from	a	running	app	directly	on	its	taskbar	button.

6  Taskbar location on screen: Click on this option to change the location 
of the taskbar on your screen. Choose the desired location from the list 
that appears with the following options:

1

2
3

4

5

A

6
7

8

9

TIPS
• You can also open the Taskbar Settings by right-clicking on the Taskbar and choose Settings.

• You can also lock the Taskbar by right-clicking on it and choose Lock the taskbar.

• You can also drag the taskbar to move it to any edge of your  screen, if it’s not locked.
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 B  Left: To move the taskbar to the 
left edge of the screen.

 C  Top:  To move the taskbar to the 
top edge of the screen.

D  Right: To move the taskbar to the 
right edge of the screen. 

E  Bottom: To move the taskbar to 
the bottom edge of the screen.

7  Combine taskbar buttons: Click 
on this option to choose whether 
to combine the buttons on the 
taskbar for the apps that are 
having multiple open windows. 
This allows you to occupy more 
buttons on the taskbar. Choose 
when to combine the taskbar 
buttons from the list that appears 
with the following options:

F  Always, hide labels: To always 
combine the taskbar buttons 
for the apps. This also hides 
the labels of all the apps on the 
taskbar buttons. 

G  When taskbar is full: To only 
combine the taskbar buttons for 
the apps when the taskbar is full 
of buttons.

H  Never: To not combine the taskbar 
buttons even if the taskbar is full 
of buttons.

8  Select which notification icons 
appear on taskbar: Click on this 
option to choose which icons you 
want	to	appear	in	the	Notification	
area of the Taskbar. Particularly, 
you can choose icons of the apps 
running in background such as 
Windows defender. 

I  Choose the desired icons from the 
list of options that appear in a new settings window.

9  Turn	System	icons	ON/OFF:	Click on this option to choose which system 
icons	you	want	to	appear	in	the	Notification	Area	of	the	Taskbar,	such	
as the Clock, Volume, or Network.

J  Choose the desired icons from the list of options that appear in a new 
settings window.

F

G
H

I

J

B
C

D

E
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MANAGING CONTENT AND APP WINDOWS 

While working on your computer, almost all the information you view on your 
computer screen is displayed in a Window. As you have seen, the various 

personalization	settings	are	displayed	in	the	Settings	window.		Similarly,	user	files	
open in the respective app windows. Usually, you have multiple windows open 
while you work on your PC. This section enables you to handle multiple windows 
efficiently.	

 A WINDOW AND AN ACTIVE WINDOW
A window is a rectangular frame that displays 
apps,	 files,	 folders,	 or	 other	 contents.	 As	
discussed, multiple windows are usually 
open simultaneously while you work. The 
window you are currently working in is called 
an Active Window. For example, if you are 
currently browsing a website in Microsoft 
Edge, it is your active window.

COMMON CHARACTERISTICS OF WINDOWS
The contents of every window are usually different but all windows have 
some common characteristics. All windows can be opened, closed, minimized, 
maximized, and resized. In addition, most of the windows have some basic 
parts, as follows:

A  Title Bar: It is the area at the top of a window that displays the title of 
an	app.	It	also	displays	the	title	of	the	file,	which	is	open	in	the	window.

     You can drag the Title bar to move a window on the screen.
B  Minimize button: This button is at the right end of the title bar. It 

minimizes a window to the taskbar, i.e. the window disappears from 
the screen. You can re-open the same window from the taskbar.

 

TIPS

You can Minimize all windows other than the 
active window by dragging and shaking its Title 
bar, or by using the keyboard shortcut Windows 
Key+ Home.
To minimize all windows, the keyboard shortcut 
Windows Key+ M can be used.

You can also use the Title bar to 
Maximize or Restore a window as shown below:
-To maximize, double click or 
drag the Title bar to the top of the screen.
-To restore, double click or drag the
 Title bar away from the top of the screen

TIPS

A
C

E

E

DB

F
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C  Maximize/Restore	button: This is next to the minimize button on the 
window title bar. Maximize resizes the window to full screen and Restore 
returns the window to its previous size.

D  Close button: Next to the maximize button is the Close button. 
					It	closes	the	window	along	with	the	file,	or	any	other	contents.
E  Scroll Bar: Scroll bar is used to move vertically or horizontally to change 

the position of the content within a window. For example, you use 
vertical or horizontal scroll bars to move through a window.

F  Window Border:	 The	outer	edges	of	a	window,	which	 specifies	area			
of the window on the screen. The Window borders can be used to 
resize a window as well. Take the mouse pointer on any border of the 
window, the pointer changes to a two-headed arrow. Drag the border 
horizontally or vertically to resize the window as desired.

 ARRANGING MULTIPLE WINDOWS
When you have multiple apps running simultaneously, you might wish to arrange 
all the app windows at once. Windows 10 allows you to automatically arrange all 
running app windows in three ways; cascade, stacked, or side by side.

CASCADE WINDOWS
This arrangement shows multiple open windows overlapped one over the 
other.
To cascade Windows,

1  Right click on empty area of the Taskbar and choose the Cascade 
windows option from the menu that appears.

A  All open windows are cascaded.

1

3

2

A
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SHOW WINDOWS STACKED
This arrangement shows the multiple 
windows one above the other.

To show Windows stacked,
2  Right click on empty area of

   the Taskbar and choose Show 
windows stacked option from 
the menu that appears.

B  All open windows are stacked.

SHOW WINDOWS SIDE BY SIDE
This shows multiple windows arranged 
side by side.

To show Windows side by side,
3  Right click on empty area of 

the Taskbar and choose Show 
windows side by side from the 
menu that appears.

C  All open windows are displayed 
side by side.

Restore cascaded, stacked or side by side windows
After you have arranged multiple windows on your 
screen, you can restore them to their previous status 
by choosing the relevant Undo command.

1  To Restore the window arrangement, right click 
on empty area of Taskbar and click the relevant 
Undo command from the menu that appears.

 
SNAP A WINDOW TO THE LEFT OR RIGHT OF A SCREEN    

Windows 10 includes several enhancements to snap, making it easier to 
manipulate the layout of an open window on your screen. Snapping a window 
to left or right side actually resizes and positions a window to occupy either 
left or right portion of the screen or one corner of the screen.

1

C

B
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1  To snap window to left half of 
the screen, drag the window 
Title bar until the mouse 
pointer touches the left or 
right edge of the screen (A 
circle	flashes	around	mouse	
pointer) and Release.

TIP

To snap a window to a quarter screen, drag the window title bar until the pointer touches a corner 
of the screen and release.

 SWITCHING BETWEEN WINDOWS
You can cycle through different windows that are open on your screen or 
minimized to Taskbar. To switch between windows, you can use the Task 
View button on the taskbar. 

Using the Task View button
The main function of the Task View button is to provide easy switching 
amongst the different open windows.

To switch between windows using 
task view button, follow the steps 
given below:

  Click Task View button on 
the taskbar.

          Windows  displays  thumbnails 
for all running programs.

    Click the thumbnail of the 
program that you want to 
switch to.

Using ALT + TAB Keys
You can also switch among the open windows easily with the ALT + TAB keys 
as follows: 

•	Press	and	hold	the	ALT key.
•	Hit	the	TAB key once, You will see the thumbnails of the open programs.
•	Hit	the	TAB key again to choose the window you want to switch to.
•	Release	the	ALT key to show the selected window.

1

1
2

A

A

1

2
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. Windows 10 provides __________ views for the desktop icons. 

a. 4

b. 3

c. 2

d. 1

2. To make the Start screen a bit wider to occupy more tiles, turn on 

__________ option in the Start menu settings.

a. Show most used apps

b. Show more icons

c. Show more tiles

d. Show recently added apps

3. The _________ button is used to switch between different windows.

a. Start menu

b. Action center

c. Title bar

d. Task view

4. The keyboard shortcut to minimize all windows including the active window 
is ___________. 

a. ALT + M

b. Windows key + M

c. CTRL + M

d. ALT + T
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Lock Screen Active Window Window Borders Theme Task View

1. __________ is like a personalization package containing the desktop 
background design, colors, sound schemes, etc.,

2. Windows 10 allows you to show detailed status and quick status of apps on 
the ________.

3. The window you are currently working in is called an ________.     

4. __________	are	the	outer	edges	of	a	window,	which	specifies	its	area	on	the	
screen.

Activity 3

Practice the following tasks on your computer.
1. Change the background picture of your desktop. (Hint: Choose the picture 

from available windows 10 pictures.)

2. Set a slide show for your desktop background. (Hint: Choose a folder of 
your choice that contains pictures)

3. Change the lock screen background picture. (Hint: Choose the picture 
from available windows 10 pictures.)

4. Open any three applications on your desktop and arrange all opened 
windows to “Show windows side-by-side”. (Hint: Open Microsoft Edge, File 
Explorer and Notepad applications.) 
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MANAGING FILES & FOLDERS AND
COMPUTER SETTINGS

Session
6

In this Session, you will understand Managing Folders & 
Files and Computer Settings.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	Managing Files and Folders
•	Understand Files, Folders, and Libraries
•	File Explorer of Windows 10
•	The Home Tab
•	The View Tab

•	Managing Computer Settings
•	Time & Language Settings
•	System Information
•	Task Manager

Specific Objectives

OBJECTIVES
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MANAGING FILES AND FOLDERS

Windows	10	organizes	the	files	in	a	hierarchical	storage	system	of	folders	and	
subfolders.	To	organize	your	files	well,	Windows	10	provides	the	File	Explorer	

app. This section explains working with the File Explorer app of Windows 10.

 UNDERSTANDING FILES, FOLDERS, AND LIBRARIES
Files and Folders play a major role in the organization of data in your computer. 
Before you work with the File Explorer app, you should understand the basic concept 
about Files, Folders and Libraries.

FILE
A file is a collection of related data or information stored in a computer; 
identified	 by	 a	 name.	 It	 can	 be	 a	 document,	 worksheet,	 graph,	 text	 file,	
presentation,	audio	clip,	video	clip,	etc.	You	can	open,	look	at	and	change	files	
by using one or more apps.

FOLDER
A folder	is	a	container	in	which	you	can	store	files	and	folders.	A	folder	within	a	
folder is called a sub-folder.	Many	apps	install	the	files	they	need	in	subfolders	
of the Program Files folder. 

LIBRARY
Libraries	allow	you	to	access	and	arrange	files	from	different	folder	locations	
quickly without moving them from their original location. The default libraries 
in Windows 10 are Documents, Music, Pictures, Videos, Camera Roll and 
Saved Pictures.

 FILE EXPLORER OF WINDOWS 10
File	Explorer	 is	 the	file	management	application	used	by	Windows	10	 to	browse	
folders	 and	files.	 It	 provides	 a	graphical	 interface	 for	 the	users	 to	navigate	and	
access	the	files	stored	in	the	computer.	If	you	are	looking	for	a	specific	document	in	
your computer use the File Explorer to locate it.

To start the File Explorer, click on its icon in the Start Menu. 

The	File	Explorer	window	opens	up	and	you	can	browse	all	folders	and	files	on	your	
computer. 

LEARNING

To open File Explorer press: Windows key + E.

TIP
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THE USER INTERFACE OF FILE EXPLORER      
You	 should	 first	 get	 familiar	
with the user interface of the 
File Explorer so that it will be 
easier for you to understand 
and practice its features. As 
you can see, the initial window 
of the File Explorer comprises 
of the following sections: 

A  Ribbon:The File Explorer includes the Ribbon at the top. The Ribbon contains 
buttons	for	the	common	tasks	you	perform	with	your	files	and	folders.	

B  Navigation and Search Bar: Just below the Ribbon, it lets you navigate 
through	the	folder	structure	easily	and	search	files	or	folders.

C  Navigation Pane: The Pane on the left, gives you easy access to storage 
structure of your computer consisting of the libraries of documents, 
pictures, storage devices and even network devices. It also features the 
new Quick access showing the frequently used folders. 

D  Contents Pane: It is the main area to the right of the Navigation Pane that 
displays the contents of the selected folder or storage location.

 THE RIBBON
In Windows 10, the File Explorer incorporates the Ribbon similar to the one 
featured	in	the	Microsoft	Office	applications.	The	Ribbon	contains	buttons	and	
commands for the most common tasks. 

The File Explorer Ribbon has the following four tabs, each with different 
commands:

A  File tab:It actually opens the File menu that has options like managing the 
File Explorer window or customize the File Explorer.

B  Home tab:	It	has	most	of	the	tools	to	organize	files	and	folders.
C  Share tab:	It	has	the	options	like	Share,	Email,	Print,	or	Compress	a	file	

or folder.
D  View tab:	It	has	the	options	to	configure	the	layout	of	the	File	Explorer	

window.

C

A

B

D

A B C D
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NAVIGATION AND SEARCH BAR  
The Navigation and Search bar below the Ribbon helps you in navigating through 
your	folder	and	searching	for	files.	It	has	four	sections	as	follows:

E  Navigation buttons: The Back, Forward and Up buttons on the left allows 
you to move through recently opened folder locations easily.

F  Address bar: To the right of the navigation buttons, the long Address bar 
displays an icon and the full path to the current folder.

G  Refresh button: On the Address bar, the Refresh button refreshes the 
display of the contents pane.

H  Search box: In	the	right	side,	the	Search	box	gives	access	to	the	file	or	
folder search feature of Windows 10. Entering a term in the Search box 
adds a new Search tab in the File Explorer ribbon with various search tools.

NAVIGATION PANE
The vertical pane that opens by default on the 
left side of the File Explorer window, displays a 
hierarchical view of the physical and virtual storage 
structures available in the computer. The Navigation 
pane	allows	you	to	browse	folders	and	files	on	your	
computer or on a network. The Navigation pane 
displays the following nodes:

A  Quick Access: The Quick Access node contains 
links to folders and libraries that you access 
frequently. You can also pin any folder location 
here to access it quickly.

B  This PC: This PC node contains links to your 
user	 account-specific	 folders,	 and	 to	 the	
physical storage locations that are installed in 
or connected to your computer. 

C  Network: The Network node displays a 
representation of other computers on your local area network.

When you click on This PC node, Network node, or Homegroup node from the Navigation Pane, The Home 
tab and Share tab are replaced with the tab of the respective node.

TIP

A

B

C

E F G H
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CONTENT PANE
In File Explorer, the Content Pane	displays	files	and	folders	stored	in	the	currently	
selected folder or storage device. It displays the contents of the selected folder 
as a textual or iconic list. The Content Pane in the initial File Explorer interface 
has	the	following	two	sections,	for	easy	access	to	recently	opened	files	or	folders.

 

Frequent folders section: It lists the folders you’ve worked with recently, 
for quick access to them.

     Recent	files	section:	It	lists	files	and	documents	that	you’ve	opened	
recently.

 THE HOME TAB  
Most	of	the	tools	you	need	to	organize	files	&	folders	on	your	computer	are	provided	
in the Home tab of the File Explorer.

The	Home	tab	consists	of	the	following	five	groups:

A  Clipboard: This group	consists	of	commands	to	copy	or	move	a	file/	folder.
B  Organize: This	group	consists	of	commands	to	copy,	move,	rename,	or	delete	a	file/	

folder.
C  New: This	group	consists	of	commands	to	create	a	file/	folder	or	other	items.
D  Open: This	group	consists	of	commands	to	open	a	file/	folder	or	display	its	

Properties.
E  Select:	This	group	consists	of	commands	to	select	the	files/	folders	in	the	

content pane.

A

B

A B C D E

A

B

When you click on the Quick Access node in the Navigation pane, the Frequent folders section and the 
Recent files section appear in the content pane. 

TIP
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PIN TO QUICK ACCESS BUTTON
As discussed earlier, the Quick Access node in the Navigation pane gives you 
a quick way to open frequently used folders. You can use the Pin to Quick 
Access button on the Home tab to easily pin any folders location to the Quick 
Access list.

To pin a drive, folder, library, or other location to the Quick Access list, follow 
the steps given below:

1  In the File Explorer, select the folder that you want to pin to Quick Access.
2  Click the Home tab on the Ribbon.
3  In the Clipboard section, click the Pin to Quick Access button.

     The selected folder is now listed in Quick Access.
 

Unpin from Quick access 
To remove a pinned location from Quick Access list, 
follow the steps given below:

1  Right-click on it in the Quick Access list.
2  Choose Unpin from Quick Access.

CLIPBOARD GROUP
When you cut or copy	 a	 folder	 or	 file,	 the	 item	
is moved to a storage area called the Clipboard. 
This facilitates you to paste one or more copies of it 
elsewhere.	In	addition	to	copying	files	and	folders	to	
other	locations,	you	can	also	make	copies	of	files	in	
the original folder. 

1 2

3

2

1A

A



121

S
e
ssio

n
 6

 
MANAGING FOLDERS & FILES AND COMPUTER SETTINGS

Copy, Paste and Cut
You	can	copy	or	move	a	file	from	one	folder	to	another.	In	a	similar	way,	you	
can also copy or move a complete folder. 

To	copy	(or	move)	a	file	or	folder	to	a	different	folder,	follow	the	steps	given	
below:

 1  Select	your	file	or	folder	in	the	File Explorer.
2  Click on the Home tab.
3  Click on Copy (or Cut) button in the Clipboard 

group; depending on whether you want to 
make a copy of the selected item or move it. 

4  Open the destination folder.
5  Click on Paste button from the Clipboard group.     

2

3

1

5

4

                  

ORGANIZE GROUP
The organize group facilitates 
you to perform different operations 
such as Copy, Move, Rename and 
Delete	in	an	efficient	way.

To Copy, press: CTRL + C
To Cut, press: CTRL + X
To Paste, press: CTRL + V

TIPS
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Move to and Copy to buttons
This	option	facilitates	you	to	directly	Move/Copy	your	file/folder	to	a	recently	
opened folder or any folder without opening it.

To	copy	(or	move)	a	file	or	folder	to	a	different	folder,	follow	the	steps	given	
below:

1 	In	File	Explorer,	select	your	file	or	folder.
2  Click the Ribbon’s Home tab at the top.
3  From the Organize group, click the Copy to (or Move to) button. 
 4  A menu drops down, listing some common locations. 

5  Click Choose Location.
6  Search through the drive and folders in the dialog box that opens to 

reach the destination folder and select it. 
7  Click	on	Copy/Move	button	on	the	dialog	box.

           

Delete button 
You	can	Recycle	or	Permanently	delete	files	or	
folders that you don’t need any more. 

To	delete	a	file	or	folder,	follow	the	steps	given	below:
1  In File Explorer, 
select	 your	 file	 or	
folder.

2  Click the Ribbon’s 
Home tab at the 
top.

3  From the Organize 
group, click on the 
Delete button.

4  Click on the 
drop down arrow of the Delete button to Choose whether you want 
to Recycle it (send it to the Recycle bin) or permanently delete it.

2

3 4

1

2

3

5

4

1

6

If you want to delete multiple items at once, select them and press DELETE key on your keyboard.

TIP

7
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Restore from Recycle Bin
Normally,	when	you	delete	a	file	or	folder,	Windows	10	moves	the	object	to	the	
Recycle Bin. 

To	restore	a	file	or	folder	from	the	Recycle	Bin,	follow	the	steps	given	below:
 1  Open the Recycle Bin 

by double-clicking the 
Recycle Bin icon on the 
desktop.

2 	Select	the	file	or	folder	in	
the Recycle Bin window. 

 3  On the Manage tab, select 
Restore the Selected Items.

					The	selected	file	or	folder	returns	to	the	folder	it	was	in	before	it	was
     deleted.

Rename
You can change the name of 
any	 file	 or	 folder	 based	 on	
changes in its contents at any 
time you want. 

To	 rename	 a	 file	 or	 folder,	
select it in the File Explorer 
and follow the steps given 
below:

1  On the Home tab, in the 
Organize group, click the 
Rename button. In the 
content	area,	the	current	name	of	the	file	or	 folder	becomes	editable.

2  Type the new name and press the Enter key.

NEW GROUP

The New group facilitates you to create new Folders or 
Files as per your requirement. 

Creating a New Folder
To create a new folder, follow the 
steps given below:

1  Click on the Home tab in File Ex-
plorer.

2  Click on the New Folder button 
in the New group. This creates a 
New folder in the content pane.

3  Type the name for the newly 
created Folder and press ENTER

1

2

2

3
1

1

2
3

To Rename, press: F2

TIP
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Creating a New Item
You	can	also	create	blank	files	of	different types in File Explorer, which can be 
opened and edited in the respective application.

To create a new Item, follow the steps given below:

1  Click on the Home tab in File 
Explorer.

2  Click the drop down arrow next 
to the New item button in the 
New group.	The	list	of	file	types	
appears.

3  Choose	the	type	of	file	you	want	
to create. This creates a New 
Item in the content pane.

4  Type the name for the newly 
created	file	and	press	the	ENTER key.

SELECT GROUP

The Select group	 facilitates	you	 to	select	multiple	files	or	
folders from the content pane.

To select a single	file or folder, you can simply click on it.

Select All
To Select all the items in a folder, 
follow the steps given below:

1  Click on the Home tab in File 
Explorer.

2  Click Select all option from the 
Select group.

Selecting Multiple Files
To select multiple consecutive items, follow the steps given below:

1  Click on the first	item and Press and hold the SHIFT key on the keyboard.
2  Click on the last item you want in the selection. Release the SHIFT key. 

To select multiple non-consecutive items, follow the steps given below:
3  Click on the first	item. Press and hold the CTRL key on the keyboard.
4  Click on other items you want to select. Release the CTRL key after you 
finish	your	selection.

1

2

3

4

1 2

TIP
Press CTRL+A on your keyboard to select all the files and folders.



125

S
e
ssio

n
 6

 
MANAGING FOLDERS & FILES AND COMPUTER SETTINGS

 THE VIEW TAB
The View tab hosts the commands that you can use to customize the display of 
items in the File Explorer window.

The	View	tab	allows	you	to	change	the	way	Windows	displays	your	files	and	folders.	
It consists of the following four groups:

A  The Panes group	facilitates	you	to	Show/Hide	the	Navigation	Pane.	It	also	
lets you choose between the Preview Pane and the Details Pane.

B  The Layout enables you to choose among the different icon sizes and their 
Details.

C  The Current view group lets you arrange the icons in different orders.
D  The	Show/Hide group enables you show or hide different options related 
to	files	and	folders.

1

2

3

4

A B C D
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PANES GROUP
The Panes group facilitates you to apply different 
options to the Navigation Pane available on the left of the 
File Explorer. It further facilitates you to access Details or 
Preview panes.

Show/Hide Navigation Pane
To	Show/Hide	the	Navigation	Pane,	follow	the	steps	given	below:

1  Click on the View tab in File Explorer.
 2  Click on the Navigation Pane button in the Panes group. 

3 	Check/Uncheck the Navigation pane option to show or hide it.

Preview and Details panes
You can either display the Preview 
pane or the Details pane on the 
right side of the File Explorer at a 
time. Click on the one you want in 
the Panes group.
 

 A  When the Preview pane is 
active,	 clicking	 on	 a	 file	
displays its content in the 
pane on the right side.

B  If the Details pane is active, 
clicking	on	a	file	displays	its	
detailed information in the 
pane on the right side.

LAYOUT GROUP
For each folder in Windows 10, you can set a custom layout, i.e. change how 
the contents of a folder are displayed. 

The options in the Layout group allows you to choose whether the contents of 
a folder are displayed as icons of various sizes such as Extra-Large, Large, 
Medium, Small icons or as a List, Details, Tiles or Content view.

To change the folder layout, follow the 
steps given below:

1  Click on the View tab in File Explorer.
2  Select the desired View option from 

the Layout group.

A

B

2 1

3

1

2
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WORKING WITH LIBRARIES
By default, the Libraries are hidden in 
Windows File Explorer. If you want to show 
the Libraries node in the navigation pane, 
follow the steps given below:

     Click on the View tab in File Explorer.     
Click on the Navigation Pane button in 
the panes group.

     Click on Show Libraries to make them visible.

Creating a New Library
To create your own custom library, follow the steps given below:

1  Click on the Libraries node 
in the Navigation pane.

2  Right click in the Contents 
pane.

3  Point to the New option.
4  Choose Library. Type the 

name for the new Library 
created in the Content pane. 

      You can open the newly created library and click on Include a Folderbutton 
to	browse	for	and	add	the	first	folder	to	the	library.

Adding Folders to a Library
To add a folder to an existing library, follow the steps given below:

1  Click on the Libraries node 
in the Navigation pane, 
to open Libraries.

2  Click on Manage Library 
button from  Manage 
Contextual tab. 

3  Click the Add button.
4  Browse and select the 

folder that you want to 
include in the library.

5  Click the Include Folder 
button.

1

2

3

1

3 4

2
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1
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MANAGING COMPUTER SETTINGS

In Session 5, you have gone through various personalization settings of Windows 
10. Noticeably, the computer settings have migrated from the more complex 

Control Panel to the seemingly simple Windows Settings App. The Settings app 
organizes	computer	settings	 into	 function	specific	pages	or	categories.	Here,	we	
guide you through the settings under the Time & Language category of Windows 
settings.

 TIME & LANGUAGE SETTINGS
Time and Language option in the Windows 
Settings app allows you to set or 
change your System Date, Time, Region, 
Language and Speech settings.

To open Time & Language settings, 
follow the given step:

1  Open Windows Settings and 
Click on the Time & Language 
category.

The Time & Language settings page 
is displayed. It has three main 
settings options:  

A  Date & Time
B  Region & Language
C  Speech 

1

B

C

A

TIPS

Keyboard Shortcuts:
•Windows key + E – Open a new File Explorer window.
•ALT + P – Show or hide the Preview pane.
•ALT + Shift + P – Show or hide the Details pane.
•ALT + Left arrow key – Move back one folder in your history.
•ALT + Up arrow key – Move up one folder in the folder tree.
•CTRL + N – Open a new File Explorer window from within the File Explore.
•CTRL + E – Activate the Search bar.
•CTRL + Shift + N – Create a new folder in the current folder.
•CTRL + Mouse wheel – Increase or decrease the size of icons or thumbnails

You can also add a folder to a library by right-
click on it and choose Include in Library in the 
shortcut menu. 

You can also change views by holding down CTRL 
key on your keyboard and scrolling mouse wheel.

TIPS
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DATE AND TIME SETTINGS
The settings here are quite simple. You can set the time to adjust automatically 
or change it manually. You can also select your Time Zone according to the 
country you live in.

Date & Time lists the following preferences:
A  Set time automatically. 

If set to ON, the system 
time will be synced 
from the Internet time 
servers. 

B  Change date and time. 
This will become active 
only if you disable the 
"Set time automatically" 
option.

     Allows you to change 
date and time manually.

C  Time Zone. Pick the 
correct time zone that 
matches your location.

D  Adjust for daylight saving time automatically. Queries Internet servers to 
sync the correct daylight saving time.

E 	Formats.	Displays	the	following	formats:	first	day	of	the	week,	short	date,	
long date, short time, long time.

F  Change date and time formats. Allows you to adjust the formats displayed 
on the Date & Time page. Here you can switch between 12-hour and 24-
hour formats for instance (the tt at the end indicates 12 hour formats).

        
To Change the date and time manually, follow the steps given below:

1  Select the Date & Time 
option from Time & Language 
settings.

2  Switch OFF the Set time 
automatically option.

3  Click the Change button.
4  In the Change date and time 

window, modify the date and 
time, and click on the Change 
button to bring the changes 
into effect.

B

A

D E

C

F

21

3

4
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REGION & LANGUAGE
The region & language Settings enable you to change the country or region, 
and to add or remove languages from the system.  Open the Start Menu and 
click on Settings > Time and Language > Region and Language.

Country or region
The	first	option	on	the	right-hand	
pane will allow you to change the 
region.	This	 is	useful	 for	finding	
localized content and apps. You 
can set it to any country you 
desire. Windows and apps may 
or may not use the selected 
region to deliver local content. 
The setting affects Windows 
Store among other things.

A  Click on drop down list to 
choose your region.

Languages
The Languages option allows you to install new languages. You may add new 
languages to the operating system depending on the version of Windows that 
is installed on the computer. Click on Add a Language and you’ll be presented 
with a list of more than 140 languages to choose from. These languages may 
be set to the default system language. 

Add a Language
To add a new Language, follow the steps given below: 

1  Open Windows Settings.
2  Click Time & language 

category.
3  Click Region & language.
4  Under Languages, click 

Add a language.
5  Choose the language you 

want to add, for example 
Arabic,	and	select	the	specific	
variation if applicable. 

A

1

2

The Related Settings, Additional date, Time and regional settings take you to the Control Panel 
where you can change the language, region and date and time of your PC in the old classic way, you 
used to do in the previous versions of Windows.

TIP
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Changing Windows display language
To change the Windows 10 display language, follow the steps given below:

1  Open the Region & 
Language settings 
pane 

2  In the Languages 
area, click a language 
that is not labelled 
as Windows display 
language.

 3  Click Set as default.

Sign out of Windows, and then sign back in to completely implement the display 
language change.

Remove a system language
To remove a system language, follow the steps given below:

1  Open the Region & 
Language settings 
pane.

2  In the Languages 
area, click the 
language you want 
to remove.

3  In the expanded 
pane, click Remove.

1

2
3

1

3

2

3

4

5
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 SYSTEM INFORMATION
It	is	important	to	know	the	configuration	(technical	information)	of	your	computer	system,	
such as edition or version of Windows, Processor details, Amount of RAM, etc. Windows 
10 provides System Information in a modern way. 

To display the System Information, open Windows Settings App and follow the 
steps given below:

1   Choose the System 
category in the 
Settings window,

A  The System settings 
window appears.

2  Scroll down the menu 
on the left and click on 
About option.

B  The System Information 
appears on the right 
side.

Windows 10 System Information has the following:
C  PC Name: Gives the 

name of the computer, 
chosen while installing 
Windows. 

	 	 	 The	 Name	 identifies	 a	
computer on a network. 
It may be different 
than the user name of 
the user account.

D  Edition: Displays the 
edition of the Windows 
installed.

E  Version: Displays the 
Version number of the 
Windows edition.

F  Product ID: Displays the activation status of Windows. Shows the Product 
ID if Windows is already activated. 

G  Processor: Displays the type and speed of the installed Processor. 
H  Installed RAM: Displays the amount of RAM installed.

1

A C

D

H

E

F
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 TASK MANAGER
You learnt about the Task View to view and switch among the running apps. If you 
want to know the resource consumption by each running app, you can use the Task 
Manager tool of Windows 10. 

The Task Manager displays the status of all the running apps along with the background 
processes.

It also displays the amount of system 
resources utilized by the app, such 
as Memory, CPU, and Disk.

To start the Task Manager, Right click 
on empty area of the Taskbar and 
choose Task Manager.

You can close any Not Responding 
app from the Task Manager by 
clicking on the End task button at 
the bottom right corner.

You can also monitor the real time 
performance of CPU, Memory, Disk, 
and Network by clicking on the 
Performance Tab at the top.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. 	 ________	is	the	file	management	application	of	Windows	10	to	access,	edit	
and	manage	files/	folders.

a. File Explorer

b. Control Panel

c. My Computer

d. My Documents

2. When	you	cut	or	copy	a	file/	folder,	it	is	stored	temporarily	in	the________.

a. File

b. Clipboard

c. Icon

d. Recycle bin

3. We	can	restore	the	deleted	files/	folders	from	the	________.

a. Recycle bin

b. My document

c. File Explorer

d. All of the above

4. The keyboard shortcut to activate the Search bar of File Explorer_______.

a. Ctrl + S

b. Window key + E

c. Ctrl + E

d. Ctrl + N
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Fill in the blanks with the appropriate words provided in the 
box. 

Quick Access Navigation Pane Contents Pane System Information Folder

  1. 	A________	is	a	container	in	which	files,	folders	and	apps	are	stored.

2. A_______ appears by default on the left side of the File Explorer window and 
allows	you	to	browse	for	the	folders	and	files	on	your	computer.

3. The_______ node in the Navigation pane give you a quick way to open 
frequently used folders.

4. We	can	use	________to	view	the	complete	system	specifications	like	Windows	
edition,	memory	configuration,	computer	name,	etc.

Activity 3

Practice the following tasks on your computer.
1. Open the File Explorer and Create a new folder named “Sample” inside the 

“Documents” folder. (Hint: Use the “New folder” button in the File Explorer 
window.)

2. Pin the “Sample” folder to the Quick access button. (Hint: This folder is 
located within the “Documents” folder)

3. Rename the “Sample” folder as “My Files”. (Hint: “Sample” folder is available 
in the “Documents” folder)

4. Create a new item “Microsoft word document” inside the “Documents” folder. 
(Hint: Use the “New item” button in the File Explorer window.)

Activity 2
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Module Three

Word Processing
(Word 2016)

Session 7: Overview of Application Software, Word Pro-
cessing, Getting Started with Word 2016 & The 
File Tab

Session 9: The Home Tab & The Insert Tab

Session 8: The Home Tab

Session 10: The Insert Tab

Session 11: The Insert Tab & The Layout Tab

Session 12: The References Tab & The Review Tab

Session 13: The View Tab & Other Features of Word 2016
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OBJECTIVES

In this Session, you will learn about Overview of Word 
Processing, Getting Started with Word 2016 & The 
File Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	Overview of Application Software
•	Application Software
•	Software Suites 

 
•	Overview of Word Processing

•	Word Processor

•	Getting Started with Word 2016
•	Starting Word 2016
•	User Interface of Word 2016
•	New Features of Word 2016
•	Creating a simple document
•	Navigating through a document

•	The File Tab
•	Managing Documents

Specific Objectives

Session
7

OBJECTIVES

Overview of Application Software, Word 
Processing, Getting Started with Word 

2016 & The File Tab
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OVERVIEW OF APPLICATION SOFTWARE

In the previous module, you have learnt about Windows 10, which is a System 
Software. There is another type of software called Application Software. The 

following section provides you an outline of it.

APPLICATION SOFTWARE
Application software is a program, or group of 
programs, designed for end users	to	perform	specific	
tasks. Examples include applications such as database 
programs, word processors and spreadsheets. 

Application	Software	can	further	be	classified	as	General Purpose Applications and 
Special Purpose Applications. The General Purpose applications, such as Word, 
Excel, PowerPoint, Microsoft Edge, etc. are useful to almost all computer users. 
Special	 Purpose	 applications	 are	 customized	 software	 used	 for	 specific	 purpose,	
such	as	Hospital	Management	System,	Air	Traffic	Control	System,	etc.

Application software may simply be referred to as an application.

TIP

SOFTWARE SUITES
A software suite is a collection of two or more software 
programs that are bundled and sold together. Each 
component program generally provides different 
but related functionality. A good example of a 
software	suite	 is	Microsoft	Office,	which	has	multiple	
software programs like Word (Word Processor), 
Excel(Spreadsheet),PowerPoint(Presentat ion 
Program), and Outlook (E-mail client). Other examples 
include Adobe Graphics suite, Corel Graphics suite, etc.

MS OFFICE 2016
MS	 Office	 2016	 is	 the	 latest	 release	 of	
the	 Microsoft	 Office	 suite.	 It	 is	 a	 complete	
package or suite from Microsoft Corporation, 
which consists of applications such as Word 
2016, Excel 2016, PowerPoint 2016, Access 
2016, Publisher 2016, and Outlook 2016, etc. 
It is the most widely used productivity suite having the general purpose 
applications	useful	for	the	corporate	office	environment	or	to	a	home	user.

LEARNING
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OVERVIEW OF WORD PROCESSING  
Word processing is the phrase used to describe "using a computer to create, edit, 
and print documents". Of all computer applications, word processing is the most 
common. To perform word processing, you need a computer, a special program 
called a word processor, and a printer. The major advantage of Word Processing is 
that you can make changes without retyping the entire document. 

WORD PROCESSOR
The application used for Word Processing is commonly known as a Word Processor. 
A word processor enables you to create a document, store it electronically on a disk, 
display it on a screen, modify it by entering commands and characters from the 
keyboard, and print it on a printer. These documents can be closed and opened again 
to continue working on them.

A word processor provides the following common features:
•	Spell Checker
•	Find & Replace
•	Formatting
•	Word wrap
•	Headers & Footers

POPULAR WORD PROCESSORS
There is a variety of Word Processors available in the market from different 
vendors. The Following are some of the popular Word Processors.
•	Microsoft’s Word 2016
•	Apple’s Pages
•	Corel’s WordPerfect

GETTING STARTED WITH WORD 2016  

Word 2016 is the most widely used word processor designed by Microsoft. It is a 
part	of	the	Microsoft	Office	suite,	but	can	also	be	purchased	as	a	stand-alone	

product. It is available for Windows and Macintosh operating systems.

Word 2016 allows you to create various types of professional documents such as 
Letters, Flyers, Brochures, Manuals, CVs and more.

STARTING WORD 2016
You know that Word 2016 is a word processor. To create a document in Word 2016, 
you need to start the application.
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 To start MS Word 2016 in Windows 10, follow the 
steps given below:

 Click on Start Button to open the Start menu.
 Click on Word 2016 from the All Apps list.

The Start Screen of Word 2016 appears with different 
options	 to	 open	 a	 file.	 You	 can	 either	 choose	 an	
existing	file	 or	 start	with	 a	new	one.	 Pressing	 the	
Esc key will start with a new blank document.

USER INTERFACE OF WORD 2016
The	Microsoft	Office	2016	user	 interface	 is	 quite	 uniform	across	 its	 components.	
Word	2016	offers	a	more	refined	user	interface	along	with	many	interesting	tools.	

The user interface of Word 2016 consists of the following:
 Quick Access Toolbar: It provides the easy access to the commands 

that	 you	 use	 frequently.	 By	 default,	 it	 has	 the	Save, Undo & Repeat 
commands. You can add or remove commands to Quick Access Toolbar 
by simply clicking on the Customize arrow button on its right.

 Ribbon: Almost all the commands in Word 2016 are compiled together in 
the	form	of	a	Ribbon,	in	order	to	help	you	work	efficiently.

 Tabs: At the top of the Ribbon is a set of tabs. Clicking a tab displays an 
associated set of commands.

 Groups: Related commands of a Ribbon Tab are organized in Groups.

1
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 Dialog Box Launcher: Clicking the Dialog box launcher displays the 
associated dialog box or pane.

 Ribbon Display Options: It allows you to Show or hide the Ribbon. Click 
on it to choose from the menu options Auto-hide ribbon, Show Tabs, or 
Show Tabs and Commands. 

 Work Area: The white area in the middle of the Word 2016 user interface 
is the Work Area or Workspace. This represents the actual page where 
you type text, edit or format a document.

 The Insertion Point (Cursor): The Insertion Point or Cursor is the blinking 
vertical line in the Work Area.  It indicates the current active place in the 
document where you can insert text, images, apply editing or formatting 
commands.

     Rulers: It helps you to view and adjust the position of the contents in the 
document.

    The Status Bar: It displays the information about the current document 
such as the total number of pages, the current page number, total 
number of words in the document, current proofing language and 
proofing status.

    View Buttons: Three view buttons Read Mode, Print Layout, and Web 
layout on the right side of the Status bar allows you to easily switch 
between the document views. 

     Zoom Slider and Buttons: These allow you to easily adjust the zoom level 
of the document contents as per your convenience.

ADDING COMMANDS TO QUICK ACCESS TOOLBAR
The Quick Access Toolbar allows you to add 
frequently	used	commands	so	that	they	are	
readily available. 

To add commands to Quick Access Toolbar, 
follow steps given below: 

  Click on the Customize Quick Access 
Toolbar arrow. 

    Choose the desired command from the 
displayed list. 

E
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2

When you move your mouse over most commands, a Tooltip is displayed. This provides a brief 
description about that command. Equivalent keyboard shortcuts are also displayed, if applicable.

TIP
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REMOVING COMMANDS FROM QUICK ACCESS TOOLBAR
To remove a command from the Quick Access 
Toolbar, follow the steps given below:

   Click on the Customize Quick Access 
Toolbar arrow.

2  Uncheck the desired command from 
the displayed list.

 RIBBON DISPLAY OPTIONS
You can control the display of the ribbon by clicking the commands on the 
Ribbon Display Options menu. It is 
located on the right side of the title bar, 
near the minimize button. It provides you 
with three options:

 Auto-hide Ribbon: This option hides 
the ribbon and maximizes the 
workspace. You need to click the top 
of the screen to view the ribbon. 

 Show Tabs: This option show Ribbon 
tabs only. You need to click on the tab 
to reveal the ribbon's commands for 
that tab. 

 Show Tabs and Commands: This 
option always show Ribbon tabs and 
commands.

USING ACCESS KEYS
Access keys are a set of keyboard shortcuts used to access the Tabs and 
Commands. You need to press the Alt key to activate the Access keys. This 
displays the little labels, or badges for all the tabs. After you press a key to 
activate a particular tab, the badges for the commands on that tab appear. 
Every single command on the Ribbon and the Quick Access Toolbar has an 
access key. Press the Alt key once again to hide the Access keys. 
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NEW FEATURES OF WORD 2016
Word	2016	is	equipped	with	several	new	features	to	help	you	work	more	efficiently.	
Out of these, following are the two useful features.

TELL ME BOX
In Word 2016 user interface screen, you 
might have noticed a text box on the right 
of the ribbon tabs with a bulb sign that says 
“Tell me what you want to do…” 

 It	allows	you	to	do	the	things	quickly	
and	 efficiently,	 keeping	 you	 free	
from remembering and locating the 
commands in various tabs & ribbons.

 All you have to do is to simply enter 
a word or a phrase in the Tell Me box 
about the command you want.

    Word 2016 provides you a list of the 
related commands. You can choose 
the one you are looking for. 

 You can even use the Tell Me box to 
get help on a particular command.

SMART LOOKUP
Another interesting feature in Word 2016 is the Smart Lookup. It allows you 
to	get	 the	definitions,	Wikipedia	articles,	and	 top	 related	searches	 from	 the	
web about any word or phrase in your document. Thus, bringing the research 
directly in to Word 2016.

 Select the word and right click 
on it. 

                  Choose the Smart Lookup option.
     The Insights pane appears with  

the results from the online 
sources like  Wikipedia, Bing, 
and Oxford Dictionaries.

Amazing thing of the Smart Lookup 
is that it gives you the contextual 
results that are relevant for the use 
of the selected word or phrase in the 
document. For example, if you use 
Smart Lookup	 selecting	 the	 word	 office	 in	 the	 phrases	Office Furniture and 
Microsoft Office Apps, the results in the Insights pane will be different according 
to the phrase. 
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CREATING A SIMPLE DOCUMENT  
By now, you have learnt about the interface of Word 2016. You have gone through 
the different features available in Word to ease your work. You can now create 
a	simple	document	to	have	a	practical	hands-on	experience.	Acquiring	the	basic	
skills of entering text, selecting text and navigating around in the document will 
help	you	to	work	efficiently	with	Word	2016.

CREATE A NEW DOCUMENT

As already discussed, when you start Word 2016, you can choose to start with 
a new blank document. You can even create a New document from an already 
open Word document.

To create a New Blank 
document, follow the 
steps given below:

 Click on the File 
tab.

 Click on the 
New command.

 Click on the Blank document.
 Templates: A Template is a pre-

designed document that can 
be used to create similar new 
documents. All the formatting 
is complete; just add your own 
contents and your document 
is ready. A lot of templates 
to create brochures, invoices, 
letters,	CVs,	certificates,	etc.,	
are already pre-installed in 
Word 2016. Moreover, you can 
browse through thousands of 
online templates. You can also 
create a Template from your 
document in Word 2016.

ENTERING TEXT
Whenever	a	new	document	 is	created,	the	flashing	cursor	 is	always	seen	at	
the	 beginning	 of	 the	 first	 line.	 You	 can	 start	 entering	 text	 by	 pressing	 the	
keys on the keyboard. As you press any alphabet key on the keyboard, that 
alphabet is inserted before the cursor or the insertion point and the cursor 
moves one position ahead. You can continue typing to complete a word. Press 
the Spacebar key to leave a space between each word. 
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Word Wrap
Whenever you reach the end of line, the cursor jumps to the next line 
automatically.	If	the	last	word	cannot	fit	on	a	line,	it	will	also	jump	with	the	
cursor to the next line. This feature is known as Word Wrap.  This allows you 
to type in continuously without bothering about the end of lines.
 

Use of Enter Key
Press the Enter key when you want to end the current paragraph and start 
with a new one. In fact, whenever you press the Enter key in the document, 
Word treats it as a new paragraph. Thus, a paragraph in Word 2016 can be of 
multiple lines, a single line, or even a single word.

Use of Tab Key
The Tab key allows you to leave some blank space and enter the text away in 
a line instead of pressing the Space key multiple times. Pressing the Tab key 
jumps	the	cursor	five	spaces	ahead,	by	default.	You	can	also	set	the	Tab	stop	
positions	as	required.	This	is	usually	helpful	in	creating	structured	documents.	
Tab key is also helpful while working with Tables in Word.

SELECTING TEXT
To	edit	or	format	text,	you	need	to	select	it	first.	You	can	select	text	by	two	
ways, either by using mouse or keyboard. 
To select using keyboard, press and hold the Shift key along with Navigation 
Keys (j, i, l, k).
To select using mouse, click and drag the mouse over the text you want to select.

DELETING TEXT
In order to delete the characters in a document, you can use the Delete or the 
Backspace key. The Delete key is used to delete the english characters to the 
right of the cursor. The Backspace key is used to delete the english characters 
to the left of the cursor.
If you want to delete a section of text in the document, select the text and 
press the Delete or the Backspace key.

To select a single word, double click on it.
To select a paragraph, position the mouse pointer in the paragraph and click 3 times.
To select the entire document, use the Keyboard Shortcut CTRL + A.
To deselect text, click anywhere outside the selected area or use the Arrow keys.

TIPS

To delete a whole word to the right of the cursor, use the Keyboard Shortcut CTRL + Delete.

To delete a whole word to the left of the cursor, use the Keyboard Shortcut CTRL + Backspace.

TIPS
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UNDO AND REDO OPTIONS

Sometimes after making some changes in a document, you may decide that 
they are not necessary. You can reverse your last action by using the Undo 
command. 

To undo any action, follow the steps given below:
 Click the Undo button on the Quick Access 

toolbar or use the keyboard shortcut CTRL + Z.
 You can click on the arrow symbol to select 

and Undo multiple commands you performed 
recently or use the keyboard shortcut CTRL + 
Z repeatedly.

Redo command is used to perform the actions which has been undone by the 
Undo command.

To Redo an action, follow the step given below:
 Click the Redo command on the Quick Access Toolbar or use the keyboard 

shortcut CTRL + Y.
The Redo command can also be used to Repeat your last action for another 
selection. To use the Redo command as Repeat, Select the text where you want 
to repeat your last command and Click the Redo/Repeat button on the Quick 
Access Toolbar or use the keyboard shortcut CTRL + Y.

NAVIGATING THROUGH A DOCUMENT
While	working	on	a	document,	it	is	frequently	required	to	locate	and	select	a	section	
of text from any part of the document. You can move across the whole document 
with keyboard or mouse.

NAVIGATING WITH KEYBOARD
Keyboard allows you to navigate through a document using the following key(s).
•	To move through left, right, up or down directions, use the four Arrow keys 

(j, i, l, k) on the keyboard.
•	 To	move	through	word	by	word	in	the	left	or	right	direction,	use	the	Control 

key (CTRL) along with the left or right arrow keys (j, l).
•	 To	move	through	by	a	paragraph	in	up	or	down	direction,	use	the	Control 

key (CTRL) along with the up or down arrow keys (i, k).
•	 To	jump	directly	to	the	beginning	or	the	end	of	the	current	line,	use	Home 

or End key on the keyboard.
•	 To	jump	to	the	beginning	or	the	end	of	the	document,	use	the	Control Key 

(CTRL) key along with the Home or End key.
•	 To	move	page	by	page	in	up	or	down	directions,	use	the	Page Up or Page 

Down key.
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TIP

NAVIGATING WITH MOUSE AND SCROLL BARS
Moving	to	a	part	of	the	document	can	be	sometimes	quicker	with	mouse.	You	
can simply use the mouse wheel or the scroll bars to locate the part of the 
document you want. Word 2016 provides you two types of scroll bars:

 Vertical scrollbar: 
This allows you to 
navigate through the 
document in up-down 
directions.

 Horizontal scrollbar: 
This allows you to 
navigate through the 
document in left-right 
directions.

USING THE NAVIGATION PANE
In Word 2016, Microsoft has improved the navigation experience with the 
Navigation Pane. The navigation pane allows you to move across a document 
by Heading levels, Pages or by Results of a text search. With the help of 
navigation	Pane,	you	can	search	specific	text	and	even	browse	the	pages	in	the	
document. 

To open the navigation 
pane, follow the steps given 
below:

 Click on the View tab.
 In the Show group, 

check the Navigation 
Pane box. 

 The navigation pane 
opens at the left of your document window.

USING GO TO OPTION
Go To option takes you di-
rectly	to	the	required	page,	
section etc., by entering 
the desired page or sec-
tion number. This option is 
available under Find menu 
of Editing group in the 
Home Tab.
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THE FILE TAB

The	first	tab	in	Word	2016	is	the	File	Tab.	When	you	click	the	File	tab,	the	document	
window becomes invisible and a menu is displayed on the left with the options 

such as Save, Close, and Print a document. It also displays the information about the 
current document on the right side. The view of File tab is also called the Backstage view.

MANAGING DOCUMENTS
The File tab provides the options to manage the documents. You can Save, Open, 
Close, or Print your documents using the File Tab.

SAVING A DOCUMENT
Saving your work at regular intervals is very important. This will prevent data 
loss due to power failure or unforeseen circumstances. By default, a document 
in	Word	2016	is	saved	with	the	file	extension	.docx.

To Save a document from the File Tab, follow the steps given below:

 Click on the File tab. 
 Choose the Save option. 

When	you	save	a	new	file	for	the	first	time,	the	
Backstage View shows the Save As options to 
choose the location where you want to save the 
document. 

 OneDrive: Allows you to 
save the document online 
to OneDrive cloud. You need 
an active internet connec-
tion and a Microsoft One-
Drive account.

 This PC: Allows you to 
save the document locally 
on the computer. You can 
choose from the recent 
folders shown on the right 
side.

 Browse: Allows you to 
choose a folder location 
manually on the computer.

 After choosing any of the above 
locations, the Save As dialog 
box is displayed.

To Save a document, you can also use the Save icon on the Quick Access Toolbar or the Keyboard 
Shortcut CTRL + S.

TIP
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 Enter the name in the File name box.
 Click on the Save button.

When you make changes to your document after saving and want to save the 
updated	file,	you	can	repeat	steps	1	and	2.

USING SAVE AS OPTION

The Save As option is used to save a copy of an existing document with a new 
name in the same or different location. You can also choose a different format 
such as PDF, Web page, Word 97-2003 document, etc. 
The steps for using the Save As option are almost same as saving a document 
for	the	first	time,	as	mentioned	above,	except	the	following:

 Select the Save As option in the Backstage view.
 Choose	the	file	type	in	the	Save as type option in the Save As dialog box.

CLOSING A DOCUMENT
Word 2016 allows you to close a document without closing the application. 
If any open document is unsaved, Word 2016 will prompt you to save your 
document before closing.
To close a document without closing the Word 2016 application, 

 Click on Close option in the Backstage view.

If there is only one open document, clicking on “X” button at the top right corner of the title bar will 
quit Word 2016 by closing the document.

TIP

OPENING AN EXISTING DOCUMENT
To open an existing document, 
follow the steps given below:

 Click the File tab and select 
the Open command. 

 Choose	the	desired	file	from	
the Recent	 files	 list	 that	
appears in the Backstage 
view.

 If	 the	 desired	 file	 is	 not	
listed, click the Browse 
option	 to	 display	 the	 file	
Open dialog box.

 Browse	 and	 select	 the	 file	
you want to open.

 Click the Open button. 
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PINNING A RECENT DOCUMENT
When the list of recent documents is full and you open a new or existing 
document, the last document in the recent document list is removed. You may 
wish to have certain important documents displayed in this list at all times for 
quick	access.	For	this,	you	may	pin	them	to	the	Recent Documents list.

To pin a document to the recent documents list, follow the steps given below:
 Point to the document 

you want to Pin in the 
recent documents 
list. This highlights 
the document and 
shows a Pin symbol 
in the right end.

 Click on the Pin Sym-
bol to add it to the 
Pinned group.

You can unpin a pinned document by simply clicking on its pin symbol.

PRINTING A DOCUMENT
You can print a document to get a hardcopy on paper. 
To print a document,

1   Choose the Print
     command from the
    File Tab. The Back-

stage View shows 
the Print interface 
and a preview of 
the current page.
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Keyboard Shortcuts

Create a New Blank Document   CTRL + N

Save a Document   CTRL + S

Open a Document   CTRL + O

Close a Document   CTRL + W

Save As a Document   F12 KEY

Print a Document   CTRL + P

TIPS
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1.  Which of the following is not an application software?

a. Microsoft Word 

b. Photoshop 

c. Microsoft Edge

d. Windows 10

2.	 ______	on	the	right	of	the	ribbon	tabs	allows	you	to	quickly	get	to	commands	
and features you want to use.

a. Status Bar

b. Smart Lookup

c. Tell Me box

d. Toot tip

3. To erase a character to the right of the cursor, press the _____ key.

a. Delete

b. End

c. Backspace

d. Home 

4.	 _______	is	the	default	file	extension	for	a	document	in	Word	2016.

a. .dotx

b. .docx

c. .decx

d. .txt
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

CTRL + P CTRL + Y CTRL + N CTRL + A CTRL + Z

1. The keyboard shortcut to Undo the changes in a document is ______.

2. The keyboard shortcut to select entire document is ________.

3. The keyboard shortcut to Print a document is _________.

4. The keyboard shortcut to create a New blank document is _________.

Activity 3

Practice the following tasks on your computer.
1. Create a new Microsoft Word document. Type the text “Welcome” and 
save	the	file	with	the	name	“Practice”.	(Hint:	You	can	save	this	file	to	the	
documents folder.)

2. Open the document “Practice”. (Hint: You can open it from the Recent 
option.)

3.		Pin	the	“Practice”	document	to	the	recent	files	list.	

4.  Create a new document using the template “Welcome to Word”.
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THE HOME TABSession
8

In this Session, you will learn about the Clipboard 
group, Font group and Paragraph group of Home Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The Home Tab
•	Clipboard Group
•	Font Group
•	Paragraph Group

Specific Objectives

OBJECTIVES
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THE HOME TAB

You learnt about the File Tab in the previous session. The next tab after it in Word 
2016 is the Home Tab. Home tab is generally used to format the documents. 

You can use effects like Bold, Italic, Underline, Size of Text, Alignment of Text, 
Quick	Styles	and	Formatting	of	whole	paragraph,	etc.	You	can	also	use	it	to	find	and	
replace words or phrases in the document.

A B C D E

The	Home	Tab	commands	are	divided	into	five	groups.	

 Clipboard: This group contains the main editing commands such as Cut, 
Copy and Paste.

 Font: This group commands enable you to modify and enhance the 
appearance of your text.

 Paragraph: This group commands enable you to format complete 
paragraphs.

 Styles: This	group	commands	enable	you	to	apply	pre-defined	formatting	
styles.

 Editing:	This	group	commands	help	you	to	find	and	replace	text	as	well	
as select text or objects.

CLIPBOARD GROUP

The First group in Home tab is the Clipboard group, which enables you to access and 
use	contents	of	the	Office	Clipboard.	

A clipboard is a temporary storage area where text or other data, which has been 
cut or copied from	a	file,	is	stored.
There are four commands in the Clipboard: Cut, Copy, Paste, Format Painter. 

COPY

The Copy command stores a copy of 
the selection on the Clipboard so you 
can paste it somewhere else. 
To copy the text, follow the steps 
given below:
 

A

B

C

D

E

LEARNING

1



157

THE HOME TAB
S

e
ssio

n
 8

 

 Select the text you want to copy.

 Click Copy from clipboard group or press CTRL + C. 

 Place the cursor to the position you want to paste and 
click Paste command or press CTRL + V.

CUT
The Cut command removes the selection 
and stores it on the Clipboard so you can 
paste it somewhere else.

To Cut (or Move) the text, follow the steps 
given below:

 Select the text you want to cut.
 Click Cut from clipboard group or press CTRL + X.
 Place the cursor to the position you want to paste and 

click Paste command from Clipboard group or press 
CTRL + V.

PASTE
The Paste command is used to add content from the Clipboard to your 
document. 

To paste the contents of the clipboard to the current cursor position, click the 
Paste from the Clipboard group or use the shortcut Ctrl + V.

PASTE OPTIONS
The Paste command provides you with different paste 
options, such as to paste the text with the source format 
or to match the destination format. To display the Paste 
options, click on the arrow below the Paste command. 

 Keep Source Formatting: Preserves the style of the 
original text. 

 Merge Formatting: Changes the formatting so that it 
matches the text that surrounds it.

 Keep Text Only: Removes all the original formatting 
from the text.

USING DRAG AND DROP
Moving or Copying text/object using Mouse is called Drag and Drop. 
To Move the selected text, click and hold the left mouse button and drag it to 
the new place. 

To Copy the selected text, click and hold the left mouse button along with 
CTRL key and drag it to the new place. 
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FORMAT PAINTER
Do you like the look of a particular selection? You can apply that look to other 
content in the document. The Format Painter command is used to copy the 
formatting applied to a section of text to another section of text.

To apply the formatting style of the selected text, 

 From the Clipboard group, click Format Painter.
Your mouse pointer changes to a paint brush. Now 
drag it over the text to which you wish to apply the 
formatting.

CLIPBOARD PANE
The Clipboard pane is used to see all the items you have 
cut or copied to the Clipboard. 

To open the clipboard pane, follow the steps given below:
 Click the Home tab
 In the Clipboard group, click the Dialog Box Launcher 

to display the Clipboard pane. 
 Here you can see all items that you have copied or 

cut. Click any item to insert it individually.
 Paste All: This button is used to insert the complete 

content from the clipboard.
 Clear All: This button is used to clear all the content 

from the clipboard.

 FONT GROUP

The next group of Home tab after Clipboard is Font. This group consists of 
commands that enable you to modify and enhance the appearance of your text.

FONT
A Font is a graphical design (typeface) having particular size, weight, and style 
for a set of characters. The Font box is used to change the font of selected 
text. It lets you pick a new font for your text.
To change the Font of the selected text, follow the steps given below:
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If you wish to apply the selected formatting at multiple places, double-click the Format Painter 

command. You can then drag over multiple areas. Press Escape Key when done.

TIP
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 Click the arrow to the right of the 
Font box.

 Select the desired font from avail-
able fonts.

The new font is applied to the selected 
text.

FONT SIZE
The Font Size box is used to change the size of selected text.

To Change the size of the selected text, 
follow the steps given below:

 Click the arrow to the right of the 
Font Size box.

 Select the desired font size from 
the font size list.

INCREASE FONT SIZE AND DECREASE FONT SIZE
Word 2016 also gives you the following two options to change the font size. 

 The Increase Font Size icon is used 
to make your text a bit bigger. 

 The Decrease Font Size icon is used 
to make your text a bit smaller.

FONT COLOR
The Font Color command is used to 
change the color of text. Using different 
colors makes text more attractive.

To change the Font color of the selected 
text, follow the steps given below:

 Click on the arrow to the right of 
the Font Color command.

 Select the desired color.

FONT STYLE: BOLD, ITALIC, UNDERLINE
Word 2016 permits you to apply the following text styles to your document:

 The Bold command is used to make text appear thicker.
 The Italic command is used to make the selected text slant to the right.
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 The Underline command is used to 
draw a line below text. On clicking 
the small arrow besides underline 
icon, more underline options are 
available like Double Underline, Thick 
Underline, etc. 

To apply the bold effect to the selected 
text, follow the steps given below:

 Select the text to which you want to 
apply bold effect.

 Click on Bold command in the Font group.
In the same way you can change the text to 
italic (I) and underline (U).

CHANGE CASE  
Word 2016 allows you to change the capitalization of the selected text to 
uppercase, lowercase, etc. The different available options are as follows:

 Sentence case	-	Only	the	first	letter	of	
the sentence is capitalized.

 lowercase - Changes the selected text 
to small letters.

 UPPERCASE – Changes the selected 
text to capital letters.

 Capitalize Each Word –	Makes	the	first	
letter of each word capital.

 tOGGLE cASE – Changes the capital letters to small & small to capital.
To Change Case of the text, follow the steps given below:

 Select the text for which you want to change case.
 Click the Change Case command of font group and select the desired case.

TEXT HIGHLIGHT COLOR
The Text Highlight Color command is 
used to make your text pop by highlighting 
it with a bright color.

To apply a text highlighter to the selected 
text, follow the steps given below: 

 Click the Text Highlight Color command 
of font group.

 Select the color you want.
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You can also use the shortcuts Ctrl + B to Bold text, Ctrl + I to Italic text and Ctrl + U to Underline text.
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TEXT EFFECTS AND TYPOGRAPHY
The Text Effects and Typography command 
is used to apply various effects to selected text. 
You	can	add	some	flair	to	your	text	by	applying	a	
text effect. Additionally, you can select Outline, 
Shadow, Reflection and Glow effects from 
the list. You can also change the typography 
settings to enable a stylistic set.

To apply the text effect to the selected text, 
follow the steps given below:

 Click on the Text effect command of font 
group.

 Select the desired effect.

CLEAR ALL FORMATTING
Clear All Formatting command removes all 
formatting from the selection, leaving only the 
normal, unformatted text.

To clear all the formatting from the selected text,
 Click on Clear All Formatting command of 

font group.

STRIKETHROUGH
The Strikethrough command is used to draw a 
line through the middle of selected text so that 
it indicates the text is stroked/cancelled out.
To apply the Strikethrough effect to the selected text,

 Click on the Strikethrough command of 
font group.

 
SUBSCRIPT AND SUPERSCRIPT

The Subscript command is used to type letters 
in very small size, just below the line of text. For 
example, H2O.
Similarly, the Superscript command is used to 
type letters in very small size, just above the 
line of text. For example, (A+B)2.
To apply the Subscript/Superscript to the 
selected text,  

      Click X2 (Subscript) or X2 (Superscript) command as desired. 
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You can also apply Double Strikethrough from effect option available in Font dialog box. 
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FONT DIALOG BOX
The Font dialog box is used to apply a 
combination of various formatting effects. You 
can customize your text using advanced font 
and character options to give it the exact look 
you want. You can add a variety of styles and 
colors to your text, as well as visual effects, like 
strikethrough, superscript and all caps.

To open the Font dialog box, follow the steps 
given below:

 Click the Dialog Box Launcher in the Font 
group to display the Font dialog box. 

 Choose the effects as per your 
requirements	and	click	the	OK button.

 

PARAGRAPH GROUP
In the Font group, you learnt to change the typeface and type settings of your 
text. Most of the commands in the Font group deal with the individual characters. 
However, in order to work with the complete paragraph, Word 2016 provides you with 
the Paragraph group. The commands in this group enable you to format complete 
paragraphs.

ALIGNMENT
Alignment refers to the way text is positioned 
horizontally in a given paragraph.

There are four types of text Alignments: 
 Align Left (Ctrl + L): This command 

aligns your content with the left margin. 
It is commonly used for body text and 
makes the document easier to read.

 Centre (Ctrl + E): This command aligns 
your content in the center. It gives documents a formal appearance and 
is	often	used	for	cover	pages,	quotes,	and	sometimes	headings.

 Align Right (Ctrl + R): This command aligns your content with the right 
margin. It is used for small sections of content, such as text in a header or 
footer.

 Justify (Ctrl + J): This command distributes your text evenly between 
the margins. It gives your document clean, crisp edges so it looks more 
polished.
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The shortcut to open the Font Dialog box is Ctrl + D.
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INDENTATION
Indentation determines the distance of the 
paragraph from either the left margin or the right 
margin. Increase Indent moves your paragraph 
farther away from the left margin. Decrease 
Indent moves your paragraph closer to the left 
margin.

 Click on the Increase Indent command to move the paragraph towards right. 
 Click on the Decrease Indent command to move the paragraph back to 

its original position.

LINE AND PARAGRAPH SPACING
The Line and Paragraph Spacing command enables you to choose how much 
space appears between lines of text or between paragraphs. 

It provides you with the following two 
options:

 Add Space Before Paragraph 
 Remove Space After Paragraph

To change the line spacing in a 
paragraph, follow the steps given below:

 Select the lines or paragraphs 
to which you want to apply the 
line spacing.

 Click on the line spacing command in paragraph group and choose the 
desired line spacing from the list.

BULLETS AND NUMBERING
Bullets and Numbering help you to create a bulleted or 
numbered list in your document. 

 Bullets: This command allows you to create a bulleted list. 
 Numbering: This command allows you to create a 

numbered list. 
To create a Bulleted/Numbered list for the selected text, 
follow the steps given below:

 Click the arrow to the right of the Bullets/Numbering 
command.

 Select the desired format.
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To apply the same spacing to your whole document, use the Paragraph Spacing command on the 
Design tab.

TIP

You can also use the horizontal Ruler just below the Ribbon for Indentation.

TIP



164

THE HOME TABModule Three : Word Processing (MS Word 2016)

BORDERS
This command is used to add or remove borders from your selection. 

To apply a border to a paragraph, follow the steps given below:
 Select the text for which you want 

to apply border.
 Click on the Borders command 

of paragraph group and choose 
desired border. 

 Borders and Shading: This option 
allows you to explore additional 
border options, such as line color 
and line width.

SHADING
Shading command is used to change the color behind the selected text, 
paragraph or table cell. 

To apply shading to the text, follow the 
steps given below: 

 Select the text or line to apply shade.
 Click on the arrow to the right 

of the Shading command of the 
paragraph group.

 Select the desired color from the 
color palette.

PARAGRAPH SETTINGS
The Paragraph Settings dialog box is used to apply 
a combination of various paragraph formatting effects. 
You	can	fine-tune	the	layout	of	the	selected	paragraph,	
including spacing, indentation, and more.

To open the Paragraph Settings dialog box, follow the 
steps given below:

 Click the Dialog Box Launcher in the Paragraph 
group. 

 Choose	the	effects	as	per	your	requirements	and	
click the OK button.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. Which operation you will perform to move the selected text from one place 

to another?

a. Copy and Paste

b. Cut and Paste

c. Paste and Delete

d. Paste and Cut

2. Characters that are smaller than normal text and typed just above the line of 
text is known as _________.

a. Strikethrough

b. Decrease Font Size

c. Superscript

d. Subscript

3. ________ command is used to make your text look like as if you have 
highlighted it with a highlighter pen.

a. Shading

b. Font Color

c. Highlighter pen

d. Text Highlight Color 

4. _______ option from the Change Case command, makes the selected text 
into capital letters.

a. Lowercase

b. Sentence case

c. Uppercase

d. Capitalize each word
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Ctrl + E Ctrl + U Underline Ctrl + D Strikethrough

1. The keyboard shortcut to Underline the selected text is ______.

2. The _______ command allows you to draw a line through the middle of 
selected text.

3. The keyboard shortcut to open font dialog box is _______.

4. _________ is the shortcut key to Center Align the selected text.

Activity 3

Practice the following tasks on your computer.
1. Create a new blank document and type the text “Welcome”. Change the size 

of text to “14” and apply the font “Verdana”. (Hint:		You	can	save	this	file	on	
the desktop.)

2. Type the text “King Saud University” and apply the font styles “Bold and 
Underline”, font color “Purple” and highlight the text in “Yellow” color. 

3. Copy the formatting styles of the text “King Saud University” to the text 
“Welcome”. 

4. Insert a random sample paragraph in the document by typing “=rand()” 
function and press the Enter key. Change alignment of the paragraph to 
“justify” and change the line spacing to “1.5”.
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In this Session, you will learn about the Styles and 
Editing groups of the Home tab and the Pages and 
Tables groups of the Insert Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The Home Tab
•	Styles Group
•	Editing Group 

•	The Insert Tab
•	Pages Group
•	Tables Group

Specific Objectives

THE HOME TAB & THE INSERT TABSession
9

OBJECTIVES
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THE HOME TAB

There	are	five	groups	in	the	Home	Tab.	In	the	previous	session,	you	learnt	about	
the Clipboard group, the Font group and the Paragraph group. In this session, 

you will learn about the remaining two groups of the Home tab i.e. the Styles group 
and the Editing group.

STYLES GROUP
The	Styles	group	commands	enable	you	to	apply	pre-defined	formatting	styles	to	
text. These styles provide an enhanced look to topics, subtopics, etc. Using the 
styles group, you can preview, manage and customize the text styles in Word 2016.

APPLYING STYLES
A	style	is	a	pre-defined	set	of	
formatting characteristics, 
such as font name, size, 
color, paragraph alignment, 
and spacing. Some styles 
even include borders and 
shading.

To apply a heading style to the text, follow the steps given below:
 Select the text. 
 Click on the Heading 1 style (or any other style) from the Styles gallery.

EDITING GROUP
The commands in the Editing group enables you to search, replace, or select text 
and objects in your document.

FIND
The Find command enables 
you to search and locate 
the text or phrase in the 
whole document. It lets 
you open a Navigation 
Pane to search through 
the document.
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To open the navigation pane, 
 Click the Find command in the Editing group.
 The Navigation pane appears in the left side of the screen. Here, you can 

type the word or phrase to search for in the whole document. 
 Below the search box, you will get the total number of words available in 

the document.

REPLACE
The Replace command enables you to replace the text or a phrase with another 
text or phrase in the document. Using this feature, you can search for the text 
that you would like to change, and replace it with the desired text.

To replace a word or phrase in your document, follow the steps given below:
 Click the Replace 

command in the 
Editing group.

 This displays 
the Replace tab 
of the Find and 
Replace dialog 
box.

 Enter	the	text	you	wish	to	find	in	the	Find what box. 
 Enter the desired text in the Replace with box.
 Click the Replace button.
 You may click the Replace All button to replace all occurrences of the 

searched text by the new text.

SELECT
The Select command in the Editing group is used to select 
text or objects in your document. This is particularly 
helpful for selecting text with certain formatting or 
objects that are behind text.
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Keyboard Shortcuts

Find text or phrase in the document                                              CTRL + F

Maximize or restore a selected window                                       CTRL + F10                                

Switch to the next window                              ALT + TAB

Replace                                                                                        CTRL + H

TIPS
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THE INSERT TAB

The Insert Tab has a lot of useful features that enable you to insert different items 
in your document. You can insert cover page, table, pictures, shapes, chart, 

hyperlink, drop cap, etc. in your document. 

The commands in the Insert Tab are divided into several groups. You will learn about 
some of these groups in the following section.

 Pages
 Tables
 Illustrations
 Links
 Header & Footer
 Text
 Symbols

PAGES GROUP
The commands in this group lets you insert a Cover Page, a Blank Page or a Page 
Break.

COVER PAGE
A	cover	page	is	the	first	page	of	article,	book,	or	any	
word	document.	Your	document	will	make	a	great	first	
impression with a stylish cover page. A good cover 
page draws the attention of the reader.

The Cover Page command is used to insert a cover 
page at the beginning of the document. On the cover 
page, you provide information like Subject, Title, Topic, 
Author name, etc. 

To insert a cover page, follow the steps given below:
 Click on the Cover Page command of the Pages 

group.
 Choose the desired cover page.
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BLANK PAGE
The Blank Page command is used to add a blank page 
anywhere in your document. This is useful when you need 
to insert a new page between two existing pages.
To insert a blank page at the current cursor position, 

     Click on the Blank Page command of the Pages group.

PAGE BREAK
The Page Break command is used to end the current page 
at the cursor position and move the cursor to the next 
page. This is useful when you want to write on the next 
page even though there is some blank space below the 
text at the current page. 

To insert a page break at the current cursor position, 
     Click on the Page Break command of the Pages group. 

 TABLES GROUP
The Tables group in the Insert tab contains only one command i.e. Table. It is 
used to insert a table in your document. A table contains data or information in the 
form of rows and columns. In a table, column is the vertical part and row is the 
horizontal part. An intersection of a column & a row is called a Cell. 

INSERTING TABLE
To insert a table in the document, follow the steps given below:

     Click on the Table command of the Tables group.
 Click on the Insert Table option from the list. This will open an insert table 

dialog box.
 In the Insert Table dialog box, enter the Table size with respect to number 

of columns and rows.
 Click OK to insert the table.

             You	can	also	insert	a	table	by	moving	the	mouse	over	the	squares	to				
select the number of rows and columns	as	required.
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Entering Table Data
To enter data into a table, simply click the cell where you want to enter the 
data. Press the Tab key to move to the next cell. Use the arrow keys to move 
between the cells. 

CONTEXTUAL TABS FOR TABLE (DESIGN AND LAYOUT)
When you click inside a table, two 
contextual tabs, namely, Design and 
Layout, appear under the heading Table 
Tools. These tabs provide commands 
for	quickly	formatting	your	table,	insert	
or delete rows and columns, and set the 
alignment for cells in your table.

RE-SIZING AND MOVING A TABLE
You	can	change	the	size	and	position	of	a	table	as	required.	Placing	the	mouse	
pointer at the bottom right corner displays a two headed arrow and placing it 
at the top left corner shows a four headed arrow.
To	 quickly	 re-size	 the	 table,	 follow	 the	
steps given below:

 Drag the resize handle at the 
bottom right corner of the table to 
an appropriate size.

 To change the width of a column 
or the height of a row, place the 
pointer on a boundary and drag when it appears as a two headed arrow. 

 To move your table, place the pointer at the four-headed arrow on the 
top left corner and drag with your mouse to a new location.

INSERTING ADDITIONAL ROWS OR COLUMNS
Word 2016 allows you to insert additional rows or columns in the table using 
the contextual Layout tab.

To insert additional rows or columns, 
follow the steps given below:

 Click in the table where you need 
additional rows or columns.

 Click on the contextual Layout Tab.
 In the Rows & Columns group, 

select one of the following:
 Insert Above to insert a row above the current row.
 Insert Below to insert a row below the current row.
 Insert Left to insert a column to the left. 
 Insert Right to insert a column to the right.
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MERGING CELLS
Combining two or more cells together into one cell is called merging cells.
 
To merge cells, follow the steps 
given below:

 Select the cells to merge.
 Click on the Merge cells 

command from Merge group 
of the Layout Tab.

SPLITTING CELLS
Word 2016 allows you to split a cell of a table into multiple new cells.

To split cells of a table, follow the steps given below:
 Select the cell that you want 

to split.
 Click the Split Cells command 

in the Merge group. 
 The Split cells dialog box 

appears.
 Enter the number of columns 

or rows into which you want 
to split the selected cells and click OK.

APPLYING TABLE STYLES
A	quick	way	to	format	a	table	automatically	is	to	use	the	Table	Style.	

To apply a Table Style, follow the steps given below:
 Select the Table and Click on Contextual Design Tab.
 In the Table Styles Group, click on the More arrow to display the complete 

gallery of styles.
 Move your mouse over the styles to preview how the table will look if you 

select that style.
 Click on a suitable style for your table.
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SHADING
The Shading command is used to highlight cells in the table. It changes the 
color behind the selected text, paragraph, or table cell. This is especially useful 
when you want the information to jump off the page.

To apply the shading, follow 
the steps given below:

 Select the cells where you 
want to apply the shading. 

 Click on the contextual 
Design tab.

 In the Table Styles group, 
click on the Shading com-
mand.

 Choose the desired color 
from the color palette to 
apply to the selected cells. 

BORDERS
A Border is the outlining of a table cell(s), row(s), or column(s). The Borders 
command in the contextual Design tab is used to add or remove borders to 
your selection.
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To apply the border to the se-
lected cells, follow the steps 
given below:

 Click on the contextual De-
sign tab.

 Click on the Borders com-
mand in the Borders group.

 Choose the desired border 
style from the drop down list.

CONVERTING TEXT TO A TABLE
You can create a table from the existing text. The Convert Text to Table 
command in the Tables group is used to convert the text separated by separator 
characters, such as commas or tabs into a table.

To convert the text to a table, follow the steps given below:
 Insert separator characters—such as commas or tabs—to indicate where 

to divide the text into table 
columns.

 Select all of the text you 
want to convert to a table.

 Click the Convert Text to 
Table option in the Table 
command.

 Choose the desired options 
in the Convert Text to Table 
dialog box and click the OK 
button.

 The selected text is con-
verted into a table.
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CONVERTING A TABLE TO TEXT
You can also convert the data contained in a table to regular text. The Convert 
to Text command in the contextual Layout tab lets you convert a table to 
regular text. You can choose the separator characters to separate the columns.

To convert a table into text, follow the steps given below:
 Click within the table 

and on the contex-
tual Layout tab, in 
the Data group, click 
Convert to Text.

 Click the option for 
the separator char-
acter that you want 
to use in place of the 
column boundaries.

 Click OK.
 The selected table is converted into text, separated by the separator 

characters.
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DELETING A TABLE
You can easily delete an 
entire table, or a part of it, 
in Word 2016. The Delete 
command in the Rows & 
Columns group of the 
Layout tab lets you delete 
rows, columns, cells, or 
the entire table.

To delete an entire table, 
follow the steps given 
below:

 Click within the table and on the contextual Lay-
out tab, from the Rows & Columns group, select Delete.

 A menu appears.
 Click the Delete Table option.
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You can also delete selected rows or columns from the Delete Button Options

TIP
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. The _______ feature enables you to change a particular text or phrase with 

other text or phrase in the document.

a. Swap

b. Replace

c. Find

d. Styles

2. If you want to give your document an impressive look, you can insert a 
_______ at the beginning of the document.

a. Blank Page

b. Page Break

c. Page Color

d. Cover Page

3. A _______ will move the contents after the cursor to the next page.

a. Blank Page

b. Table

c. Page Break

d. Page Color

4. The _______command is used to insert a new page in your document.

a. Blank Page

b. Empty Page

c. New Page

d. Page Color
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Table Merge Cells Borders Shading Style

1. A	______	is	a	predefined	set	of	formatting	characteristics.

2. A ______ allows you to organize your data in the form of rows and columns.

3. The _____ command allows you to combine two or more cells into one cell in 
a table.

4. The ______ command is used to add outlines to the selected table cells. 

Activity 3

Practice the following tasks on your computer.
1. Create a new blank document. Type the text “Class schedule”, apply the style 

Heading 1 to it and save the document on the desktop.

2. Prepare your weekly class schedule details in a table format and apply the 
table style “Grid Table 4”. 

3. Insert a new row at the top of the table with the title text “Weekly class 
schedule”.  (Hint: You can merge all the cells of the row.)

4. Replace every instance of the text “schedule” with the text “timetable” 
throughout the document. 
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THE INSERT TABSession
10

In this Session, you will learn about the Illustrations 
group, the Links group, and the Header & Footer group 
of the Insert Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The Insert Tab
•	Illustrations Group
•	Links Group 
•	Header & Footer Group

Specific Objectives

OBJECTIVES
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THE INSERT TAB

There	are	 ten	groups	 in	 the	 Insert	Tab.	 In	 the	previous	 session,	 the	first	 two	
groups i.e. the Pages group and the Tables group were discussed. In the current 

session, you will learn about the Illustrations group, the Links group, and the 
Header & Footer group.

ILLUSTRATIONS GROUP
The commands in this group enable you 
to insert various types of illustrations 
like Pictures, Shapes, Charts, and 
Screenshots.

INSERTING A PICTURE
The Pictures command lets you insert 
pictures from your computer or from other 
computers that you are connected to.

To insert a picture, follow the steps given 
below:

 Click in the document where you want 
to insert a picture.

 Click on the Pictures command 
of Illustrations group.

 The Insert Picture dialog box 
appears.

 Browse and select the desired 
picture and click on the Insert 
button in the dialog box. 

CONTEXTUAL TAB - FORMAT

When you insert a picture, or select an already inserted picture in a document, 
a new contextual Format tab appears. This tab contains various tools, such as 
brightness, color, corrections, picture styles and size of picture, etc. These tools 
help you to modify the appearance of your picture.
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APPLYING ARTISTIC EFFECTS
You can apply various artistic effects to an inserted picture. The Artistic Effects 
command add artistic effects to the picture to make it look more like a sketch 
or painting.

To apply the artistic effects, 
follow the steps given below:

 Select the picture. 
 On the contextual Format 

tab, in the Adjust group, 
click the Artistic Effects 
command.

 A gallery of different 
effects is displayed.

 Choose a suitable effect.

CROPPING A PICTURE
You can crop a picture to remove any unwanted parts. 

To crop the selected picture, follow the steps 
given below:

 On the contextual Format tab, in the 
Size group, click the Crop command.

 Eight cropping handles appear on the 
edges of the picture.

 Drag these handles inwards to remove 
unwanted parts of the picture.

WRAP TEXT
Wrap Text command makes it easy to 
arrange the text around an object, such as 
a picture or a shape, in different ways. For 
example, you can choose to have the text 
continue around the object or cross right 
over it. The default wrapping style is In Line 
with Text. This places the image in line with 
your text. 
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You may also crop a picture into a specific shape. For this, click the arrow below the Crop command and 

select Crop to Shape. Select a suitable shape from the displayed Shapes gallery.

TIP
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To wrap text around a picture, follow the steps given below:
 Click the image to select it. 
 On the contextual Format tab, in the Arrange group, 

click the Wrap Text command.
 Choose one of the following:
 Square: To wrap text around the border of your 

image. 
 Tight: To wrap text closely around an irregularly 

shaped picture. 
 Through: Text	can	fill	in	more	of	the	blank	space	around	the	image.
 Top and Bottom: To place the text above and below the image. 
 Behind Text: To display the text over the image.
 In Front of Text: To display the image over the text.

CHANGING PICTURE POSITION
The Position command helps 
you to choose where the selected 
picture appears on the page. 
While changing the position of the 
picture, the text automatically 
wraps around the picture.

To Change the picture position, 
follow the steps given below:

 Click the picture to select it.
 In the contextual Format 

tab, from the Arrange group, 
click the Position command.

 Move the mouse pointer 
over the displayed options 
to preview the picture position and click on the suitable one.

 
ONLINE PICTURES

The Online Pictures command 
helps	you	find	and	insert	pictures	
from a variety of online sources.

To insert an online picture, follow 
the steps given below:

 Click on the Online Pictures 
command in the Illustrations 
group. 

 The Insert Pictures dialog 
box appears. 

1

2

3

A

B

C

D

E

F

1

2

3

1

A

A

B
C

D
E

F

1

2

3

1
2

A



185

THE INSERT TAB
S

e
ssio

n
 1

0
 

 Type the keyword in the Bing 
Image Search box and press the 
Enter key.

 Select the picture(s) you want 
to insert and click on the Insert 
button. The picture is downloaded 
and inserted in the document.

INSERTING SHAPES
The Shapes command is used to insert ready-
made shapes into your document. Available 
shapes include Rectangles, Basic Shapes, 
Block	 Arrows,	 Equation	 Shapes,	 Flow	 chart,	
Stars and Banners, Callouts, etc.

To insert Shapes, follow the steps given below:
 Click the Shapes command in the 

Illustrations group to display the Shapes 
gallery.

 Select the Shape you want and drag the 
mouse to create a shape of the size you 
wish.

 A new contextual Format tab appears 
that contains various options to enhance 
the appearance of the shape.

ROTATING AND RESIZING SHAPES
Shapes can be adjusted after they are drawn. You can change the orientation 
of a shape using the rotation handle at the top. Place the mouse pointer on 
it and drag to the left or right to rotate your shape. 

To adjust the size of the shape, follow the steps given below:
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 Select the shape you want to 
resize.

 On the contextual Format 
tab, in the Size group, click 
the arrows or type new 
dimensions in the Height and 
Width boxes.

INSERTING A SMARTART
SmartArt graphics are visual representations of information that communicate 
your	 messages	 or	 ideas	 quickly	 and	 effectively.	 The	 SmartArt command 
enables you to insert a SmartArt graphic to visually communicate information. 
SmartArt graphics range from graphical lists and process diagrams to more 
complex graphics, such as Venn diagrams and organization charts.

To insert SmartArt, follow 
the steps given below:

 Click on the SmartArt 
command in the Illus-
trations group. 

 The SmartArt dialogue 
box appears.

 In the left pane, select 
the option you want.

 In the right pane, 
select	 the	 required	
SmartArt.

 Click the OK button.

Two new contextual tabs 
named Design and For-
mat are displayed. 

 The  Design tab helps 
you to change the lay-
out, style, or colors 
used in your SmartArt 
graphic.

 The Format tab helps 
you change the shapes 
in your SmartArt 
graphic, their style, and 
their colors. 
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INSERTING CHART
A chart is a visual representation of data and conveys information in an easy 
to understand and attractive manner. The chart makes it easy to spot patterns 
and trends in your data. Several types of charts like bar chart, column chart, 
pie chart, line chart etc. are available in Word 2016.

To insert a Chart, follow the 
steps given below:

 Click on the Chart com-
mand in the Illustrations 
group. 

 The Insert Chart dialogue 
box appears.

 In the Insert Chart dialog 
box, select the type of 
chart that you want.

 Click the OK button.
 The Excel 2016 sheet ap-

pears. 
 Edit the data in Excel 

2016.	After	you	finish	ed-
iting your data, close the 
Excel.

 The desired chart is in-
serted in the document.
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 LINKS GROUP
The Links group consists of commands that enable you to create bookmarks, links 
and cross references. These commands help you to jump to other places in the same 
document or to open another document or a website.

INSERTING BOOKMARK
Suppose you are working on a long 
document	and	need	to	move	to	specific	
locations in the document. For this, you 
can use the Bookmarks. It enables you 
to	quickly	jump	to	the	marked	locations	
within the document instead of scrolling 
through many pages of your document. 
To insert a Bookmark, follow the steps 
given below:

 Select the location where you 
would like to insert the bookmark.

 Click the Bookmark command from 
the Links group. 

 The Bookmark dialog appears.
 In the Bookmark name box, type a 

name for your bookmark. 
 Click the Add button. 
 To reach the bookmark location, 

open the Bookmark dialog box from 
the Insert Tab, select the name of 
the bookmark, and then click Go To.

DELETING A BOOKMARK
To delete the bookmark, follow the steps 
given below: 

 Click the Bookmark command from 
the Links group. 

 The Bookmark dialog appears.
 Select the bookmark that you wish to 

delete.
 Click on the Delete button. 
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The Bookmark name must start with a letter and cannot contain spaces.
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INSERTING HYPERLINK
Hyperlinking	is	a	process	to	create	a	link	in	your	document	for	quick	access	to	
webpages	and	files.	Hyperlinks	can	also	take	you	to	the	marked	places	in	your	
document, such as headings and bookmarks.

To insert a hyperlink, follow the steps given below:
 Select the text to which 

a link has to be created.
 Click the Hyperlink 

command from the 
Links group. The In-
sert Hyperlink dialog 
box appears.

 If the link has to be 
created for a web-
page, then click the 
first	 option	 (Existing	
file	 or	 webpage)	 in	
the Link to pane on 
the left. Type the URL of the web page in the Address text box.

 If the link has to be created for an existing	file,	then	click	the	first	option	
(Existing	file	or	webpage) in Link to	list	and	browse	the	file	in	right	panel.

 If the link has to be created for any place in the same document, then 
click the second option (Place in this document) in Link to list and browse 
the	bookmark	of	that	specific	place	in	right	panel.	

The color of hyperlinked text gets changed to blue with underlined. To open 
the link, place the mouse pointer over the hyperlinked text, keep the CTRL key 
pressed, and then click the mouse. 

REMOVING HYPERLINK
You can also remove the hyperlink from the text. 
To remove the hyperlink, 
follow the steps given below:

 Select the hyperlinked 
text.

 Click the Hyperlink 
command in the Links 
group.

 The Edit Hyperlink di-
alog box appears. 

 Click on the Remove 
Link button in the di-
alog box.
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Right-click on the Hyperlinked text and select Remove Hyperlink.
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HEADER & FOOTER GROUP
The commands in the Header and Footer group enable you to add contents at the top 
and bottom of all pages in the document. This group consists of: Header, Footer 
and Page Number.

ADDING HEADER OR FOOTER TO A DOCUMENT
The text, symbol, picture, page no., etc. 
that appears on top of every page of 
the document, is called a Header. For 
example, Name of the company, Topic of 
the document, etc. is the header for each 
page.

In the same way, the text, symbol, picture, 
page no., etc. that appears in the bottom 
of every page of a document is called a 
Footer.

To add the Header, follow the steps given 
below:

 Click on the Header command in the 
Header & Footer group. 

 A list of header styles is displayed.
 Choose the suitable header style.
 The header area becomes active . 
   A new contextual Design tab is 

displayed with various options for 
header and footer.

    Enter the text in the header area.
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To insert a Footer, click on the Footer command from the 
Header & Footer group in the similar way.

Close Header & Footer option
After adding a header or footer to the document, you can close the header and 
footer option from the contextual Design tab, by clicking on Close Header 
and Footer button.

INSERTING PAGE NUMBER
The Page Number command is used to insert the page number on every page 
of your document at a position of your choice.

To add the page number, follow the steps given below:
 Click on the Page 

Number command in 
the Header & Footer 
group. 

 A list of Page Number 
options appear. 

 Click on the desired 
option from the list.

 Click on a suitable 
style.

 The page number 
gets inserted.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. The contextual ________ contains various tools to modify the appearance of 

selected picture.

a. Design tab

b. Format tab

c. Layout tab

d. Tools tab

2. The ________ command allows you to insert an image from a variety of 
online sources.

a. Online Pictures

b. Store Pictures

c. Quick Pictures 

d. Picture Sources

3.	The________	command	is	used	to	move	directly	to	specific	word	or	location	
in a document.

a. Comment

b. Bookmark

c. Cross-references

d. Outlines

4. The Header is located at the _________ of the document.      

a. Left

b. Right

c. Bottom

d. Top
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

SmartArt Wrap Text Hyperlink Picture Styles Artistic Effect

1. You can apply _________ to make the picture look more like a sketch or 
painting.

2. The _________ command allows you to place text behind an image, in front 
of an image or around an image.

3. The _________ helps you to visually communicate information using graphics.

4. Adding	_______	to	text	or	image	can	provide	access	to	webpages	and	files	
directly from your document. 

Activity 3

Practice the following tasks on your computer.
1. Create a new blank document. Type the text “google search engine” and link 

the text to google website. 

2. Insert a picture from online pictures. Crop the picture and set the picture 
position to “Middle Center “. (Hint: You can search “car”.)

3. Create your daily routine cycle (Hint: You can use the “Text Cycle” SmartArt.)

4. Insert your name and section number in the Header, and page number at 
the bottom left of the document. (Hint: You can align name in the right, and 
section number in the left of header.)
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THE INSERT, DESIGN & THE LAYOUT TABSSession
11

In this Session, you will learn about the Text group and 
the Symbols group of the Insert Tab, Page Background 
group of the Design Tab, and Page Setup group of the 
Layout Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The Insert Tab
•	The Text Group And The Symbols Group

 
•	The Design Tab

•	Page Background Group

•	The Layout Tab
•	Page Setup Group

Specific Objectives

OBJECTIVES
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THE INSERT TAB

In the previous sessions, you have learnt about some groups in the Insert Tab. 
This tab has a lot of useful commands that enable you to insert tables, pictures, 

shapes, SmartArt graphics, charts, etc.  In the following section, you will learn about 
some more commands available in the Text and Symbols groups.

THE TEXT GROUP AND THE SYMBOLS GROUP
The Text group commands enable 
you to present text in different ways 
and insert embedded objects. The 
Symbols group commands enable 
you	to	insert	equations	and	symbols.

INSERTING TEXTBOX
A Text Box enables you to add text anywhere in your document. It is great for 
showcasing	important	text,	such	as	headings	or	quotes.	

To insert a Text Box, follow the steps given below: 
 Click on the Text Box command in the Text 

group. 
 A list of various text boxes appears.
 Choose	the	required	style	of	text	box.	
 The Text Box is inserted and you can edit 

the text.
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USING WORDART
The WordArt command is used to insert decorative text 
in the document. 

To insert WordArt, follow the steps given below:
 Click on the WordArt command in the Text group. 
 The WordArt gallery having various decorative texts 

appears.
 Choose	 the	 required	 WordArt	 from	

the gallery. 
 This inserts a text box in the document 

with the same decorative format. 
Here, you can write the desired text.

APPLYING DROP CAP EFFECT
You might have noticed a bigger letter in the beginning of a paragraph in 
Newspapers, Flyers, etc. This is done to create interest and is called a Drop Cap 
effect. The Drop Cap command is used to apply the effect.

To insert the Drop Cap effect to a paragraph, follow the steps given below: 
 Click anywhere in the paragraph.
 Click on the Drop 

Cap command from 
the Text group. 

 A list appears with 
various Drop Cap 
options.

 Select the desired 
Drop Cap option 
from the list.

 The selected Drop Cap effect is applied to the paragraph.

INSERT DATE & TIME
The Date & Time	command	is	used	to	quickly	add	the	current	date	or	time	to	
your document.

To insert the Date & Time, follow the steps given 
below:

     Click in the document where you want to 
insert Date & Time.

 Click on the Date & Time command in the 
Text group.

 The Date & Time dialog box appears.
 Choose the desired Date & Time format 

from the list and Click on OK button. 
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INSERTING SYMBOLS
There are several special symbols such as Mathematical operators, Currency, 
and other symbols that you may need to insert in a document. You can insert 
these symbols from the Symbol command in the Symbols group. You can also 
insert symbols that are not available on the keyboard such as ©, ®, ¥.

To insert a symbol, follow the steps given below: 
 Click in the document where you 

want to insert the symbol.
 Click on the Symbol command in 

the Symbols group.
 A list displaying several symbols 

appear.
 Click on the desired symbol to insert 

it into your document.

THE DESIGN TAB

The next tab after the Insert tab is the Design tab. This tab consists of commands 
that	enable	you	to	quickly	apply	different	formatting	styles	to	your	document.	

You can even set colors and insert pictures in the background of a document. 

PAGE BACKGROUND GROUP
The commands in this group enable you to add a Watermark, change the Page Color 
or add a Page Border. Watermark and Page Color apply to the entire document, while 
you can change Page Borders by section.

ADDING WATERMARK
The Watermark command enables you to add see-through text, such as 
“Confidential” or “Urgent” behind the content on the page. The faint watermark 
is	a	great	way	to	show	that	the	document	requires	special	treatment	without	
distracting from the content. 

To insert a Watermark, follow the steps given below: 
 Click on the Watermark command in the Page Background group. 
 A list appears containing many samples along with Custom Watermark 

option.
 Click the Custom Watermark option. 

1

2

A

3

1

A

2

There is an Update automatically checkbox in Date & Time Dialog box. This option automatically 

updates the date and time when you re-open the document.

TIP
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 A dialog box appears that helps to insert 
picture watermark or text watermark with 
several options.

 Select the Text Watermark and type the 
desired text in the box. 

 Click Apply followed by the OK button.

REMOVING WATERMARK
To remove watermark, follow the steps given 
below: 

 Click on the Watermark command in the Page 
Background group.

 Click on the Remove Watermark option in the 
drop-down list. 

APPLYING PAGE COLOR
The Page Color command adds a splash of color to your document by changing 
the background color of the page. You can select the desired color from the 
color palette and apply it to all the pages of your document. 
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To apply a page color, follow the steps given below:

 Click on the Page Color command in the Page Background group.
 A color palette containing various colors appears.
 Select the desired page color.
 The page color is changed. 
 The Page Color palette also has an option Fill Effects, which opens a 

dialog box having four tabs as Gradient, Texture, Pattern and Picture. 
Using these tabs, you can change the background of your document to 
the	selected	fill	effect.

PAGE BORDERS
A border draws focus and adds a 
stylish touch to your document. 
The Page Borders command 
applies borders to selected or all 
pages of the document.

To apply the Page Border, follow 
the steps given below: 

 Click on the Page Borders 
command in the Page 
Background group. 

 A dialog box containing op-
tions such as style, width, 
color, etc., appears. 

 Select the desired border 
style, width, color, etc.

 Click on OK button.
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THE LAYOUT TAB

The Layout tab allows you to customize the way your document’s page is set up. It 
helps you to change the document orientation, page size, margins, indentation, 

line spacing, and paragraph settings. It is better to adjust the Page settings before 
you start creating a document.

 PAGE SETUP GROUP
The Page Setup group contains the commands like margins, page size, orientation, 
line numbers, etc., that enable you to modify the structure of your document. 

MARGINS
Margins are the blank areas of space around the edge of your document. The 
Margins command is used to set the margin sizes for the entire document or 
to a section. There are four margins: left, right, top, and bottom. Gutter is 
a special margin used for binding purpose.

To set the page Margins, follow the steps given below: 
 Click on the Margins command in the Page Setup group. 
 A	list	appears	containing	pre-defined	margins	and	custom	margin	options.
 Click the Custom Margins to set the margins manually.
 A dialog box appears where you can set the margins.
 Change the values for each margin as desired.
 Click on OK button. 
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ORIENTATION
Orientation is the direction of a page in the document. The Orientation 
command is used to give your pages a Portrait or a Landscape layout. By 
default, Word 2016 provides Portrait orientation.

To set the Orientation of a page, follow the steps given 
below:

 Click on the Orientation command from the Page 
Setup group. 

 Select the desired orientation for your document. 

SIZE
The Size command is used to choose a paper size for 
your document. The paper sizes may be A4, A3, A5, 
Letter, Legal, etc.

To change the paper size, follow the steps given below: 
 Click on the Size command from the Page Setup 

group.
 A list appears displaying the available paper sizes.
 Choose the desired paper size.

COLUMNS
You can divide the text in your document into columns. You can also choose 
the width and spacing of the columns, or use one of the pre-set formats. The 
Columns command is used to split your text into two or more columns.

To split your text into columns, follow the steps given below: 
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 Select the text that 
you want to convert 
into columns.

 Click on the Columns 
command from the 
Page Setup group. 

 Choose the desired 
number of columns for 
your text.

LINE NUMBERS
Word 2016 automatically 
counts the lines in a docu-
ment and can display the 
appropriate number beside 
each line of text. Viewing the 
line numbers is sometimes 
very useful when you want 
to	refer	to	a	specific	line	in	a	
document. You can choose to 
display the line numbers in 
all or part of the document.

To insert the Line Numbers, follow the steps given below: 
 Click on the Line numbers command in the Page Setup group.
 Choose the desired option from the list.

HYPHENATION
The Hyphenation feature is 
used to split long words at 
the end of a line. A hyphen 
is a symbol like “-”, which 
is inserted when a word 
appears at the end of a line 
and	it	does	not	fit	in	the	end.	
Just like you see in books 
or magazines, hyphenating 
helps you to create more 
uniform spacing, and saves 
space in your document. The 
Hyphenation command in the Page Setup group inserts hyphens to eliminate 
gaps in justified	text	or	to	maintain	even	line	lengths	in	narrow	columns.	
To enable the hyphenation feature, follow the steps given below: 

 Select the paragraph.
 Click on the Hyphenation command in the Page Setup group.
 Choose the desired option from the list.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. The________ command enables you to add a block of text with different 

styles anywhere in your document.      

a. Drop Cap

b. Symbol

c. Workbox

d. Textbox

2. A_________is a large capital letter at the beginning of a paragraph that has 
the size of two or more lines of regular text.      

a. Increase Font Size

b. Word Art

c. Drop Cap

d. Superscript

3.  ________ is a see-through text or picture that appears behind the contents 
in your document.     

a. Word Art

b. Drop Cap

c. Textbox

d. Watermark

4.  ________ is a special margin used to add extra space for book binding.        

a. Header and Footer

b. Gutter

c. Orientation

d. Custom margin
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Symbol Page Color WordArt Hyphenation Drop Cap

1. The ________command is used to add decorative text in the document.

2. The ________ command enables you to insert signs or special characters in 
your document.

3. The	________command	is	used	to	add	color	or	fill	effect	to	the	background	of	
your document.

4. The ________ command is used to split long words at the end of a line to 
eliminate	gaps	in	the	justified	text.

Activity 3

Practice the following tasks on your computer.
1. Create a blank document. Insert the “Facet Quote” textbox and type the text 

“King Saud University”. 

2. Insert random sample text in the document by using “=rand()” function. 
Change the orientation of the document to “Landscape” and apply a page 
border with 6pt width.

3. Set the Top and Bottom margins to 2 inches, Left margin to 1.5 inches, and 
Right margin to 1 inch.

4. Add the Watermark with the text “King Saud University” and set the Page 
color to the texture effect “Denim” in the document. 
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THE REFERENCES TAB & THE REVIEW TAB Session
12

In this Session, you will learn about the Table of Contents 
and Footnotes groups of References Tab and Proofing 
and Comments groups of Review Tab.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The References Tab
•	Table of Contents Group
•	Footnotes Group 

•	The Review Tab
•	Proofing	Group
•	Comments Group

Specific Objectives

OBJECTIVES
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THE REFERENCES TAB

The References Tab commands help researchers & professionals in creating 
references in the document. In this section, you will learn about the following 

groups of the References tab.

 Table of Contents Group
 Footnotes Group

TABLE OF CONTENTS GROUP
This group enables you to create table of contents in your documents. It has 
commands such as Table of Contents, Add Text, Update Table.

INSERTING TABLE OF CONTENTS
A Table of Contents displays the topics of the entire document in a list format and 
facilitates easy location of topics. This provides a structured and a hierarchical 
view of contents.

To Insert a Table of Contents, follow the steps given below: 
 Select the Titles in the document and apply the appropriate Heading 

Styles from Styles group of Home tab.
 Place the cursor in the document where you want to insert the Table of 

Contents and Click on the Table of Contents command.
 Choose the Automatic Table1 from the drop down list.
 A Table	of	Contents	for	the	whole	document	is	inserted	in	the	specified	

page.
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UPDATING TABLE OF CONTENTS
While working on a document, the number of pages and its contents keep 
on changing and accordingly you need to update your Table of Contents. The 
Update Table command, available in the Table of Contents group, helps you 
to update the table if there are any changes in the titles or page numbers.

To Update the Table of Contents, follow the steps given below:           
 Click on the Update Table command from the Table of Contents group.
 Select the Update entire table option from the dialog box.
 Click OK button
 The Table of Contents is updated. 
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DELETING TABLE OF CONTENTS
A Table of Contents can be deleted from the document, when you don’t need 
it or want to create a manual table of contents instead of an automatic table.

To Remove Table of Contents, follow the steps given below: 
 Click on the arrow of Table of Contents command.
 Choose the Remove Table of Contents option from the drop down list.

FOOTNOTES GROUP
The Footnotes group helps you to insert additional notes about words/phrases either 
at the end of each page or at the end of the document. 

INSERTING AND DELETING FOOTNOTES
Footnote is a way of citing source of references 
within the text in a document and it appears at 
the bottom of a page. It helps to present the 
information in context with its sources, allowing the 
reader to judge the precision of the information.

To Insert a Footnote, follow the steps given 
below: 

  Select the Text on which you want to insert 
the footnote.

  Click the Insert Footnote command from 
the Footnotes group. 

  A superscripted number appears on the 
text, and you’re instantly taken to the 
bottom of the page.
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  Write the appropriate notes 
in the reference mark at the 
bottom of the page.

To delete a Footnote, 
 Select the superscripted ref-

erence number on the text 
and press the DELETE key 
from the keyboard. 

THE REVIEW TAB

The	 Review	 tab	 has	 some	 significant	 commands	 to	make	 your	 document	 free	
of	errors.	 For	 instance,	you	can	use	 it	 for	proofing	your	document,	adding	or	

removing comments, etc. 

This tab helps you to check Spelling & Grammar mistakes, Count Words, Translate, 
and change Language in documents. 

PROOFING GROUP
The Proofing group allows you to make your document look perfect and professional. 
It has commands such as, Spelling & Grammar, Thesaurus, Word Count.

SPELLING AND GRAMMAR
The Spelling & Grammar command is used to check and remove spelling 
and	grammar	errors	from	a	document.	Word	2016	flags	spelling	and	grammar	
errors as below:

 Blue Wavy Underline: This	is	flagged	to	show	grammar	errors,	formatting	
inconsistencies or contextual errors. 

 Red Wavy Underline:	This	is	flagged	to	show	the	spelling	errors.

To check the Spelling & Grammar of your document, follow the steps given below: 
 Click on the Spelling & Grammar command from the Proofing group.
 Word	2016	selects	the	first	error	in	the	document.
 The Spelling Pane appears on the right side of the document. 
 Select the suitable word from the suggestion list.
 Click on the Change button to replace the text with the selected text from 

the suggestion list. 
 Use the Change All button to replace all the occurrences in the whole 

document. 
 Click on the Ignore button to keep the word as it is in the document. 
 Use the Ignore All button to keep it, as it is in the whole document if any. 
 Click on the Add button to add the selected word to the default dictionary, 

so	that	Word	2016	stops	flagging	it	as	misspelt.
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Repeat the above steps to correct the spelling or grammar errors in the entire 
document. 
Word	displays	a	dialog	box	when	it	finishes	checking	for	spelling	and	grammar	
mistakes,	finally	click	the	OK button.
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Right-Click over a flagged spelling or grammar error to view the list of suggestions to fix the spelling 

or grammar mistakes.

TIP

COMMENTS GROUP
The commands in this group enable you to insert, delete and view comments. Word 
2016 displays the comments in the Reviewing pane or in a balloon at the right 
margin of the document. 

INSERTING COMMENTS
A comment is an additional note or an annotation for some text or phrase in 
the document that can be added by an author or a reviewer.

To insert a Comment, follow the steps given below: 
 Select the text on which you want to insert a Comment.
 Click on the New Comment command from the Comments group.
 Write the comment in the balloon that appears on the right side of the 
     document.
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DELETING COMMENTS
The Delete comments command is used to delete the comments that are no 
longer	required	in	the	document.

To delete a comment, follow the steps given below:
 

 Select the comment that you want to delete.
 Click on the Delete command from the Comments group.

12

COMMENT NAVIGATION
You can use the Previous and Next commands available in the Comments 
group to navigate through the comments in the whole document.
 
To navigate through the comments, follow the steps given below:

 Click on the Previous com-
mand to jump to the previ-
ous comment.

 Click on the Next command 
to jump to the next Com-
ment.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. You can create a ________to display the headings of the document in a list 

format.     

a. Table of Contents

b. Footnotes

c. New comment

d. Smart Lookup

2. _______ provide references or additional information for a particular text at 
the bottom of the page.     

a. Comments

b. Footnotes

c. Table of Contents

d. Cover Page

3.  The _______command is used to check and remove errors from the document.    

a. Cross-reference

b. Spelling & Grammar

c. Check & Review

d. None of the above

4.  _______ appears as a balloon on the right side of the document.  

a. Comment

b. Footnote

c. Table of Contents

d. Spelling & Grammar
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Proofing Footnote Red Wavy Heading Styles Comments

1. You need appropriate _______ to insert a Table of Contents.

2. The Spelling & Grammar command is located in the _______ group of the 
Review tab. 

3. A________ is marked as a superscripted number to the referenced text.

4. To represent spelling error, a _______ line appears under the word.     

Activity 3

Practice the following tasks on your computer.
1. Create a blank document. Insert random paragraphs by using “=rand()” 

function. Enter the text “Sampule cantant” before the second paragraph and 
apply Heading 1 style.

2. Add the footnote “Spelling mistake” to the text “Sampule cantant”. 

3. Check and correct the spelling and grammar mistakes in the document.

4. Remove the footnote from the document. 
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THE VIEW TAB & OTHER FEATURES OF 
WORD 2016

Session
13

In this Session, you will learn about the View Tab and 
Other Features of Word 2016.

General Objectives

At the end of this Session, you should be able to understand 
and Practice:

•	The View Tab
•	Views Group
•	Show Group 

•	Other Features of Word 2016
•	Using PDF Format
•	Creating a Template

Specific Objectives

OBJECTIVES
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LEARNING

THE VIEW TAB

The View tab contain commands that help you to change the view of your document, 
adjust zoom level, show or hide user interface elements, and to arrange or work 

with multiple document windows. It has the following groups:

 Views Group
 Show Group
 Zoom Group
 Window Group
 Macros Group

VIEWS GROUP
The commands in the Views group allow you to view your 
document	in	different	ways.	Word	2016	provides	five	views	
for your document: Read Mode, Print Layout, Web 
Layout, Outline, and Draft.

Each view is optimized for a particular task and content 
type.	You	can	quickly	switch	from	one	view	to	another.	

READ MODE
If you want to read or review a document instead of writing, the Read Mode 
view is best suitable. 

To switch to the Read Mode view,
 Click on the Read Mode command in the Views 

group. 
 This view shows the document in a book style 

using columns, hiding the Ribbon and other 
screen elements. A Next and a Previous arrow 
button appears on both sides to move between 
pages. It also provides some tools specially 
designed to read a document.

A

B

C

D

E

1

A

A B C D E

1



219

THE VIEW TAB & OTHER FEATURES OF WORD 2016
S

e
ssio

n
 1

3
 

To exit from the Read Mode view, choose Edit Document from the View menu 
or just hit the Esc key on the keyboard. 

PRINT LAYOUT
The Print Layout view is the default view when you create a new document. 
This view is often used to work with standard documents, such as letters, 
brochures, reports, etc.

To switch to the Print Layout view,

 Click on the Print Layout command in the Views 
group. 

 This View displays the document as it will appear 
on the printed pages. It follows the WYSIWYG 
(What You See Is What You Get) approach. This 
means the display of margins, headers and footers, 
breaking of paragraphs on pages, etc. matches to 
the printed output. 

1

A

1

A

A
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WEB LAYOUT
You can use the Web Layout view to create and edit pages that you intend to 
publish online. It simply provides an approximation of how content will appear 
when published online.

This layout is also great if you have wide tables in 
your document.

To switch to the Web Layout view,
 Click on the Web Layout command in the Views 

group. 
 The Web Layout view displays the document as 

a webpage. 

OUTLINE
The Outline view allows you to create an outline of a document and shows the 
content as a bulleted list.

In the Outline view, a contextual tab Outlining appears with various outline 
tools. By using the Outline tools, you can move your text up and down, expand 
and collapse levels, change heading levels, or show only one kind of heading 
level.

To switch to the Outline view, 
 Click on the Outline command in the Views group. 
 It shows the document as collapsible levels of 

headings, providing a glance of the structure of 
the document.

1
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To exit from Ouline view, click on Close Outline View command from Close 
group in Outlining tab.

DRAFT  
The	Draft	view	is	designed	to	edit	and	format	text	quickly.	This	view	is	useful	
when you have to focus on the content, rather than the printed output.

To switch to the Draft view, 
 Click on the Draft command in the Views group. 
 The Draft view enables you to type and edit 

quickly	by	simplifying	the	layout	of	the	page.

Some page elements such as, the boundaries between 
pages, headers and footers, backgrounds, etc. do not 
appear in the Draft view.

1

A

1

A

A
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SHOW GROUP
The Show group on the View tab allows you to turn On/
Off features like Ruler, Gridlines and the Navigation Pane. 
Importance of some of these options are discussed in the 
following section.

SHOW/HIDE RULERS
The Rulers help you to align text, graphics, tables, and other elements in your 
document, horizontally or vertically.

To Show or Hide  the Rulers,
     Click on the check box of Rulers in the Show group.
 The Horizontal Ruler appears at the top of the document workspace. The 

horizontal ruler is visible in most document views.
 The Vertical Ruler appears along the left edge.

SHOW/HIDE GRIDLINES
The Gridlines give visual indications when you are formatting your document. 
It helps you to properly align shapes and other objects in your document. 
Gridlines are for visual reference only and cannot be printed.

To show the Gridlines, 
 Click on the check box of Gridlines in the Show group.

To hide the Gridlines, simply uncheck the Gridlines box.
 

1
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OTHER FEATURES OF WORD 2016

Apart from the editing and formatting features, Word 2016 enables you to convert or 
save	your	documents	in	different	file	formats.	The	following	section	demonstrates	

how	to	convert	a	Word	2016	document	as	a	PDF	file	or	a	Word	Template.

USING PDF FORMAT
Portable	Document	Format	(PDF)	is	a	platform-independent	file	format.	It	enables	
easy	sharing	and	printing	of	documents.	PDF	 is	a	widely	accepted	file	 format	by	
many agencies and organizations.
You	can	use	PDF	format	when	you	want	a	file	that:

•	Looks	the	same	on	most	computers.
•	Has	a	smaller	file	size.
•	Complies	with	an	industry	format.

CONVERTING A DOCUMENT TO A PDF
Word 2016 provides direct conversion of a document into a .pdf	file.
To	convert	an	already	opened	Word	2016	document	to	a	PDF	file,	follow	the	
steps given below: 

 Click on the Export option in the File tab Backstage view.
 Click on the Create PDF/XPS button.
 The Publish as PDF or XPS dialog box appears.
 Enter	the	name	for	the	PDF	file	in	the	File name box.
 Click on Publish button.

1

2

A

3

4

1



224

Module Three : Word Processing (MS Word 2016)

CREATING A TEMPLATE  
A Template is a specialized pre-formatted document, which can be used to create a 
similar	type	of	document.		It	allows	quick	creation	of	standard	documents	and	saves	
time.

If	you	frequently	work	with	a	certain	type	of	documents,	such	as	a	monthly	report,	
a sales forecast, or a document with a company logo, you can save it as a Template.

3

4

A

2

1
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SAVING A DOCUMENT AS TEMPLATE
By using the Templates feature of Word 2016, you can focus on the contents 
of the document and leave the formatting to the Template. A Template in Word 
2016	is	identified	with	the	file	extension	.dotx.

To Create a Template from your open document, follow the steps given below:
 Click on the Save As option in the File tab Backstage view.
 Click on the Browse option.
 The Save As dialogue box appears.
 Click on the Save as type drop down list.
 Choose the Word Template option. 
 Enter the name for the Template in the File name box.
 Click on the Save button.

To start a new document based on your template,
 Click New option in the File tab Backstage view.
 Click on the Personal category.
 Click your Template.

1

2
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. _______ is the default view of a new word document.  

a. Read Mode

b. Web Layout

c. Print Layout

d.  Outline Mode

2.	 The	_______	are	beneficial	to	properly	align	an	object	in	the	document.		

a. Underlines

b. Gridlines

c. Tables

d. Templates

3. To show headers and footers, you must switch to _______ view.      

a. Read Mode

b. Print Layout 

c. Web Layout

d. Draft Mode

4.		_______	is	the	file	extension	for	a	Template	in	Word	2016		

a. .dotx

b. .docx

c. .decx

d. .txt
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Print Layout PDF Read Mode Web Layout Template

1. _______ view displays the document as it will appear on the printed pages.

2. In _______ view, the Ribbon is hidden to maximize your reading area.

3. _______	is	a	platform-independent	and	widely	accepted	file	format.

4. A _______is a pre-formatted document used to create documents with similar 
style.      

Activity 3

Practice the following tasks on your computer.
1. Create a blank document. Insert random paragraphs by using “=rand()” 

function. Change the view of the document to Read Mode. 

2. Change the View of the document to Print Layout and hide the Ruler. 

3. Display the Gridlines in the document. 

4.	Save	the	document	with	the	file	name	“Practice”	and	file	type	as	“PDF”.	
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OVERVIEW OF SPREADSHEETS, GETTING 
STARTED WITH EXCEL 2016 & THE HOME TAB

Session
14

In this Session you will understand Overview of Spread-
sheets, Getting Started with Excel 2016 and The Home 
 Tab.

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	Overview of Spreadsheets
•	Spreadsheet Programs

•	Getting Started with Excel 2016
•	Starting Excel 2016

•	User Interface of Excel 2016

•	New Features of Excel 2016

•	Create a simple Workbook

•	Managing Worksheets

•	The Home Tab
•	Font Group

Specific Objectives

OBJECTIVES
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OVERVIEW OF SPREADSHEETS

In the previous module, you learnt to create well-designed documents using Word 
2016 Application. You will now learn about Spreadsheet Application, which helps 

you to arrange and analyze large amount of data. Large and small companies use 
it for budgeting and other purposes. This module guides you through the basic 
knowledge and skills of Microsoft Excel 2016, which is the most widely used 
Spreadsheet Application.

SPREADSHEET PROGRAMS

A Spreadsheet is an application program used to organize and store data in a tabular form. 
It consists of rows and columns; used to manipulate data and perform calculations 
using mathematical formulas and functions. The Spreadsheet program is used 
to	generate	sales	figures,	sales	taxes,	commissions, corporate budgeting, etc. 

FEATuRES OF SPREADSHEET PROGRAMS
Spreadsheet programs are primarily used to organize and analyze information. 
They are popular because of their useful features, such as:

•	 Fast and effective data comparisons

•	 Automated calculations and AutoFill

•	 Functions and Formulas

•	 Charts

•	 Sort and Filter

POPuLAR SPREADSHEET PROGRAMS
A number of spreadsheet programs are out there with lots of capabilities and 
functionalities.  Given below are some of the popular spreadsheet programs.

•	 Microsoft Excel

•	 Apple iWork Numbers

•	 Corel Quattro Pro

LEARNING
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GETTING STARTED WITH EXCEL 2016

Excel	2016	 is	a	 component	of	 the	Microsoft	Office	2016	suite	and	 is	available	
for both Windows and Macintosh operating systems. Excel 2016 gives you a 

handy place to work with both textual and numerical data. You can create formulas, 
summarize information, show information in charts and do a lot more. The common 
scenarios to use Excel 2016 is for creating Schedules, Inventory, Reports, Bud-
geting, Accounting, Planning and much more.

STARTING EXCEL 2016
Excel 2016 is widely used spreadsheet program. To create workbooks, you need 
to open the Excel 2016 application.

To start Excel 2016 in Windows 10, 
follow the steps given below:

1  Click on the Start Button to 
open Start menu.

2  Locate and click on the Excel 
2016 from All Apps list.

The Start Screen of Excel 2016 
appears with	a	list	of	recently	used	files	
and available templates. You can either 
open	an	existing	file,	choose	a	template,	
or start with a new blank workbook. You 
can also press the Esc key to start with 
a new blank workbook.

uSER INTERFACE OF EXCEL 2016
It is better to understand the user interface of Excel 2016 before you work with 
it. Excel’s user interface is organized in tabs containing groups and commands. 
These commands enable you to work with the data contained in cells, rows, 
columns and worksheets. Different user interface elements of Excel 2016 are 
briefly	mentioned	below:

A  Ribbon: Ribbon consists of a set of commands placed under different 
tabs. Each tab is divided into groups, having logically related commands. 

B  Tell Me Box: This box, located to the right of the ribbon tabs, allows quick 
access to Excel commands and features you want to use. 

C  Ribbon Display Options: You can show or hide a ribbon to maximize or 
minimize your workspace. You can choose from the options: Auto-hide 
the ribbon, Show Tabs only or Show Tabs and Commands.

D  Worksheet: A Worksheet Sheet consists of cells organized into rows 
and columns. Worksheets are used to store and manage information in 
tabular form.

2

1
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E  Cell and Active cell: The intersection of a row and a column in a worksheet 
is called a Cell. An Active cell is the currently selected cell; which is 
recognized by its green outline. 

F  Columns: Columns are the vertical divisions of a worksheet. The column 
headings are sequential letters at the top of each column to identify it 
e.g. A, B, C, and so on.

G  Rows: Rows are the horizontal divisions of a worksheet. A row number 
identifies	a	specific	worksheet	row	and	appears	along	the	left	side	of	the	
worksheet e.g. 1, 2, 3, and so on.

H  Name Box: To	the	left	of	the	formula	bar	is	the	Name	box,	which	identifies	
the selected cell, chart or other objects on the worksheet. Each cell has 
cell address	identified	by	column	letter	and	the	row	number	(E.g.	A1).	

I  Formula Bar: It displays the contents of the active cell and is mainly used 
to enter a formula to calculate cell data.

J  Sheet Tab: The sheet tabs, at the bottom of the worksheet, displays the 
name of the sheets. Each sheet tab represents a separate worksheet in 
the workbook. Sheet tabs help you to manage different worksheets in a 
workbook.

K  Status Bar: The horizontal bar at the bottom of the worksheet, below 
the sheet tabs, is the status bar. The status bar shows quick summaries 
of selected cells (count, sum, average, minimum or maximum values). 
You can change its status by right clicking on it and choosing which 
summaries to show. By default, status bar contains View Buttons, 
Zoom Slider and Zoom Button.

C

A

B

D
E
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G

H

I

J
K
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NEW FEATuRES OF EXCEL 2016
Microsoft has added some new exciting features and enhancements in Excel 2016 
such as Tell Me box, Smart Lookup, New Chart types, Quick Analysis tool, 
etc. Tell me box and Smart Lookup features work similar as discussed in module 
3. One of the new features of Excel 2016 is Quick Analysis Tool,	which	is	briefly	
mentioned below.
       

QuICK ANALySIS TOOL 

Quick Analysis Tool is the real time-saver, which helps you to instantly 
create charts, apply conditional formatting, table styles and quickly calculate 
data.
 
To use the Quick Analysis 
feature, follow the steps given 
below:

1  Select the range of cells 
containing data you want 
to analyze.

2  Click the Quick Analysis 
Button that appears to 
the bottom right of your 
selected data (or press 
CRTL + Q).

A  It opens Quick Analysis 
gallery.

3  In the Quick Analysis 
gallery, select a tab For  
example, choose Form-  
atting Tab to highlight 
data with colors. 

4  Select an option, or just 
point to each one to see a 
preview.

B  The selected data is highl-  
ighted with colors.

The options in the Quick 
Analysis Gallery change based 
on the type of data you have selected in your workbook.

CREATE A SIMPLE WORKBOOK
A workbook	is	simply	an	Excel	file	that	contains	one	or	more	worksheets.	You	
can create a workbook from a template or start with a blank workbook. Tem-
plates are predesigned workbooks that help you to create new workbooks with 
special formatting already available.

1
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CREATING A NEW WORKBOOK

To create a new workbook, click on File Tab and follow the steps given below:

1  Click on New option from 
Backstage view.

2  Click on Blank workbook to 
create a new workbook.

A  Choose a template if you 
want to use a template.

ENTERING DATA INTO CELLS

You can enter data into any cell of the Worksheet. The data you enter in a cell 
can be text, numbers, dates and formulas.
•	 To enter data in a cell, select the cell and type the data you want to enter. 
•	 Press	ENTER KEy or TAB KEy.
•	 The	data	appears	in	the	cell	and	also	in	the	Formula	Bar.

EDITING CELL DATA

After entering data, you may like to make some changes. 
• To edit the contents of a cell, double click on it and make the required changes.
•	 To	delete	the	contents	of	cells	entirely,	select	them	and	press	the	Delete key. 
•	 To	overwrite	the	contents	of	a	cell,	Select	it	and	type	new	contents.

ADJuSTING COLuMN WIDTH

Sometimes all the data in a cell is not visible. You need to adjust the column 
width to display the entire cell contents.

To adjust the column width, follow the step given below:
1  Place the Mouse Pointer over 

the boundary between 
column headers and drag 
the column boundary to its 
right.

You can also double click on the 
boundary between column headers to 
automatically	resize	the	column	to	fit	
the cell contents.

1

2

A

1

Excel workbook is saved with the extension 
“.xlsx”. Excel template is saved with the extension 
“.xltx”.
You can browse for online templates in the Search 
for online templates box .

TIPS
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SELECTING MuLTIPLE CELLS

In a worksheet, you may frequently need to select multiple cells to edit data, 
apply some formatting options, perform mathematical operations, etc. 

To select sequential cells, follow the steps given below:

1  Click on a cell and drag the 
mouse over a group of cells  
you want to select.

A  Excel highlights the selected 
cells in gray color.

 B  Use the Select All Button if 
you want to select all the cells 
in the worksheet.

uSING NAME BOX

You can also use the Name Box 
to	quickly	locate	and	select	specific	
cells or range of cells in a worksheet.

To select sequential cells using 
Name Box,

1  Enter the cell addresses of the 
first	and	last	cells	separated	
by a colon (:) 
in the Name Box and press 
Enter key e.g. A2:F6. 

A  Excel highlights the selected 
cells in gray color.

      To select non- sequential 
cells using name box,

2  Enter the cell addresses 
separated by commas in the 
Name Box and press Enter 
key e.g. C3, D5, E8, F4. 

B  Excel highlights the selected 
cells in gray color.

A

B
1

1

A

2

B

To select non-sequential cells, select the cell(s), hold down the CTRL key, and select additional cell(s). 

TIP

To select cells sequentially, click on any cell, hold down 

the “Shift” key, and click on the last cell you want to 

select. 

TIP
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NAVIGATING A WORKSHEET

Since Excel worksheet contains data in cells, you need to move between cells 
or to different locations in the worksheet. There are different ways to navigate 
your worksheet. 

Keyboard Navigation
You can use keyboard shortcuts for navigation, primarily to save the time while 
working with worksheets. Following are the keyboard shortcuts to navigate 
through a worksheet.
•	 Use the four Arrow keys (←, ↑, →, ↓) to move one cell left, right, up or 

down directions.
•	 Use TAB Key to move the active cell one column to the right in the worksheet.
•	 Use CTRL + Home to move the active cell to cell A1 in the worksheet. 
•	 Use CTRL + End to move the active cell to the last cell in the worksheet 

that contains data. 
•	 Use CTRL + Down Arrow key to move the active cell to the last row in 

excel sheet that contains data.
•	 Use CTRL + Right Arrow key to move the active cell to the last column in 

excel sheet that contains data.

Navigation using Scroll Bars
Similar to Word 2016, you can use scroll bars for easy navigation in Excel 
worksheets. You can quickly move to any part of the worksheet using Horizontal 
or Vertical Scroll Bars.

MANAGING WORKSHEETS
Excel 2016 allows you to work with multiple worksheets in a workbook. You need to 
manage multiple worksheets as each worksheet can contain a different set of data. 
For example, one worksheet can contain sales data, a second can contain inventory 
and third can contain your expenses. The following topics guide you to manage and 
classify multiple worksheets.

INSERTING A WORKSHEET

In Excel 2016, a workbook contains only one worksheet by default. You can 
insert more worksheets to your workbook. 

To insert an additional worksheet, follow the steps given below:
1  Right click on sheet tab.
2  Click Insert option from the popup menu. 

To resize name box, point to the right edge of the name box and drag the border to the right.

TIP
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A  It will open Insert dialog  
box. 

3  Click on Worksheet option. 
4  Click on OK button to 

insert worksheet. 
B  You can also click on New 

Sheet button to insert a 
new worksheet.

DELETING A WORKSHEET

You can delete a worksheet that you no longer need in your workbook.
A worksheet can only be deleted if the workbook contains more than one 
worksheet. 

To delete a worksheet, follow the steps given below:
1  Right click on the sheet

     tab you want to delete. 
2  Click Delete option from 

the popup menu.
A  Excel prompts you with a box 
to	confirm	the	deletion	if	the	
excel sheet contains data.

3  Click on Delete button to 
delete the worksheet.

 

RENAMING A WORKSHEET

Excel 2016 assigns a default name to each 
worksheet in a workbook like Sheet1, Sheet2. 
You	can	give	specific	names	to	worksheets	to	
help you identify their content. 
To rename a worksheet, follow the steps 
given below:

1  Right click on the sheet tab you want to 
rename.

2  Click Rename option from the popup 
menu and type a new name for the 
worksheet.

B

A

2

1

3

4

Press Shift+F11 to insert a new Worksheet.

TIP
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1
3

Double click on the worksheet tab to rename it.

TIP
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MOVE OR COPy A WORKSHEET 

Moving a worksheet within the same workbook or to a different workbook is 
helpful to keep worksheets in order. Copying a worksheet helps you to use the 
same worksheet in the same or different workbook. 

To Move or copy a worksheet, follow the steps given below:
1   Right click on the sheet tab you want to Move or Copy.
2  Select Move or Copy option 

from popup menu. It opens 
Move or Copy dialog box.

A  You can move selected sheet to 
another workbook.

B  You can move selected sheet in 
the same workbook.

3  Select Create copy checkbox to 
copy the worksheet.

4  Click on OK button.
C  Worksheet is copied.

CHANGING TAB COLOR

A tab color applied to worksheet tabs, help you to identify different worksheets 
in a workbook.

To apply a tab color, follow the steps 
given below:

1  Right click on the sheet tab and 
point to Tab Color option from 
popup menu.

2  Choose a color from the 
displayed color palette.

A  The tab color of the worksheet 
changes instantly.

A

1

2

A

B

C

2

1

3 4

You can also Insert, Delete, Rename, Move or copy sheet and change Tab color from cells group of the Home Tab.

TIP
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OTHER SHEET OPTIONS

While working with a workbook, you may need to select 
all worksheets or secure your worksheet from other 
users. 

When you right click on a sheet tab, it also displays the 
following options:

A  Select All Sheets: Selects all worksheets so that a 
formatting option can be applied at once, like Tab color.

B  Hide: Makes a worksheet invisible from sheet tabs. 
C  Protect Sheet: Allows you to prevent unwanted 

changes from users by limiting their ability to edit 
the worksheet.

THE HOME TAB 

The Home Tab provides a collection of commonly used commands for easy access. 
Following are different groups in the home tab.

A  Clipboard: This group contains main editing commands such as cut, copy 
and paste. 

B  Font: This group contains commands used to apply range of formatting options.

C  Alignment: This group contains commands used to position cell data and 
merge cells.

D  Number: This group contains commands used to apply different number 
formats to data.

E  Styles: This group contains commands used to apply various styles.

F  Cells: This group contains commands used to add, delete and format 
cells, rows, columns and worksheets.

G  Editing:	This	group	contains	commands	used	to	sort,	filter	and	calculate	data.

C

B

A

A B C D E F G
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THE FONT GROuP

The basic formatting commands of Word 
2016 are also available in Excel 2016. 
The commands of the Font group enable 
you to modify and enhance the appearance 
of your data.

APPLyING FONT AND FONT SIZE 

Font is a particular size, weight and style of a typeface. It is a graphic design 
applied to numerals, symbols, and text in a worksheet. The proper choice of 
font size makes your data easily readable. 

To apply Font to the selected cells:
1  Click on Font Box in Font 

Group and choose a 
suitable font. 

     To apply Font Size to the 
selected cells:

2  Click on Font Size Box in 
Font Group and choose a 
suitable font size.

To increase or decrease font size 
for the selected cells: 

3  Click on Increase Font 
Size or Decrease Font Size accordingly. 

APPLyING FONT STyLES

Font styles	 are	used	 to	make	specific	data	appear	visually	different	 from	
other data in a worksheet. For example, Bold can make the headings appear 
thicker. Similarly, to draw attention to important data, you can underline it.  

To apply Font Styles to the selected 
cells, choose the desired option:

A  Bold: To make data appear as 
thick.  

B  Italic: To change data to slant 
position.

C  Underline: To insert single or 
double line under the selected 
data.

1

2

3

A B

C
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APPLy FILL COLOR AND FONT COLOR 

Fill color is the cell background color used to highlight the cells. The 
organization	of	data	 in	worksheets	can	be	made	more	specific	by	applying	
a	set	of	fill	colors.	Font color makes your data appear more attractive and 
visible.

To apply a Fill Color, Select a cell 
or range of cells and follow the 
steps given below:

1  Click on dropdown arrow 
of Fill Color command in 
the Font group.  

2  Choose a color from the 
color palette.

A   Fill color is applied.

In the same way, you can use the 
Font Color command to change 
the font color of the selected data.

APPLyING BORDER
While organizing your data, you can apply borders to clearly separate data 
from	surrounding	cells.	It	simplifies	the	analysis	of	information.	You	can	use	
the Border command to apply Borders to the selected range of cells.

To apply Border, select a cell or range of cells and follow the steps given 
below:

1  Click on the dropdown 
arrow of Border 
command in the Font 
group.

2  Select an appropriate 
border from the list; e.g. 
All Borders.

A  All Borders are applied.

You can choose No Borders to remove the borders 

from selected range of cells.

TIP
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THE FORMAT CELLS DIALOG BOX 
The Format Cells dialog box is used to apply a combination of various 
formatting options to the selected cells such as font, font size or font 
color. You can also apply additional formatting such as strikethrough 
using this dialog box.

To Open and Use Format Cells 
dialog box, follow the steps 
given below: 

1  Select a cell or range of cells.
2  Click on the Dialog Box 

Launcher at the bottom 
right in the Font group. 

A   This opens the Format Cells 
dialog box. 

3  Choose various formatting 
options you want to apply.

4  Click on OK button to apply 
the changes.

A
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.

1. Which of the following is not a spreadsheet program?

a. Microsoft Excel

b. Corel Quattro Pro

c. Apple iWork Numbers 

d. Microsoft Word 

2. An Excel 2016 workbook is a collection of _______.

a. Documents

b. Worksheets

c. Templates

d. Pictures

3. By default, how many sheets are there when you create a new blank Workbook 
in Excel 2016?

a. 3

b. 1

c. 2

d. 4

4. The keyboard shortcut to insert a new Worksheet is _______.

a. Shift + F1

b. Ctrl + N

c. Shift + F11

d. Shift + F6

245
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Hide Quick Analysis Name Box Fill color Formula Bar

1. _______ tool allows you to instantly create charts, apply conditional 
formatting and quickly calculate data.

2. The_______ command is used to change the background color of cells.

3. _______ displays the contents of the active cell and is used to enter a 
formula.

4. You can use _______ option to make a worksheet invisible from workbook.

Activity 3

Practice the following tasks on your computer.
1. Create a blank Workbook. Type the text “Welcome” in the cell A1, apply the 
font	style	as	“Bold”	and	font	color	as	“Purple”.	(Hint:	You	can	save	this	file	
with the name “Practice” on the desktop.)

2. Select the cell range from A1 to A6 using the Name box. 

3. Apply “All Borders” to the cell range from A1 to A6.

4. Insert a new worksheet and Rename it as “Student Marks”. Change the Tab 
Color to “Blue” and move this sheet before the “Sheet 1”.
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OBJECTIVESOBJECTIVES

In this Session, you will learn about the Alignment Group, 
Number Group and Styles Group of the Home Tab.

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	The Home Tab
•	Alignment Group

•	Number Group

•	Styles Group

Specific Objectives

ALIGNMENT, NuMBER AND STyLES GROuPS OF 
THE HOME TAB

Session
15

OBJECTIVES
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A C

B

A CB

THE HOME TAB

In the previous session, you learnt about the Font group of the Home Tab. This 
session will guide you to explore the Alignment group, Number group and Styles 

group of the Home Tab.

THE ALIGNMENT GROuP

Excel aligns text to the left position and numbers to the right position of the cell, by 
default. The Alignment group helps you to change horizontal and vertical alignment 
of cell data. The commands of this group also enable you to display the data around 
different positions in a cell, combine a range of cells and adjust the cell data if it 
does	not	fit	a	cell.

ADJuST HORIZONTAL CELL ALIGNMENT
Horizontal alignment determines the position of the data within a cell relative 
to the left and right borders of the cell.

The horizontal alignment allows following options.
 Align Left: Select this 

option to align cell content 
to the left edge of a cell.

 Center: Select this option to 
center align your content.

 Align Right: Select this 
option to align cell content to the right edge of a cell.

ADJuST VERTICAL CELL ALIGNMENT
Vertical alignment determines the position of the data within a cell relative to 
the top and bottom borders of the cell.

The vertical alignment allows following options
 Top Align: Select this 

option to align cell content 
to the top of the cell.

 Middle Align:  Select this 
option to align cell contents 
centered between top and 
bottom of a cell.

 Bottom Align: Select this option to align cell contents to the bottom of 
the cell.

A
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TEXT ORIENTATION
The Orientation command is used to rotate cell contents diagonally or 
vertically. You can use this feature when a column is not wide enough to 
display its contents.   

To Rotate Cell data, follow the steps given 
below:

 Select the cell containing data and 
click on dropdown arrow of Orientation 
command in the Alignment group.

 Choose an orientation option from the 
drop down list.

 The orientation is applied to the cell or 
range of cells you selected.

WRAP TEXT
When the data in a cell is extra-long, it occupies more than one cell if the cell 
next to it is empty. You can use Wrap text command to display long text into 
multiple lines so that you can see all of it.

To apply wrap text, follow the 
steps given below:

  Select the cell containing  
data.

  Click on Wrap Text comm- 
and in the Alignment group 
of Home Tab. 

  The data appears on multi- 
ple lines.

MERGE AND CENTER
The Merge and Center command combines selected cells into one larger cell 
and centers the contents. When you merge two or more adjacent horizontal 
or vertical cells into one cell, the cell is displayed across multiple columns or 
rows. You can use this feature to create labels that spans multiple columns or 
rows.

To merge and center, follow the steps given below:
 Select a range of cells you want to merge.
 Click on Merge and Center command in the Alignment group.
 The contents of the selected cells are merged and centered.
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NuMBER GROuP

Excel 2016 provides you with options to display 
numbers as percentage, currency, date, fraction etc. 
The Number group is used to apply different number 
formats to numerical data in a worksheet. This group 
contains the commands such as Number Format, 
Increase Decimal, Decrease Decimal etc.

APPLyING A NuMBER FORMAT
The Number Format box allows you to choose a format for the data such 
as Currency, Accounting, Date, Percentage etc. You can choose different 
number formats to change the appearance of a number without changing 
the number itself. A column containing prices of different items is better 
displayed by applying a Currency symbol such as $, SAR etc. A column 
containing Percentage of different numbers is better displayed by applying a 
Percentage (%) symbol.

To apply Currency format to selected 
cells, follow the steps given below:

1   Click on the arrow of Number Format 
box. 

2   Click on the Currency option.
A   Default Currency format ($) is applied 

to selected cells.
To apply Date format to the selected 
cells:

3  Click on the Short Date option from 
the Number Format box.

B  The Date format is applied to 
selected cells.

A1

2

1

2

3
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To apply Percentage (%) format to the 
selected cells:

 Click on the Percentage option from the 
Number Format box. 

 The Percentage format (%) is applied 
to selected cells.

More Number Formats
The following table provides a summary of some other number formats that 
are available in the Number group of Home Tab in Excel 2016.

Format      Example                                    use

General 4567 The default number format that Excel applies when you type a number. The 
numbers you type are right aligned in the cell.

Number 4567.00 Used to display numbers with decimal point and decimal places.

Accounting $ 4,567.00                   Used for monetary values like Currency format but aligns the Currency symbol at 
the left edge of the cell. This format is mostly used for accounting purposes.

Time 12:00:00 PM Displays number as Time values.

Fraction 55.75 →  55 3/4 Displays a number after decimal point as a fraction. 

Scientific 4570 → 4.57E+03
Displays a number in exponential notation, replacing part of the number with E+n, 
where E stands for Exponent and n represents the number, which is the nth power 
of the Exponent. 

Text KSU 18 Treats the content of a cell as text and displays the content exactly as you type it, 
even when you type numbers.

Special 000-00-4567 Displays a number as a postal code, phone number, or Social Security Number.

INCREASE / DECREASE DECIMAL
Increase Decimal and Decrease Decimal commands allow you to change 
the number of decimal places after the decimal point to better display your 
numerical data. You can show more or fewer number of digits after the 
decimal point of a number. The number of decimal places to be increased or 
decreased depend on whether you want to show your data more precise or 
less precise.

4

C A BC

The default Currency format is $ symbol. You can apply different 

currency symbols such as SAR, from format cells dialog box of 

Number Group.

TIP
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To increase or decrease decimal places for selected numbers, follow the steps 
given below:

1  Click on the Increase Decimal command in the Number group to increase 
the decimal places. 

A  The Decimal places are increased.
2  Click on Decrease Decimal command in the Number group to decrease 

the decimal places.
B  The Decimal places are decreased.

SPECIFyING DECIMAL PLACES

By default, Excel 2016 displays two (2) decimal places for Currency, Percentage 
and Number format. You can specify the number of decimal places to be displayed 
after the decimal point of a number. 

To specify decimal places for Number 
format, follow the steps given below:

1  Click on Dialog Box Launcher arrow 
in the Number group.

A  Format Cells Dialog Box appears.
2  Select Number option from the 

category list.
3  Specify the number of decimal places 

in the box next to Decimal places. 
4  Click on the OK button.

After you apply a number formatting e.g. Long Date or you increase decimal places, Excel 2016 displays ##### 

in the cell, indicating that the cell is not wide enough to display the data. You need to increase the column width to 

see the cell contents.

TIP

B
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STyLES GROuP

A style is a set of formatting characteristics that is applied to cell(s) at once. You 
can use several formatting styles to create professional-looking worksheets that 
display your data effectively. The commands of the Styles Group enable you to 
apply	pre-defined	formatting	styles	to	quickly	format	cells.	This	group	contains	the	
following commands:

A  Conditional Formatting: This command is 
used to apply different formatting styles to a 
range	of	cells	that	meet	specified	conditions.

B  Format as Table: This command is used to 
quickly format a range of cells and convert it to 
a	table,	by	choosing	a	pre-defined	table	style.

C  Cell Styles: This command is used to apply a cell style to a range of cells, 
by	choosing	a	pre-defined	cell	style.	

APPLyING CONDITIONAL FORMATTING 
Conditional formatting is used to apply colors, data bars or icon sets to the cells 
containing	values	that	meet	specific	criteria	or	condition.	For	example,	you	
can apply various colors or formatting options to visually highlight different 
values in the cells based on a criteria such as Less Than, Greater Than, 
Between, Equal To, etc. By applying conditional formatting to your data, you 
can quickly identify variations in a range of values with a quick glance. 

To apply Conditional Formatting to selected data, follow the steps given below: 
1  Click on Conditional Formatting command in the Cell Styles group.
2  Point to Highlight Cell Rules option and click on the Greater Than option. 
A  The Greater Than dialog box appears.
3  Enter the number (greater than condition) in the Greater Than dialog box.
4  Choose a required formatting option.
5  Click on the OK button.
B  The cells that are greater than the entered number are highlighted with 

the selected formatting style and the other cells remain unchanged.

A B C
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FORMAT AS TABLE
You can apply a table style to a group of related data in a worksheet. This 
helps	you	to	easily	manage	and	analyze	the	data.	You	can	quickly	sort	or	filter	
data and resize the table using the Sizing Handle.

To apply a Table Style, follow the steps given below: 

1  Select the cell range.
2  Click on Format as Table command in the Styles group. 
3  Select a Table Style from the gallery that appears. 
A  The Format As Table dialog box appears showing the selected cell range 

and an option to select whether it has table headers. 
4  Click on the OK button.
B  Table Style is applied to selected cell range.
C  You can use the Filter Control in the Header row	to	sort	and	filter	table	data.
D  A Sizing Handle in the lower-right corner of the table allows you to resize 

the table.

Click the Quick Analysis button   in the bottom  right corner of the selection to quickly apply Conditional 

Formatting.

TIP

Click the Quick Analysis button   in the bottom  right corner of the selection to quickly apply Table Style.

TIP
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APPLyING CELL STyLES

To make your important data standout in a worksheet, you can apply a colorful 
cell style. A cell style is a set of formatting characteristics, such as a font, 
font size, cell border and cell shading. Cell Styles allow you to apply several 
formatting styles in one step and ensures that cells have consistent formatting.

To apply a Cell Style to the selected cells, follow the steps given below:

1  Click on the Cell Styles command in the Styles group.

2  Select a desired style from the gallery that appears.
A  The cell style is applied to the selected cells.

2
1

A



ALIGNMENT, NUMBER & STYLES GROUPS OF THE HOME TAB

256

Module Four : Spreadsheets (MS Excel 2016)

ACTIVITIES

Choose the correct option for the following statements.
1. You can use the _______ command to display long text into multiple lines 

within a cell.

a. Text Orientation

b. Middle Align

c. Wrap Text

d. Merge and Center

2. ________ is the default number format for a cell.

a. General 

b. Text

c. Fraction

d. Number

3. The	_______command	enables	you	to	apply	a	pre-defined	table	style	to	a	
range of cells.

a. Border

b. Format as Table

c. Table

d. Create Table

4. ________	 is	 used	 to	 highlight	 a	 range	 of	 cells	 that	meets	 some	 specific	
criteria.

a. Number Formatting

b. Format as Table

c. Conditional Formatting

d. Cell Format

Activity 1
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Text Cell Styles Number Orientation Currency

1. The _______ command allows you to rotate cell contents in several 
directions.

2. By default, Excel aligns ______ to the left position in a cell.

3. The _______ format shows numeric data in cells as monetary values.

4. The______ command allow you to apply several formatting effects to a cell 
in one step.

Activity 3

Practice the following tasks on your computer.
1. Create a new workbook. Type the text “3-Mar” in the cell A1 and apply the    

number format “Short Date”. 

2. Select the cell range from A1 to A6. Merge the selected cells and “Middle 
Align” the cell content.

3. Select the cell A1 and rotate the cell content to “Angle Clockwise”.

4. Type “100” in cell B8. Apply the Number format “Currency” to cell B8, change 
the currency symbol to “SAR” and increase the decimal places to “3”. 
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OBJECTIVES

In this Session you will learn about Cells Group and Editing 
Group of the Home Tab of Excel 2016. 

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	The Home Tab
•	Cells Group

•	Editing Group

Specific Objectives

CELLS GROuP AND EDITING GROuP OF THE 
HOME TAB

Session
16

OBJECTIVES
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THE HOME TAB

In the previous session, you learnt to apply different styles to the worksheet cells 
using the Styles group of the Home tab. In this session, you will learn about the 

Cells group and Editing group of the Home tab.

CELLS GROuP
The commands of the Cells group enable you to insert, delete and format cells, rows, 
columns or worksheets. This group contains the following commands: 

 Insert: This command is used to add new cells, rows, 
columns and worksheets to your workbook. 

 Delete: This command is used to remove cells, rows, 
columns and worksheets from your workbook. 

 Format: This command is used to resize rows and 
columns as well as organize and protect your worksheets.

INSERTING ROWS
You can insert single or multiple rows wherever you want in a worksheet. The 
new row is inserted above the selected row in the worksheet.

To Insert a new row, follow 
the steps given below:

 Select the row or 
a cell of the row 
above which you 
want to insert the 
new row. 

 Click on the arrow of 
the Insert command 
in the Cells group.

 Click on Insert 
Sheet Rows option 
from the list.

 A new blank row is 
inserted above the 
selected row.

 Insert Options 
button appears to 
format the newly 
inserted row same 
as above or below row.
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To insert multiple rows at a time, you need to select equal number of rows from the 
worksheet. For example, to insert three new rows, you need to select three rows 
from the worksheet before using the Insert command.

To insert non-adjacent rows, hold down Ctrl key and select the desired non-adjacent rows. Click the Insert 

command to insert new rows.

TIP

INSERTING COLuMNS
You can insert single or multiple columns wherever you want in a worksheet. 
The new column is inserted to the left of the selected column. 

To Insert a new column, 
follow the steps given 
below:

 Select the column 
or a cell of the 
column before 
which you want to 
insert the new 
column. 

 Click on the arrow 
of the Insert 
command in the 
Cells group.

 Click on Insert 
Sheet Columns 
option from the 
list.

 A new blank 
column is inserted 
to the left of the 
selected column.

To insert multiple columns at a time, you need to select an equal number of 
columns from the worksheet before using the Insert command.

To insert non-adjacent columns, hold down Ctrl key and select the desired non-adjacent columns. Click the Insert 

command to insert new columns.

TIP

INSERTING AND SHIFTING CELLS
You can also insert single or multiple cells in a worksheet. For inserting multiple 
cells at a time, you need to select equal number of cells in the worksheet. The 
new cells are inserted to the left or above selected cells. 
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To insert cells, follow the steps given below:
 Select a cell or 

range of cells where 
you want to insert 
new cells.

 Click on the arrow of 
Insert command 
in the Cells group.

 Click on Insert 
Cells option from 
the list.

 It opens the Insert 
Dialog Box to select 
an option to Shift 
cells right, Shift 
Cells down, insert 
Entire Row or Entire 
Column.

 Click on the OK 
button.

 Excel inserts new 
cells in place of 
selected cells.

To quickly insert, right click on selected cells, rows or columns and select insert option.

TIP

DELETING CELLS, ROWS OR COLuMNS
You can delete single or multiple cells, rows and columns that you no longer 
need in your worksheet. You need to select the cells, rows or columns before 
using the Delete command. 

To delete a row, follow the steps given below:

 Select the row you 
want to delete.

 Click on the arrow  
of Delete command 
in the Cells group. 

 Click on Delete 
Sheet Rows option.
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To delete a column:
 Select the column and click on Delete Sheet Columns option from the 

Delete command.

To delete a cell:
 Select the cell and click on Delete Cells option from the Delete command.

When you delete a cell or a range of cells, you can Shift cells left, Shift cells up, 
delete Entire row, or delete Entire column.

FORMAT ROWS AND COLuMNS
The Format command in the Cells group allows you to adjust the height and 
width of rows and columns in your worksheet. You can specify row height from 
0 to 409 points and column width from 0 to 255 characters. The height of 
multiple rows or width of multiple columns can also be changed at the same 
time. 

To change row height, follow the steps given below:
 Select the row 

you want to 
resize.

 Click on the 
arrow of Format 
command in the 
Cells group.

 Click on Row 
Height option.

 It opens Row Height dialog box to enter the new row height. 
 Click on the OK button.

To change the column width:
 Select the column and click on Column Width option from the Format 

command. Specify the new column width and click on the OK button.

To quickly set the row height or column width, 
right-click the selected rows or columns and 
choose the row height or Column Width option, 
type the value and then click the OK button.

If the row height is zero (0), the row is 
hidden. Similarly, if the column width is 
zero (0), the column is hidden. 

TIPS

EDITING GROuP
Excel 2016 helps you to perform calculations or analyze the data in the worksheet. 
The commands of Editing Group enable you to quickly calculate your data, generate 
series of numbers and text automatically, sort your data in an order or search for 
particular data. In this section you will learn to use the following commands:
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 AutoSum: This Command is used to quickly 
calculate sum of data in contiguous cells.

 Fill: This	Command	is	used	to	fill	the	selected	
cells with the contents of adjacent cells.

 Sort and Filter: This Command is used to 
organize	your	data	in	an	order	or	filter	out	
data	to	display	only	the	specific	data	you	want.

AuTOSuM
AutoSum is a built-in feature of Excel 2016 that allows you to quickly calculate 
sum of values without manually entering a formula. You can also calculate 
average, minimum or maximum values using dropdown menu of AutoSum 
command. To use AutoSum command, you need to select the blank cell next to 
the numbers in a row or a column. AutoSum will automatically sense the range 
to be calculated and builds the formula for you. 
To use AutoSum, follow 
the steps given below:

 Select the cell where 
you want to display 
the sum.

 Click on the Auto 
Sum command in 
the Editing group.

 Excel selects range 
of cells and displays 
the formula in the 
selected cell.  
Press the Enter Key.

 Sum is displayed
     in selected cell.

AuTOFILL FOR FASTER DATA CALCuLATION
Excel’s AutoFill feature is used to copy the contents or formula of a cell to the 
adjacent cells. While using AutoFill feature, you can use the Fill handle, which 
is a small square in the lower-right corner of the selected cells. 
To use AutoFill feature, follow the steps given below:

 Select the cell containing the formula you want to AutoFill. 
 Move the mouse pointer to the bottom right corner of the cell.
 When mouse pointer changes to (+) sign, drag the Fill handle downwards 

to	the	last	cell	you	want	to	fill.
 The Formula is copied and the results are shown in the cells.
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OTHER uSES OF AuTOFILL
Instead of entering data manually, the AutoFill feature also allows you to 
automatically	fill	a	range	of	cells	with	data	that	follows	a	pattern,	for	example	
a series of numbers, dates, weekdays, months or years. To AutoFill a series of 
numbers, you need to enter numbers in at least two cells and select both cells.

 
To AutoFill cells with Weekdays, follow the step given below:

1  Enter a weekday in a cell 
and drag the Fill handle 
downwards as far as you 
want	to	fill	the	cells.

A 	 Weekdays	 are	 filled	
automatically.

To use AutoFill for generating 
a series of numbers, follow the 
step given below:

2  Enter	 the	 first	 two	
numbers of the series.

 Select both cells and drag the 
Fill handle downwards as far as 
you	want	to	fill	the	cells.

 Number	series	is	filled	automatically.

CREATING A FORMuLA
Excel 2016 allows you to manually create formulas for calculations. A formula 
is an expression that performs calculations on data in the cells. A formula 
uses arithmetic operators like +, -, *, /, %, to perform addition, subtraction, 
multiplication, division and percentage respectively. In Excel 2016, a formula 
begins with an equal to (=) sign. 
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To create a formula to 
multiply two numbers, follow 
the steps given below:

 Select a cell where 
you want to display 
the result.

 Type the formula 
starting with equal 
sign (=) followed by 
the Cell addresses 
you want to calculate 
with the (*) sign in 
between. 

The formula will appear 
in the cell and in the 
formula bar. Press the 
Enter Key at the end.

 The result is displayed 
in the cell you selected.

You can also manually create formulas to calculate the numbers directly. For example, when you type =12+10 in 

a cell and press ENTER key, Excel calculates the result and displays 22 in that cell.

TIP

uSING FILL COMMAND
You	can	use	the	Fill	command	to	fill	the	selected	cells	with	the	contents	of	an	
adjacent cell or range of cells. 

To use the Fill command, follow the steps given below:
   Select the Cell or Cell range where you want to copy the contents of 

adjacent cell or cell range.
     Click on the arrow of Fill command in the Editing group. 
     Select Down, Right, Up or Left	option	to	fill	the	selected	cells.
 The	selected	cells	are	filled	with	the	contents	of	adjacent	cells.
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You can also use the Fill command to fill a formula into adjacent range of cells. Select simultaneously, the cell with 

the formula and the adjacent cells you want to fill. Click the Fill command and choose Down, Right, up, or Left 

option.

TIP

SORTING DATA
Sorting data is an integral part of data analysis. It allows you to arrange the 
data in an order to quickly visualize and understand it better. You can sort a 
list of names in an alphabetical order i.e. (A to Z or Z to A). Similarly, you can 
sort a list of numbers in Ascending order (Smallest to Largest) or Descending 
order (Largest to Smallest).
 
To sort a list of numbers in ascending order, follow the steps given below:

 Select	the	first	cell	of	the	column	you	want	to	sort.	
 Click on the arrow of Sort & Filter command in the Editing group.
 Select Sort Smallest to Largest option.
 The data is sorted according to your selection and the accuracy with the 

other data is maintained.
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A

FILTERING DATA
Filter	command	allows	you	to	view	specific	rows	in	a	worksheet,	while	hiding	
the	other	rows	that	do	not	meet	the	specified	filtering	criteria.	When	you	apply	
Filter command, Filter Controls appear to the header cell of the columns. You 
can	use	the	Filter	Controls	on	a	column	to	specify	the	criteria	for	filtering	the	
data in the column.

To use the Filter command, follow the steps given below:
 Click	on	the	header	cell	of	the	column	that	you	want	to	filter.
 Click on the arrow of Sort & Filter command in the Editing group. 
 Select the Filter option.
 It will add Filter Control with a dropdown arrow to each column heading. 
 Click on the arrow of Filter control of the column you want to sort. 
 Click the check boxes according	to	the	filtering	criteria	you	want.
 Click on the OK button. 
 The	data	 is	filtered	and	you	see	only	 the	 information	according	to	 the	

filtering	criteria.
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Activity 1

Choose the correct option for the following statements.
1. A new row is inserted _______ the selected row in the worksheet.

a. Below 

b. Right

c. Above

d. Left

2. The_______command is used to change the row height or column width.

a. Insert

b. Format

c. Change

d. Font Size

3.	 The_______	command	is	used	to	fill	the	selected	cells	with	the	contents	of	
adjacent cells.

a. Format

b. AutoSum

c. Fill

d. Sort

4. _______feature allows you to arrange the data in an order, according to the 
contents of a column.

a. Sort

b. AutoFill

c. Filter

d. Format

ACTIVITIES
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Filter Sort Cells AutoFill AutoSum

1. _______ group enables you to insert, delete and format the rows or columns 
of worksheet.

2. The_______command is used to quickly add a range of numbers in a column 
or a row.

3. _______feature is used to generate a series of numbers, weekdays, months, 
etc.

4. _______ option temporarily hides unwanted data to show only the data you 
need. 

Activity 3

Practice the following tasks on your computer.
1.  Create a blank Workbook. Select the column range from A to E and increase 

the column width to 30.

2. Enter the data of 5 students under the column headings “ID Number”, 
“Name”, “Midterm marks”, and “Final marks”. Enter the column heading 
“Total marks” and calculate total marks for each student. (Hint: You can use 
AutoSum command.)

3. Generate name of the months starting from “January” to “December” in the 
cell range B10 to B21. (Hint: You can use AutoFill feature.) 

4. Display only the details of the students who have a “Total mark” less than 
50.
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OBJECTIVESOBJECTIVES

In this Session you will learn about Charts Group of the 
Insert Tab and Themes, Page Setup, and Sheet Options 
groups of the Page Layout Tab of Excel 2016.

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	The Insert Tab
•	Charts Group

•	The Page Layout Tab
•	Themes Group

•	Page Setup Group

•	Sheet Options Group

Specific Objectives

THE INSERT TAB AND THE PAGE LAyOuT TABSession
17

OBJECTIVES
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INSERT TAB

The Insert Tab enables you to insert Charts, Pictures, 3D Maps, Links, etc. in your 
worksheet. In the following section, you will learn to create and format Charts in 

Excel 2016 that help you to visualize worksheet data graphically.  

CHARTS GROuP
Charts feature is one of the most powerful and 
easy-to-use feature of Excel 2016. The different 
chart types that are available in Charts group 
include: Column Chart, Line Chart, Pie Chart, 
Bar Chart, Waterfall Chart, etc.

WHAT IS A CHART?
A Chart is a graphical representation of data, used to communicate information 
in  an easy to understand and attractive manner. Charts are especially helpful 
to illustrate the workbook data graphically, which makes it easy to visualize 
comparisons. In an Excel 2016 chart, the data series is represented by data 
points, such as columns in a column chart, bars in a bar chart or lines in a line 
chart.   

ELEMENTS OF A CHART
A chart is comprised of various chart elements. The chart elements can be 
edited or formatted to make the chart descriptive, meaningful and appealing. 
Some of the chart elements are displayed by default; others can be added as 
needed.

 Chart Area: It is the 
entire area of the chart, 
which encompasses all 
the chart elements.

 Plot Area: The actual 
chart area where the 
data is graphically 
plotted in the chart.

 Chart Title: It is the 
title that gives an idea 
about the contents of 
the chart.

 Data Points: They represent the data series that are plotted in the 
chart.

 Primary Vertical Axis Title: It is the title of vertical (value) axis.
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 Primary Horizontal Axis Title: It is the title of horizontal (category) axis.  
 Legend: It shows which color represents what data in the chart. 
 Data Labels: Help you to identify the details of the data on the chart 

itself.

INSERTING A CHART
You can create a chart for the 
data you have arranged in rows 
or columns in a worksheet. As 
mentioned, there are several 
chart types available in Excel 
2016, you have to choose the 
one that best suits to your data. 
For example, Column chart is 
used to compare values across 
a few categories. It displays 
categories along the horizontal 
axis and values along the 
vertical axis.

To insert a column chart, follow 
the steps given below:

 Select the columns or 
rows containing data that 
you want to plot in the 
chart. 

 Click on the Insert Column 
or Bar Chart command in 
the Charts group. 

 Select a suitable column 
chart from the displayed 
list of charts. 

 Selected Chart type is inse- 
rted.

 Chart buttons appear.
 Chart tools appear.

If you are not sure which type of chart to use, the Recommended Charts command in the Charts group will 

suggest several charts based on your selected data.

TIP
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CONTEXTuAL TABS- DESIGN & FORMAT 
When you insert a chart, two new contextual tabs, Design tab and the Format 
tab, appear on the ribbon with the title Chart Tools.

 The Contextual Design Tab: This tab enables you to add chart elements, 
change chart styles, colors and change chart data. It also enables you to 
Move a Chart or change Chart Types.

 The Contextual Format Tab: This tab enables you to format different 
elements	of	a	chart	by	applying	shape	styles,	shape	effects,	or	fill	colors.	
It also enables you to draw different shapes on the chart and apply 
different WordArt Styles to chart titles.   

CHART BuTTONS
Chart Buttons enable you to quickly format the inserted chart. They appear 
to the upper right corner of the chart. When you select the chart, Excel 2016 
provides you with the following Chart buttons. 

 Chart Elements 
Button: 
This button is used 
to add, remove and 
change chart eleme-

    nts such as Title, Axis, 
Legend,Gridl ines 
etc.

 Chart Styles 
Button: This button 
is used to set a style 
or color scheme for 
the chart.

 Chart Filters Button: This button is used to select the data points to be 
visible on your chart.
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MOVING A CHART
When you insert a new chart, it is placed on the same worksheet that contains 
its source data. The Move Chart command enables you to move the chart to  
a new sheet or as an object to any existing worksheet. It helps you to keep 
your workbook organized.

To move a chart, select it and follow the steps given below:
 In the contextual Design 

tab from the Location 
group, click on the Move 
Chart command.

 It displays Move Chart 
dialog box.

 In the dialog box,  select 
New sheet option to move 
the chart in a chart sheet 
and type the chart sheet 
name. 

 Use the Object  in box if 
you want to move the 
chart to an existing work- 
sheet.

 Click on the OK button.

CHART STyLES
Excel	2016	provides	a	variety	of	useful	predefined	chart	styles	and	colors	to	
customize the visual style of the chart.

To apply a Chart Style, select 
the chart and follow the steps 
given below:

 In the contextual Design 
tab from the Chart Styles 
group, click on the More 
Drop Down Arrow. 

 Select a suitable chart 
style.

 Selected style is applied 
to the chart.
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You can also change the background color and shape style for the chart from Shape Styles group of the contextual 

Format Tab. 

TIP
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CHART TITLE
To make a chart easier to understand, you can add a chart title. The Add Chart 
Element command helps you to add, remove or change chart elements such as 
Chart Title, Axes, Data Labels, etc.  
 
To insert a Chart Title, select the 
chart and follow the steps given 
below:  

 In the Chart Layouts 
group of contextual 
Design tab, click on 
the Add Chart Element 
command. 

     Point to Chart Title option.
 Select Above Chart 

option.
 Type the Chart Title.

AXIS TITLES
Axis Titles help you to clarify the information in your chart. Charts usually have 
two axes that are used to measure and categorize the data. A Column Chart 
typically displays the categories along the Horizontal (category) Axis and the 
values along the Vertical (value) Axis. 

To add Axis Titles, select the 
chart and follow the steps 
given below:

 In the Chart Layouts group 
of contextual Design tab, 
Click on the Add Chart 
Element command.

 Point to the Axis Titles 
option.

 Select the desired Axis 
(Primary Horizontal or 
Primary Vertical)

 Type the suitable axis 
titles.
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You can add, show or hide chart elements using the check boxes that appear when you click on the Chart Elements 

button. 

TIP

You cannot add Axis Titles to charts that do not have Axis (Pie or Doughnut charts).

TIP
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DATA LABELS
Data Labels make a chart easier to understand by showing the actual data 
values on its individual data points. Data Labels help you to quickly identify 
variations in a data series of the chart. By default, the data labels are linked to 
values in the worksheet, and gets updated automatically when the values are 
changed.

To show Data Labels on a chart, select the chart and follow the steps given 
below:

 In the contextual 
Design Tab from the 
Chart Layouts group, 
click on the Add Chart 
Element command.

 Point to Data Labels 
options.

      Select a suitable 
Data Label position 
from the list that 
appears.

 Data Labels are disp- 
layed on the chart.

CHANGING CHART DATA
After you create a chart, you may need to add, change or remove its source 
data in the worksheet. The Select Data command enables you to change the 
source data (data range) to be included in the chart.

To change the Chart Data, select the chart and follow the steps given below:

            Click on the Select Data command in the Data group of the 
contextual Design tab.
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 The Select Data Source dialog box appears.
 Worksheet containing source data appears.
 Select the new data range from the worksheet that you want to include 

in the chart.
 Click on the OK button.
 The Chart is updated with the new source data.

CHANGING CHART TyPE
If your data is not well suited to a 
certain Chart Type, you can switch 
to a different Chart Type. Change 
Chart Type command enables you 
to change your existing chart to a 
different Chart Type. For example, 
you can change a Column Chart to 
a Bar Chart.

To change the Chart Type, select 
the chart and follow the steps given 
below: 

 Click on the Change Chart Type 
command in the Type group of 
contextual Design tab.

 Change Chart Type dialog box 
appears.

 In the All Charts tab of the 
dialog box, select a suitable 
Chart Type in the left pane.

 In the right pane of the dialog 
box, select the chart Sub-type. 

 Click on the OK button.
 The Chart is changed to 

selected Chart Type.
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PRINT A CHART
You may print the chart along with the data on the worksheet in the normal 
way. You can also quickly print a chart without the worksheet data.  

To Print a selected chart, follow the steps given below:
 Click on the Print option 

in the File Tab Backstage 
view.

 The Print Selected Chart 
option is selected in the 
Settings dropdown menu.

 Print preview of the 
chart appears.

 Click on the Print button.

PAGE LAyOuT TAB

The Page Layout tab allows you to customize the way your worksheets are set up 
into different pages. It helps you to change the Theme, Page Size, Margins, Print 

Area, and more.

THEMES GROuP
The Themes group commands enable you to format the 
entire workbook to give it a professional and modern look 
by applying a theme, theme colors, theme fonts and theme 
effects.

APPLyING THEMES
A theme is a unique set of formatting characteristics  that includes colors, fonts 
and effects. Themes command	is	used	to	apply	a	theme	from	several	predefined	
Excel 2016 themes to give your workbook a style instantly. The selected theme is 
applied to all the worksheets in the workbook.

To apply a Theme, follow the steps given below:
  Click on the Themes 

command in the 
Themes group. 

     Select a suitable Theme 
from the themes gallery.

      Selected theme is 
applied and the entire 
look of the workbook is 
changed instantly.
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PAGE SETuP GROuP
The Page Setup group has some common page setup commands such as Page 
Margins, Orientation, and Size. It also has some special commands such as Print 
Area, Background, and Print Titles that you will learn in the following section.

SET PRINT AREA
A print area is a range of cells that you select to print when you do not want to 
print the entire data of the worksheet. The Print Area command enables you to 
select only the area of the worksheet you need to print. 

You can also remove the selected print area using the Clear Print Area option 
of the Print Area command.

To set Print Area, follow 
the steps given below:

  Select the area that 
you want to set as 
print area.

     Click on the Print Area 
command in the Page 
Setup group. 

  Select the Set Print 
Area option.

     
To Clear Print Area,
   Select the Clear Print 

Area option of the 
Print Area command.

WORKSHEET BACKGROuND
The Background command enables you to insert a picture as worksheet 
background. You can browse your computer for the background picture or 
search for online pictures using Microsoft Bing Search box.  The worksheet 
background picture is used for display purpose only and is not printed.
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You can select multiple print areas by holding down Ctrl key before using the Set Print Area command. Each Print 

Area will print as a separate page.

TIP
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To insert a picture as worksheet background, follow the steps given below:
    1  Click on the Background 

command in the Page Setup 
group.

A  The Insert Pictures dialog 
box appears.

2  In the dialog box, click on 
Browse to select the picture 
on your computer. 

B  Use the Bing Image Search 
box if you want to search 
for online pictures.

3  Browse and select the picture 
in the Sheet Background 
dialog box.

4  Click on the Insert button.
C  Selected picture is inserted as worksheet background.

PRINT TITLES
You can use Print Titles command to specify the 
rows to be printed at the top or columns to be 
printed at the left of each page. For example, you 
can print the header row on all pages when you 
have a large worksheet to print, so the readers 
don’t	have	to	go	back	to	the	first	printed	page	to	
see the headers.
To set Print Titles, follow the steps given below:

   Click on the Print Titles command in the Page 
Setup group. 

   Page Setup dialog box appears.
   Click in the Rows to repeat at top box under 

Sheet tab of the dialog box.
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 Select the Row that you want to print on every page.
 Similarly, click in the Column to repeat at left box and select the column 

that you want to print on every page.
 Click on the OK button

SHEET OPTIONS GROuP
The commands of Sheet Options group 
allow you to change the Sheet Direction, 
show/hide/print the Gridlines and Headings 
of columns and rows.

 

SHEET RIGHT-TO-LEFT
If the column & row 
headings start from top 
left of the worksheet 
and you want to change 
the sheet direction from 
right to left, you can 
use the Sheet Right-
to-Left command.

To change the sheet 
direction,

 Click on the Sheet 
Right-to-Left 
command in the 
Sheet Options 
group.

 Sheet direction is 
changed from right 
to left.
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You can also click on Collapse Dialog button   at the right end of the Rows to repeat at top and 

Columns to repeat at left boxes, to minimize the dialog box and then select the title rows or columns that you 

want to print on every page. 

TIP
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HIDE GRIDLINES AND HEADINGS OF COLuMNS & ROWS 
Gridlines are the faded lines that appear around the cells to distinguish them on 
the worksheet. By default, Gridlines appear in the entire workbook. Similarly, 
the column headings (A, B, C, etc.) or row headings (1, 2, 3, etc.) are also 
displayed, by default. You can hide these Gridlines and Headings of rows and 
columns, if you want.

To hide Gridlines,

 Uncheck the View check 
box under Gridlines in the 
Sheet Options group. 

 Gridlines are disappeared.

To hide Headings of columns 
and rows,

 Uncheck the View check 
box under Headings in 
the Sheet Options group. 

 Column headings are 
hidden.

 Row headings are hidden.

PRINT GRIDLINES AND HEADINGS
By default, Excel 2016 does not print the Gridlines and the Headings of columns 
and rows that you see on screen. You can specify to print the Gridlines or 
Headings from Sheet Options group. 

To print Gridlines,

       Check the Print check box under Gridlines 
in the Sheet Options group.

To print Headings,

      Check the Print check box under  Headings 
in the Sheet Options group.
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Choose the correct option for the following statements.
1. The______ is used to visualize workbook data graphically.

a. Row

b. Cell

c. Chart

d. Table

2.  The ______ is used to identify the chart name and usually displayed above 
the chart. 

a. Legend

b. Chart Title

c. Chart label

d. Data Points

3. A ______is a unique set of formatting characteristics that changes the look 
of your workbook.

a. Print Area

b. Background

c. Chart

d. Theme

4. A _______ is a ranges of cells that you select to print when you don’t want 
to print the entire worksheet. 

a. Margins

b. Orientation

c. Print Area

d. Print Titles

ACTIVITIES

Activity 1
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Legend Background Print Area Print Titles Data Labels

1. _______ are used to show actual data values of the data series in a chart.

2. _______ is a part of chart that describes the meaning of colors and patterns 
used in the chart.

3. The _______ command enables you to insert a picture behind the contents 
of a worksheet.

4. _______ feature is used to print the header row at the top of each page. 

Activity 3

Practice the following tasks on your computer.

1. Create a blank Workbook. Enter the data of 5 students under the column 
headings “ID Number”, “Name”, “Marks” in the cell range A1 to C6. Apply 
the theme “Main Event”.

2. Insert	a	Column	Chart	for	the	data	of	“Name”	and	“Marks”	fields.	Move	the	
chart to new sheet and name it as “Students Marks”.

3. Change the chart type to “Bar Chart” and show the data labels at “Outside 
End”. 

4. Set the print area from the cell range A1 to C6.
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OBJECTIVES

THE FORMuLAS TABSession
18

OBJECTIVES

In this Session, you will learn about Function Library group 
of the Formulas Tab of Excel 2016.

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	The Formulas Tab
•	Function Library group

Specific Objectives

OBJECTIVES
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LEARNING

FORMuLAS TAB

The Formulas Tab allows you to calculate data using a variety of functions available 
in Excel 2016. In this session, you will learn about the Function Library group that 

contains built-in functions, which simplify various complex calculations. 
FuNCTION LIBRARy GROuP

Excel 2016 provides a number of built-in functions to perform mathematical, 
statistical, logical or other operations easily. Function Library group contains various 
functions grouped in different categories such as Financial, Logical, Text, Date & 
Time	and	Math	&	Trig,	to	help	you	find	the	suitable	function.	You	will	learn	some	basic	
functions of Excel 2016 from the following categories.

A  Logical: Logical Functions are used to test for a condition to evaluate it as true 
or false. It includes functions such as AND, FALSE, IF, NOT, OR, TRUE, etc.

B  Text: Text functions are used to manipulate text strings. It includes functions 
such as CHAR, LEN, LOWER, PROPER, TEXT, UPPER, etc.

C  Math and Trig: These functions perform arithmetic operations, conditional 
sum, exponents & logarithms, and the trigonometric calculations.

     It includes the functions such as SUM, SUMIF, LOG, COS, SIN, etc.
D  More Functions: It includes Statistical and Engineering functions such as 

AVERAGE, COUNT, MAX, MIN, CONVERT, DELTA, etc.

To access all available functions, you can also use the Insert Function command of Function Library group or you can 

use the Insert Function button (fx) available to the left of the formula bar.

TIP

D
A B C
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WHAT IS A FuNCTION?
A Function in Excel 2016 is a preset or inbuilt formula that performs calculations 
automatically.	Each	function	has	a	specific	syntax, i.e. a set of rules associated 
with it. In order to use a function correctly, you need to understand its syntax. 
The general syntax of a function is as follows:

=Function Name(argument list)
Example:  = SuM(number1, [number2], ...)

A Function has an Equal Sign (=), Function name and Argument list, which 
is enclosed within parentheses. Arguments are the values (e.g., 10, abc) or 
cell references (e.g., D5, B2:B8) supplied to the function. Some arguments 
are mandatory (required), whereas some are optional.

THE SuM FuNCTION
The SUM function calculates the sum of values contained in a range of cells. 
Syntax:
 =SUM(number1, [number2],....)

To use the SUM function, select the cell to display the result, and follow the 
steps given below:

 Click on the Math & Trig 
category in the Function 
Library group. 

 Select the SUM function 
from the displayed list of 
functions.

 Function Arguments 
dialog box appears.

 In the Number 1 box, 
enter the cell range you 
want to sum or select 
the cell range from the 
worksheet. 

 Click on the OK button.
 The Sum value is displayed 

in the selected cell.
 The SUM function appears 

in the Formula bar.

1

2

A

3

4

B

C

4

1

2

3

A

B

C
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THE AVERAGE FuNCTION

The AVERAGE function is used to calculate the average of the values contained 
in	a	range	of	cells.	It	calculates	the	sum	of	the	specified	values	and	then	divides	
the sum by the count of those values.
 Syntax: 
=AVERAGE(number1, [number2], ...)

To use the AVERAGE function, select the cell to display the result, and follow 
the steps given below:

1  Click on the More Functions category in the Function Library group.
2  Point to the Statistical option and select the AVERAGE function from the 

displayed list of functions. 
3  In the Number 1 box, enter the cell range for which you want to calculate 

average, or select the cell range from the worksheet.
4  Click on the OK button.
A  Average value is displayed in the selected cell.
B  The Average Function appears in the Formula bar.

B

A

1

2

3

4
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THE COuNT & COuNTA FuNCTIONS 

The COUNT function counts the number of cells in a range that contain numbers 
only. 
Syntax: 
=COUNT(Value1, [Value2], ……) 

The COUNTA function counts the number of cells in a range that are not empty 
i.e. it counts cells with text and numbers but does not count empty cells. 
Syntax: 
=COUNTA(Value1, [Value2], ……) 

To use the COUNT function, 
select the cell to display 
the result, and follow the 
steps given below:

1  Click on the More 
Functions category 
in the Function Libr- 
ary group.

2  Point to the Statistical 
option and select 

      the COUNT function
     from the displayed     

list of functions. 
3  In the Value 1 box, 

enter or select the 
cell range you want 
to count from the 
worksheet.

4  Click on the OK button.
A  The cells containing 

numbers are count-
     ed. Similarly, to use 

the COUNTA function,
5  Choose the COUNTA 

function from the 
displayed list of 
Statistical functions. 
•	 Follow the steps 3 & 4 mentioned above

B  The non-empty cells are counted.

BA

5

2

1

3

4
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THE MAX AND MIN FuNCTIONS 

The MAX function is used to calculate the largest or maximum value in the 
selected range of cells.
Syntax: 
=MAX(number1, [number2], ...)

The MIN function is used to calculate the smallest or minimum value in the 
selected range of cells. 

Syntax: 
=MIN(number1, [number2], ... 

To use the MAX function, select the cell to display the result, and follow the 
steps given below:

1  Click on the More 
Functions category in 
the Function Library 
group.

2  Point to the Statistical 
option and select the 
MAX function from 
the displayed list of 
functions.

3  In the Number 1 box, 
enter or select the 
cell range from the 
worksheet.

4  Click on the OK button.
A  Maximum value is 

displayed in the sel- 
ected cell.

Similarly, to use the MIN 
function,

5  Choose the MIN func - 
tion from the displayed 
list of Statistical func - 
tions. 
•	 Follow the steps 
3 & 4 as mentioned 
above. 

B  Minimum value is dis- 
played in the selected 
cell. 

3

4

1

2

5

A

B
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THE LOWER & uPPER FuNCTIONS 

The LOWER function is used to convert the text to lowercase i.e. small letters. 

Syntax: 
 =LOWER(Text)

The UPPER function is used to convert the text to uppercase, i.e. capital letters. 

Syntax:
=UPPER(Text) 

To use the LOWER function, select the cell to display the result and follow the 
steps given below:

1  Click on the Text category 
in the Function Library 
group.

2  Select the LOWER function 
from the displayed list of 
Text functions.

3  In the Text box of Function 
Arguments dialog box, 
enter the cell address 
containing the text string 
you want to convert or 
select the cell from the 
worksheet.

4  Click on the OK button.
A  The text is converted to 

lower case.
     Similarly, to use the UPPER 

function,
5  Choose the UPPER function 

from the displayed list of 
Text functions. 
•	 Follow the steps 3 & 4 as 

mentioned above. 
B  The text is converted to 

upper case.

1

5

2

B

A

3

4
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THE LEN & PROPER FuNCTIONS 

The LEN function is used to calculate the number of characters in a text 
string including spaces. 
Syntax: 
=LEN(Text) 

The	PROPER	function	capitalizes	the	first	letter	of	each	word	of	a	text	string	
and changes all other letters to lowercase. 

Syntax:  
=PROPER(Text)

To use the LEN function, select the cell to display the result and follow the 
steps given below:

1  Click on the Text function 
category in the Function 
Library group.

2  Select the LEN function 
from the displayed list of 
Text functions.

3  In the Text box of Function 
Arguments dialog box, 
enter or select the cell 
containing the text string 
from the worksheet. 

4  Click on the OK button.
A  The length of the text 

string is displayed.
Similarly, to use the PROPER 
function,

5  Choose the PROPER 
function from the 
displayed list of Text 
functions.
•	 Follow the steps 3 & 4 
as mentioned above. 

B  The Proper case is applied
     to the text string.

3

4

B

A
5

2

1
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THE IF FuNCTION 

The IF function allows you to evaluate a situation which has two possible results 
and calculate a different value for each result. The IF function returns one value if 
a	specified	condition	evaluates	to	TRUE,	or	another	value	if	it	evaluates	to	FALSE.	

Syntax:
=IF(logical_test, value_if_true, [value_if_false])

Logical test: Any value or expression that is evaluated to TRUE or FALSE. 
Value if true: The value that is returned, if the logical test argument evaluates to TRUE. 
Value if false: The value that is returned, if the logical test argument evaluates 
to FALSE.

To use the IF function, select 
the cell to display the result 
and follow the steps given 
below:

1  Click on the Logical 
category in the Function 
Library group.

2  Select the IF function 
from displayed list of 
logical functions. 

     Function Arguments  
dialog box appears.

3   In the dialog box, enter 
the arguments such as:
•	Logical_test: G2>60 
•	Value_if_true: PASS
•	Value_if_false: FAIL

4  Click on the OK button.
A  Result is displayed in the 

selected cell.

NESTED IF STATEMENT 

Sometimes you need to work with situations where there are more than two 
possible results. That is where nested IF statement is generally used. For 
example, Nested IF statement can be used while calculating the grades of 
students with the following conditions or criteria:

•	 If the Project Marks > 30, Grade = A
•	 If the Project Marks > 20, Grade = B
•	 If the Project Marks < 20, Grade = FAIL

1

2

3

4

A
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To use Nested IF statement, select a cell to display the result and follow the 
steps given below:

1  Click on the Logical 
category in the Function 
Library group.

2  Select the IF function 
from the displayed list 
of Logical functions. 
Function Arguments 
dialog box appears.

3   In the dialog box,enter 
the arguments, such as:
•	 Logical_test: G2>30 
•	Value_if_true: A

4  Click in the Value_if_
false box and click in the 
Name box.

5  Function Arguments 
dialog box appears 
again for the next 
IF statement. In the 
dialog box, enter the 
arguments, such as:
•	 Logical_test: C2>20
•	Value_if_true: B
•	Value_if_ False: FAIL

6  Click on the OK button.
A  Grades are displayed 
according	to	the	specified	
criteria. You can drag the 
fill	 handle	 to	 calculate	
grade for other students.

B  The Nested IF statement 
appears in the Formula 
Bar. 

1

2

3

4

5

6

A

B
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THE SuMIF FuNCTION 
The	SUMIF	function	is	used	to	add	the	values	in	a	range	that	meets	specified	
criteria. For example, you have purchased items of different categories 
and you want to calculate the total cost of each category. For this type of 
calculation, you can use the SUMIF function.

Syntax:
=SUMIF(range, criteria, [sum range])

To use SUMIF function, select the cell to display the result and follow the 
steps given below:

1  Click on the Math & Trig category in the Function Library group.
2  Select the SUMIF function from the displayed list of functions.

    Function Arguments dialog box appears.
3  In the Range box, enter or select the cell range that contain different 

categories, from the worksheet. 
4   Enter the Criteria in the Criteria box.
5  In the Sum_range box, enter or select the cell range that is to be calculated, 

from the worksheet. 
6  Click on the OK button.
A  The sum is calculated only for items of the selected category. 

1

2

A

3
4

5

6
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THE COuNTIF FuNCTION

The COUNTIF function counts the number of cells within a range that meets 
specified	criteria.	For	example,	if	you	want	to	calculate	the	number	of	students	
present or absent on a particular date, COUNTIF function is helpful. 

Syntax:
=COUNTIF(range, criteria)

To use the COUNTIF function, select the cell to display the result, and follow 
the steps given below:

1  Click on the More Functions category in the Function Library group.
2  Point to the Statistical option and select the COUNTIF function from 

displayed list of functions. 
     Function Arguments dialog box appears. 
3  In the Range box, enter or select the cell range you want to count, from 

the worksheet.
4  Enter the criteria in the Criteria box.
5  Click on the OK button.
A  The number of cells are counted based on the criteria.

1

2

A

3
4

5
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Activity 1

Choose the correct option for the following statements.

1. The_____ function is used to count the number of characters in a text string.

a. COUNT

b. COUNTA

c. COUNTALL 

d. LEN

2.  The_____ function is used to evaluate a condition as true or false.

a. MAX

b. IF

c. SUM

d. AVERAGE

3. The_____ function counts the number of cells in a range that are not empty.

a. COUNTA

b. COUNT

c. COUNTALL

d. COUNTIF

4.	 The	_____	function	capitalizes	the	first	letter	of	each	word	and	changes	all	
other letters to lowercase. 

a. UPPER

b. PROPER

c. TOGGLE

d. LOWER

ACTIVITIES
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

MIN Function IF COUNTIF SUMIF

1. A _____ is a preset formula, that is useful to perform various mathematical, 
statistical, or logical operations. 

2. The	_____	function	is	used	to	find	the	smallest	value	in	the	selected	range	
of cells.

3. The	_____	function	adds	numbers	in	a	range	of	cells	based	on	the	specific	
criteria. 

4. The _____ function counts the number of cells within a range that meets the 
specified	criteria.

Activity 3

Practice the following tasks on your computer.
1. Create a blank Workbook. Enter the data of 5 students under the column 

headings “ID Number”, “Name”, “Midterm marks”, and “Final marks” in cell 
range from A1 to D6.

2. Enter the column heading “Total marks” in cell E1 and calculate total marks 
for each student in cell range from E2 to E6.

3. Calculate the average “Total marks” of all students in cell E8. (Hint: You can 
type the text “Average marks:” in the cell D8.)

4. Calculate the Maximum “Total marks” in cell E10 and the Minimum “Total 
marks” in cell E11.

5. Count the total number of students in cell A10. (Hint: You can use “ID 
Number” column to count.)
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In this Session, you will learn about the Formula Auditing 
Group of the Formulas Tab, Cell Referencing, Window group 
of the View Tab, and the Workbook Security in Excel 2016.

General Objectives

At the end of this Session, you should be able to understand 
and practice:

•	The Formulas Tab
•	Formula Auditing group

•	Cell Referencing

•	The View Tab
•	Window group

•	Workbook Security
•	Workbook Password

Specific Objectives

THE FORMuLAS TAB, CELL REFERENCING, THE 
VIEW TAB & WORKBOOK SECuRITy

Session
19

OBJECTIVES
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THE FORMuLAS TAB

In the previous session, you learnt about the Function Library group of the 
Formulas tab. In the following section, you will learn about the Formula Auditing 

group of the Formulas tab.

FORMuLA AuDITING GROuP

When Excel 2016 cannot properly evaluate a formula or a function, it displays an 
Error. The Formula Auditing group 
enables you to check the worksheet for 
errors and accuracy. It also enables you 
to display the actual formula in the cells 
instead of the formula result.

SHOW FORMuLAS
Formula results are shown in the worksheet cells, while the formulas are 
visible in the formula bar. The Show Formulas command is used to display 
the actual formula or function applied to a cell instead of the resulting value. 
Showing	formulas	 in	the	cells	makes	 it	easy	to	find	the	cells	 that	contain	
formulas or to check for errors.

To Show Formulas in the cells,
   1  Click on the Show Formulas command in the Formula Auditing group.

A  Formulas are displayed in the cells instead of the results.

You can use the keyboard shortcut Ctrl + ~ (grave accent key-above the Tab key) to quickly

switch between formulas view and their results.

TIP

LEARNING

1

A
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ERROR CHECKING
The Formulas and Functions can sometimes result in error values. It is a 
good practice to perform an error check once your worksheet is ready with 
calculations. The Error Checking command helps you to check for common 
errors that occur when using formulas or functions. This command shows you 
the cells containing the error, the type of error and other error information. 
Then you have the access to a number of options to check and correct these 
errors.

To check the worksheet for 
errors, follow the steps given 
below:

1  Click on the Error Checking 
command in the Formula 
Auditing group. 

A 	Excel	jumps	to	the	first	cell	
containing the error.

B  The Error Checking dialog 
box appears which displays 
error information. 

2  To edit the formula, click 
on the Edit in Formula Bar 
button in the dialog box.

3  Edit the formula with 
valid syntax, reference or 
arguments and press the 
Enter Key.

C  The formula is recalculated 
and the correct result is 
displayed in the cell.

4  Click on the Resume 
button in the dialog box 
to continue error checking 
for other cells.

The options displayed in the Error Checking dialog box are:
•	Help on this error:	Displays	information	specific	to	the	error	type.
•	Show Calculation Steps: Demonstrates all steps leading to the error.
•	Ignore Error: Allows you to accept the formula as entered.
•	Edit in Formula Bar: Allows you to edit the formula in the Formula Bar.

•	

1

2

A

B

3

4

C

The cell containing the error is marked with a small green triangle in the upper-left corner.Select the cell to get error 
information. Also the Error Checking button appears on the left side of the cell.

TIP
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COMMON ERROR TyPES IN EXCEL
While	working	with	a	worksheet,	it	becomes	essential	to	identify	and	fix	errors.
Following are some of the common Error Types in Excel 2016.

Error/
Solution

Description Example

#DIV/0!
When a number is divided either by zero (0) or by a cell that 

contains zero (0) value or no value.
=A5/0

Solution Change the cell reference or value of denominator. =A5/3

#NuLL!
When you incorrectly specify cell ranges. The areas C2:C3 and E4:E6 

do not intersect.
=SuM(C2:C3  E4:E6)

Solution
Make sure cell ranges are correctly separated. Adding a comma 

between the C and E ranges will correct it.
=SuM(C2:C3,E4:E6)

#NuM! When a formula or function contains invalid numeric values. =SQRT(-4)

Solution Check and update the formula with valid numbers. =SQRT (4)

#NAME? The Formula is unrecognized i.e. a syntax error. =SSuM(E10:E15)

Solution Use the Function Wizard or type the correct formula. =SuM(E10:E15)

#REF!
Cell reference is not valid. Cells may have been deleted like C2 that 

was referred to by formula.
=SuM(B2,#REF!,D2)

Solution

Adjust the formula so that it uses a reference that exists. Either use 

Undo (Ctrl+Z) to undo the deletion, rebuild the formula, or use a 

continuous range reference like: 

= SUM(B2:D2)

=SuM(B2,C2,D2)

#VALuE!
Formula or operator is wrong. Also one or more cells that are 

included in an arithmetic formula contain text.
=D10, D34

Solution
Type the correct operand and make sure the appropriate data is 

referenced.
=D10+ D34
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CELL REFERENCING

You	know	that	each	cell	is	identified	by	its	reference	i.e.	the	column	letter	and	row	
number (e.g., D5). Excel 2016 refers to a cell or a range of cells on a worksheet 
to locate the values that are calculated by formulas or functions. For example, 
=C2 refers to Cell C2 and returns the value of Cell C2. Similarly, =Sheet2! B2 
refers to cell B2 of Sheet2 and returns the value of Cell B2 of Sheet2. These 
references allow formulas or functions to dynamically update their results.

TyPES OF CELL REFERENCES

There are three types of Cell References in Excel 2016 i.e., Relative, Absolute 
and Mixed cell references. The type of cell reference being used is important, as 
each cell reference behaves differently when a formula or function is copied or 
filled	to	another	cell.	

RELATIVE CELL REFERENCING
In the Relative cell reference, the cell reference automatically changes when 
the formula is copied across a column or a row. It is especially convenient 
when you need to repeat 
the same calculation across 
multiple rows or columns. 
For example, after you 
calculate the total marks of 
first	 student	 using	 the	Sum	
formula,	you	copy	or	autofill	
the same formula to calculate 
the total marks for other 
students. You can observe 
that the Cell References in 
the formula of each next cell 
gets updated relative to the 
rows and columns.

ABSOLuTE CELL REFERENCING
An	Absolute	cell	reference	is	fixed	i.e.	the	cell	reference	does	not	change	when	
you copy a formula from one cell to another cell. An absolute reference is 
designated in a formula by the addition of a dollar sign ($) preceding both the 
column and the row. For example, $A$2 means that the column and the row 
do not change when a formula is copied.

For example, cell E10 contains some bonus marks to be added to the total marks 
of each student. To add the cell reference (E10) to the Sum formula, type a $ sign 
before column letter and row number of the cell i.e. $E$10.	Copy	or	autofill	the	
SUM formula for other students. Observe that the cell reference $E$10 remains 
constant in every formula and does not change as in Relative cell referencing.
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MIXED CELL REFERENCING
A Mixed cell reference has either an absolute column and a relative row, or an 
absolute row and a relative column. For example, $A1 is an absolute reference 
to column A and a relative reference to row 1. When the mixed reference is 
copied from one cell to another cell, the absolute reference stays the same 
but the relative reference changes. You can use this reference to generate a 
multiplication table. 

MuLTIPLE SHEET REFERENCING

In Excel 2016, you can create formulas to calculate data from multiple sheets. 
This is called Multiple sheet reference. For example, Sheet2 contains the marks 
scored by the students in the Mid Term exam and Sheet3 contains the marks 
scored in the Final Term exam. Now in Sheet1, you can calculate the Total Marks.

To Use Multiple Sheet Referencing, select the cell of Sheet1 where you 
want	to	display	the	total	marks	of	first	student,	type	the	Equal	to	Sign	=	and	
follow the steps given below:
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1  Select Sheet 2 from 
the Sheet Tab and in 
Sheet 2 select the cell 
that contains Mid Term 
Marks	of	first	student.	
Type the + operator.

2  Select Sheet 3 from the 
Sheet Tab and in Sheet 
3 select the cell that 
contains the Final Term 
Marks	of	first	student. 

      Press the Enter Key.
A  The	total	marks	are	calculated,	you	can	autofill	the	formula	for	other	

cells. 

 THE VIEW TAB

The View Tab contains many useful groups such as Workbook Views, Show, 
Zoom, Window and Macros. In the following section, you will learn about the 

Window group of the View Tab.

WINDOW GROuP

The commands of the Window group enable you to lock particular rows or columns 
and divide a worksheet into separate panes. It helps you to compare worksheet 
data easily. 

FREEZE PANES

The Freeze Panes	command	enables	you	to	lock	specific	rows	or	columns	in	
place to keep them visible while you are scrolling rest of the worksheet. Using 
this feature, you can freeze header rows or columns to keep them visible at all 
times. 
You	can	choose	to	freeze	just	the	top	row,	the	first	column	or	multiple	rows	
and multiple columns. You need to select a row below the row(s) that you want 
to freeze or select a column to the right of column(s) that you want to freeze.
To Freeze both row(s) & column(s), follow the steps given below:

2 A

1
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1  Select the cell to freeze all the rows above it and all the columns to the 
left of it.

2  Click on the Freeze 
Panes command.

3  Choose the Freeze 
Panes   option.

A  To freeze the top row, 
use the Freeze Top 
Row option from the 
Freeze Panes        

     command.
B  To	freeze	the	first	

column, use the 
Freeze First Column option from the Freeze 

     Panes command.

SPLIT WORKSHEET WINDOW
The Split command enables you to split the worksheet window into separate 
panes. Splitting a worksheet helps you to compare data from different parts 
of the worksheet at the same time by scrolling each part independently. You 
can split a worksheet horizontally or vertically.

To Split the worksheet Horizontally, follow the steps given below:

1  Select the row where you want to split the worksheet. 
2  Click on the Split command in the Window group.
A  The worksheet is divided into separate Horizontal panes.
B  Vertical Scroll Bars 

appear for each pane. 

To Split the worksheet 
Vertically, follow the steps 
given below:

2

1
A

B

After applying Freeze Panes, the dropdown menu of the Freeze Panes command will show the Unfreeze Panes option, 
which you can choose to Unfreeze the panes.

TIP

2
3

A

1
B
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1

2

B

A

1  Select the column 
where you want to 
split the worksheet. 

2  Click on the Split 
command in the 
Window group.

A  The worksheet is 
divided into separate 
Vertical panes.

B  Horizontal Scroll Bars 
appear for each pane.

To remove the split, click on the Split command.

WORKBOOK SECuRITy

Your workbooks can contain sensitive information like Credit Card Numbers, 
Identification	Numbers,	Employee	Information	etc.	Excel	2016	enables	you	to	

secure your work to prevent unauthorized access to your workbook. The following 
section will guide you through Excel's password protection feature.

WORKBOOK PASSWORDS

You can protect your Excel workbook with a password to prevent the unauthorized 
users from accessing it. Once you encrypt an Excel workbook with a password, no 
one else will be able to open it.

CREATING A PASSWORD
Password is the most common and recommended technique to lock an Excel 
workbook. 

To create a Workbook Password, click on the File Tab and follow the steps 
given below:

1  In the Backstage view, from the Info option, click on the Protect Workbook 
command.

2  Click on the Encrypt with Password option from the displayed list.

To split a worksheet both horizontally & vertically at the same time, select the cell which intersects both row and 
column where you want to split the worksheet and then click on the Split command.

TIP
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3  Type the password in the Encrypt Document dialog box and click on the 
OK button.

4  Re-enter the password in the Confirm	Password	dialog box.
5  Click on the OK button and save the workbook to apply the password.
A  When you open the workbook, Excel 2016 prompts you to enter the 

password for the workbook.

    
REMOVING A PASSWORD

You can also remove the password from the protected workbook.

To Remove the Password, click on the File Tab and follow the steps given below:
1  In the Backstage view, from the Info option click on the Protect 

Workbook Command.
2  Click on the Encrypt with Password option from the displayed list.
3  In the Encrypt Document dialog box, select the password and press 

the Delete key.
4  Click on the OK button and save the workbook.
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ACTIVITIES

Choose the correct option for the following statements.
1. The _____ command is used to display formulas in the cells instead of result 

values.

a. Display Formulas

b. Remove Values 

c. Show Formulas

d. Auto Sum

2. The_____ command helps you to check for errors that occur in a worksheet.

a. Name Box

b. Auto Sum

c. Remove Error

d. Error Checking

3. An absolute cell reference in a formula is recognized by the _____ sign 
preceding both the column and the row headings.

a. &

b. $

c. %

d. @

4. The _____ command is used to divide the worksheet window into separate 
panes.

a. Divide

b. Split

c. Freeze

d. Hide

Activity 1
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

FREEZE PANES PASSWORD #NULL! #VALUE! # NUM!

1. The ______ error is displayed when one or more cells that are included in an 
arithmetic formula contain text.

2. The______ error indicates that formula contains invalid numeric values. 

3. The	______command	enables	you	to	lock	specific	rows	or	columns	while	you	
scroll the worksheet.

4. You can protect your Excel workbook with a ______ to prevent others from 
accessing it.

Activity 3

Practice the following tasks on your computer.
1. Create a blank Workbook. Create the column headings “ID Number”, 

“Name”, “Total Marks” in the cell range from A1 to C1. Enter the data for 5 
students in the range from A2 to C6. Freeze the “Top Row” of the sheet. 

2. Create the column heading “Final marks” in cell D1. Enter the bonus marks 
“10” in the cell E2. Add the bonus marks to the Total Marks of each student 
and display the sum in the “Final marks” column. (Hint: You can use 
Absolute Cell Reference.)

3. Split your worksheet horizontally.

4. Protect your workbook with a password.
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Module Five

Presentation Graphics
(PowerPoint 2016)

Session 22: The Insert Tab And The Design Tab

Session 21: The Home Tab

Session 23: The Transition Tab, The Animation Tab, The 
Slide Show Tab And The View Tab

Session 20:  Overview of Presentation Graphics & Getting 
Started With Powerpoint 2016
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OVERVIEW OF PRESENTATION GRAPHICS & 
GETTING STARTED WITH POWERPOINT 2016

Session
20

In this session, you will learn about Overview of Presentation 
Graphics and Getting Started with PowerPoint 2016.

General Objectives

At the end of this session, you should be able to understand 
and Practice:

•	Overview of Presentation Graphics
•	Presentation Graphics Applications

 
•	Getting Started with PowerPoint 2016

•	Starting PowerPoint 2016
•	User Interface
•	Creating a Presentation
•	Saving and Printing a Presentation

Specific Objectives

OBJECTIVES
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OVERVIEW OF PRESENTATION GRAPHICS

For working with text documents you have used Word 2016 and Excel 2016 for 
numeric data analysis. However, Presentation Graphics applications such as 

PowerPoint 2016, allow you to present your information in an attractive manner.

PRESENTATION GRAPHICS APPLICATIONS
Presentation graphics application is designed to create and present information 
graphically in the form of slides. This application integrates text, images, audio, 
video, animations and sound effects that makes up a presentation. The information 
is arranged in slides, which can be set to appear as frames with a mouse click or 
automatically	after	specified	time.

FEATURES OF PRESENTATION GRAPHICS APPLICATIONS
A Presentation Graphics application has the following key features:

•	Slide: A slide is a single page of a presentation, created with the Presentation 
Graphics application.

•	Placeholders: These are dotted boxes in a slide, which are used to add Text, 
Pictures, Charts, Tables and other objects.

•	Objects: These are elements of a slide such as Text boxes, Pictures, Tables, 
Charts, SmartArts, etc. 

• Animations: These are a set of visual effects that can be applied to objects, 
so that it will animate during the Slide Show.

•	Transitions: These are visual effects applied to the slides, when moving from 
one slide to another.

POPULAR PRESENTATION GRAPHICS APPLICATIONS
There are a varieties of Presentation Graphics applications available in the 
market that have different features. Following are some of the popular 
applications:

•	Microsoft	PowerPoint	2016
•	Apple	Keynote
•	Corel	Presentations

LEARNING



319

OVERVIEW OF PRESENTATION GRAPHICS & GETTING STARTED WITH POWERPOINT 2016
S

e
ssio

n
 2

0
 

GETTING STARTED WITH POWERPOINT 2016  
PowerPoint 2016 is one of the most widely used Presentation Graphics application. It 
enables you to create professional presentations containing animations, narrations, 
images, videos, audios, etc., in your presentation.

STARTING POWERPOINT 2016

To start PowerPoint 2016 in Windows 10, follow the steps given below:

 Click Start button to open the 
start Menu.

 Click on PowerPoint 2016 from 
the All Apps list.

The Start Screen of PowerPoint 2016 
appears	with	a	 list	 of	 recently	used	files	
and available templates. You can either 
open an existing presentation, start with 
a new blank presentation, or choose a 
template. You can also press the Esc key 
to start with a new blank presentation.

THE USER INTERFACE
Exploring and understanding the User Interface of PowerPoint 2016 will help you 
work	efficiently	 in	 the	 later	 sessions.	 The	User	 Interface	of	 the	PowerPoint	 2016	
consists of the following elements.

 Slide Thumbnails Pane: It appears on the left side of the PowerPoint 2016 
window. In the Slide Thumbnails pane, you can rearrange, delete, hide, 
duplicate and add new slides in the presentation. 

 Slide Area: It is the actual slide where you can add objects such as Text, 
Pictures, Tables, Charts, Videos, etc.

 Notes Pane: It is located below the Slide Area, which enables you to add 
notes for each slide. These notes are also known as Speaker Notes that 
the presenter can refer to while delivering the presentation.

 Status Bar: It is a strip at the bottom that displays active slide number 
and contains the zoom buttons and the View buttons.

 View Buttons: These are used to switch between the views of the 
presentation i.e., Normal, Slide Sorter, Reading and Slide Show view.

1
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A

B

C
D E F

G

H

 Next Slide: This button enables you to move to the next slide in the presentation.
 Previous Slide: This button enables you to move to the previous slide in 

the presentation.
 Fit Slide to Current Window: This	button	enables	you	to	fit	the	current	

slide to the Slide Area.

RESIZING PANES
There are two Panes in the PowerPoint 2016 user interface, namely the 
Thumbnails Pane and the Notes Pane. The 
Notes Pane can be increased if there are 
more notes to be mentioned in that area. 
The size of the Slide Thumbnails Pane 
can be customized for the desired visual 
appearance of the miniature slides.

To Resize the Panes, follow the steps given 
below:

 Move the Mouse pointer over the edge of 
the Thumbnails Pane, the cursor becomes 
a two headed arrow. Click and drag to 
increase or decrease the pane area.

 Move the Mouse pointer over the edge 
of the Notes Pane, the cursor becomes 
a two headed arrow. Click and drag to 
increase or decrease the pane area.

F

G

H
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MOVING AND RESIZING THE PLACEHOLDERS
Placeholders are used to identify different objects in a slide such as Pictures, 
Charts, Tables or even Text. 

To Move a Placeholder,
 Move the mouse pointer 

over the placeholder 
border, it gets converted to 
a four-headed arrow. Drag 
to move the Placeholder as 
desired.

To Resize a Placeholder, 
 Select the Placeholder and 

place the mouse pointer 
over a sizing handle, it gets 
converted to a two-headed 
arrow. Drag to resize the 
Placeholder as desired.

CREATING A SIMPLE PRESENTATION
You can now start creating a new Presentation in PowerPoint 2016. The following 
section guides you through creating a new presentation, adding, moving, duplicating, 
and deleting slides.

CREATING A NEW PRESENTATION
You can create a new Blank Presentation when you start the PowerPoint 
2016 application or from an open PowerPoint 2016 window. 

To create a blank Presentation 
from an open PowerPoint 2016 
window, follow the steps given 
below:

 Open the File tab 
Backstage view and click 
on the New option.

 Click on the Blank 
Presentation in the 
Backstage view.

1

2

1

2

1

2

2
1

You can also choose from the various Predesigned templates present in the Backstage view to create a new 

presentation. 

TIP
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MANAGING SLIDES FROM SLIDE THUMBNAILS PANE 
The Slide Thumbnails pane allows you to quickly 
organize, add or delete slides of your presentation. 

To add a new slide, follow the steps given below:
 Right click on a Slide in the Thumbnails pane.
 Click on the New Slide option from the 

shortcuts menu.

To duplicate a slide, 
 Choose the Duplicate Slide option from the 

shortcuts menu.

To delete a slide, 
 Choose the Delete 

Slide option from the 
shortcuts menu.

SELECTING MULTIPLE SLIDES  
Procedures to select multiple slides is quite similar to selecting multiple objects 
in	other	Office	applications	i.e.,	with	CTRL	and	SHIFT	Keys.

•	 To	select	consecutive slides, click the first slide, hold down the SHIFT 
key and then click the last slide in sequence.

•	 To	select	non-consecutive slides, hold down the	CTRL	key and select the 
required slides. 

MOVING SLIDES USING DRAG & DROP

In the Slide Thumbnails Pane, you can move 
the slides or rearrange the slides as required by 
drag and drop with mouse.

To move a slide using the Slide Thumbnails Pane,
 Select the slide(s) and Drag & Drop it to the 

desired place.
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Keyboard Shortcuts:

New slide - CTRL + M

Duplicate Slide - CTRL + D

TIPS
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SAVING AND PRINTING A PRESENTATION
After creating a new Presentation, you need to know how to save it in order to 
access or edit. PowerPoint 2016 allows you to save your presentation in several ways 
and formats. You can also print it to view and share your presentation on hardcopies.

SAVING A PRESENTATION
Saving	a	presentation	in	PowerPoint	2016	is	similar	to	saving	a	file	in	other	Office	
applications.

To save a new presentation from the File Tab, follow the steps given below:
 Click on the Save 

command from the 
File tab Backstage 
view. 

 Click on the Browse 
option.

 Select the 
destination folder 
from the Save As 
dialog box.

 Enter the name in 
the File name box.

 Click the Save button. 

By default the presentation is saved with .pptx extension.

SAVE AS OPTION
By using the Save As 
command from the File 
tab, the Presentation 
can be saved in different 
formats like PowerPoint 
Template, PowerPoint 
Show, MPEG-4 video 
format, JPEG format 
and other formats.

To use Save As command, 
follow the steps given 
below:

 Click on the Save As 
command from the 
File tab Backstage 
view.
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 Choose	the	desired	file	location	by	using	the	Browse button.
 Click on Save as type drop down button.
 Select	the	desired	file	type	and	click	on	the	Save button.

PRINTING A PRESENTATION
It is easy to preview and print the slides, speaker notes, slide outline or handouts 
of the presentation.
The Handout is used by the audience to follow along the slide show or keep for 
future reference. You can print handouts of your presentation, with one, two, 
three, four, six, or nine miniature slides on a single page.  

To print the handouts of your presentation, 
follow the steps given below:

 Click the Print command from the 
File tab Backstage view.

 Click on the arrow button of the 
Full Page Slides option under the 
Settings. 

 Select the desired Handouts option.
 Click on the Print button.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. _____ is a dotted box which is used to add objects in a slide.

 a. Slide

 b. Placeholder

 c. Speaker Note

 d. Note Pane

2. The keyboard shortcut to insert a new slide is_______.

 a. Ctrl + M

 b. Ctrl + N

 c. Ctrl + S

 d. Ctrl + D

3. A PowerPoint presentation is saved with the extension _____.

 a. .potx

 b. .pptm

 c. .ppsx

 d. .pptx

4. The keyboard shortcut to duplicate the selected slide is_______.

 a. Ctrl + M

 b. Ctrl + C

 c. Ctrl + D

	 d.	Ctrl	+	K
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Slide Area Duplicate Slide Status bar Notes Slide Thumbnails

1. The ______ is a strip at the bottom of PowerPoint interface that displays the 
active slide number.

2. The _______ is the actual place where you add and edit objects.

3. _______ option is used to insert a new slide with the contents as well as the 
design of an existing slide.

4. The _______ pane appears on the left side of the PowerPoint window.

Activity 3

Practice the following tasks on your computer.
1.	Create	a	new	blank	presentation	and	add	4	slides.	Type	the	text	“King	Saud	

University” in slide 3 and save the presentation with the name “Practice”. 
(Hint: You can save this presentation to the "Documents" folder on your 
computer.)

2. Move the slide 3 to above the slide 2.

3. Delete the slides 4 and 5 from the presentation.

4. Create a new presentation using the template “Welcome to PowerPoint” and 
duplicate the slide 4.
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THE HOME TABSession
21

In this session, you will learn about the Slides, Font, 
Paragraph, Drawing and Editing groups of the Home tab.

General Objectives

At the end of this session, you should be able to understand 
and Practice:

•	 The Home Tab
•	Slides Group
•	Font Group
•	Paragraph Group
•	Drawing Group
•	Editing Group

Specific Objectives

OBJECTIVES
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THE HOME TAB

The Home tab contains the most commonly used commands for editing and 
formatting slides. These commands are divided into six groups which are as 

follows:

    Clipboard Group
    Slides Group
    Font Group
    Paragraph Group
    Drawing Group
    Editing Group

SLIDES GROUP
The commands in this group enable you to add new slides, change the slide layout, 
reset slides, and to add new sections in the Presentation.

INSERTING A NEW SLIDE
When you insert a new slide from the slide 
thumbnails pane, the new slide is inserted with 
the default slide layout. Using the arrow of New 
Slide command, you can insert a new slide with 
the desired layout after the active slide.

To insert a new slide, follow the steps given below:
1   Click on the arrow of the New Slide 

command from the Slides group.

2   Choose the desired Slide layout for the new 
slide. 
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LEARNING
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CHANGING SLIDE LAYOUT
A slide layout contains pre- 
formatted placeholders for text, 
pictures, charts,videos, and 
more.
The layout of an existing slide 
can be changed by using the 
Layout	command of the Slides 
group.

To change the layout of a slide, 
follow the steps given below: 

 Click the slide for which 
you want to change the 
Layout.

 Click on the Layout 
command from the Slides 
group.

 Choose the desired slide 
layout from the layout 
gallery.

RESET SLIDE
The Reset command is used to reset the position, size and formatting of the 
placeholders in a slide to its default settings. This enables you to restore a 
slide to its default layout after you have made changes to it. 

To Reset a slide, follow the step given below:

        Click on the Reset command from the Slides group.
A  The moved and resized placeholder before the Reset command.
B  The placeholder has reverted to its default settings.
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ORGANIZING SLIDES INTO SECTIONS
You can group several slides and create meaningful sections in a presentation.
The Section command allows you to create, rename, or merge all sections in 
a presentation. 

To create a section, follow the steps given below:

1  Click on the slide where you want to create a section.
2  Click on the Section command in the Slides group.
3  Select Add Section option from the drop down list.

To rename the section, follow the steps given below:

4  Click on the section name Untitled Section.
5  Click on the Rename Section option from the drop-down list of the Section 

command.
6  Enter the suitable section name in the Rename Section dialog box that 

appears.
7  Click on the Rename button.
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To remove all sections, follow the 
steps given below:

1   Click on the Section command 
from the Slides group.

2  Select the Remove All Sections 
options from the drop down 
list.

FONT GROUP
The commands in the Font group of the Home tab enable you to modify and enhance 
the appearance of text. You can change the Font, Font Color, Font Size, Font Effects 
and more from this group.

APPLYING FONT, FONT SIZE, FONT COLOR

The procedures to change font, font size, and font color is same as what you 
have learned in Word 2016 or Excel 2016. 
To change the Font of the selected text, 

1  Click on the arrow of the Font 
command and choose the 
desired Font.

To change the Font size of the 
selected text, 

2  Click on the arrow of the Font 
Size command and select the 
desired Font Size.

To change the Font color of the 
selected text,

3  Click on the arrow of the Font 
Color command and select the 
required color from the color 
palette.

1
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1
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INCREASE OR DECREASE FONT SIZE  
Font size can also be increased or decreased quickly by using the Increase
Font Size and Decrease Font Size commands in the Font group.

A  Use the Increase Font Size 
command to increase the font size.

B  Use the Decrease Font Size 
command to decrease the font size.

APPLYING BOLD, ITALIC, UNDERLINE AND STRIKETHROUGH EFFECTS 
You can use the Bold, Italic, Underline or Strikethrough commands to emphasize 
the text.

     Use the [ B ] button to make the text  
         thicker.

B  Use the [ I ] button to make the text 
slant to the right.

C  Use the [ U ] button to Underline the 
text.

D  Use the [ abc ] button to apply the 
text effect Strikethrough.

A

A B

A B C D
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SHADOW EFFECT AND CHARACTER SPACING  
The Shadow command is used to add a 
shadow behind the selected text to emphasize 
it. Whereas the Character Spacing command 
allows you to adjust the spacing between the 
characters of the selected text. 

To apply the shadow effect to the selected text,
1  Click on the [ S ] button from the Font 

group.
To change the character spacing of the 
selected text,

2  Click on the Character Spacing command 
and choose the desired character spacing 
option

CHANGE CASE AND CLEAR FORMATTING
The Change Case command enables you to change the text to upper, lower and 
other capitalizations. While the Clear All Formatting command enables you to 
remove all applied formatting from the text.

To use the Change Case command for the 
selected text, follow the steps given below:

1  Click on the Change Case command from  
the Font group.

2  Choose the desired case from the drop    
down list.

To clear all formatting from the selected text,
3  Click on the Clear All Formatting command 

from the Font group.
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PARAGRAPH GROUP
The Paragraph group of the Home tab contains the commands to set the alignment, 
text direction, and line spacing of the paragraphs. It also has the commands for 
creating a bulleted or numbered list.

HORIZONTAL TEXT ALIGNMENT
The	Left,	Right,	Center	and	Justify	commands	allow	you	to	align	text	horizontally	
relative to the left and right margins of a text box.

 A  Align	Left: This command is used 
to align the text to the left of the 
text box.

 B  Center: This command is used to 
align the text to the center of the 
text box.

       Align Right: This command is 
used to align the text to the right of the text box.

 D  Justify: This command is used to distribute the text evenly between the 
margins of the text box.

VERTICAL TEXT ALIGNMENT
The Align Text command is used to align the text vertically relative to the top 
and bottom margins of the text box. You can align the text vertically at the top, 
middle or at the bottom of the text box.

To align the text vertically in the selected text box, 
follow the steps given below:

1  Click on the Align Text command from the 
Paragraph group.

2  Choose the desired alignment option from the 
dropdown list.

C
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CREATING A BULLETED OR NUMBERED LIST
While creating a presentation, it is recommended to use 
key points of the information instead of using lengthy 
paragraphs. The key points can be emphasized by creating 
bulleted or numbered lists.

To create a bulleted list for the selected text, follow the 
steps given below:

1  Click on the arrow of the Bullets command from the 
Paragraph group.

2  Select the desired Bullet style from the drop down list.

To create a numbered list for the selected text, follow the 
steps given below:

1  Click on the arrow of the Numbering command from 
the Paragraph group.

2  Select the desired Numbering style from the drop 
down list. 

INCREASE/DECREASE LIST LEVEL 
You can create multilevel bulleted or numbered lists 
using	the	Increase	List	Level	or	Decrease	List	Level	
commands of the Paragraph group.

To increase list level of the selected text,
1  Click on the Increase	List	Level command from 

the Paragraph group.

To decrease list level of the selected text,
2  Click on the Decrease	List	Level command from the Paragraph group.

TEXT DIRECTION 
The Text direction in a text box can be set in different ways, 
such as rotate 900, rotate 2700, or stacked.

To change the text direction of the selected text, follow the 
steps given below:

     Click on the Text Direction command from the Paragraph 
group.

      Choose the desired text direction from the drop down list.
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DRAWING GROUP
The commands in the Drawing group of the Home tab enable you to draw shapes, 
insert images, and enhance objects in the slide. In this section, you will learn about 
the Shapes Gallery, Quick Styles, and Shapes formatting.

INSERTING SHAPES
The Shapes gallery in the Drawing group enables you to insert a variety of 
shapes in your presentation. 

To insert a Shape, follow the steps given below:

1  Click More arrow of the Shapes gallery from 
the Drawing group.

2  Select the desired shape. The mouse pointer 
changes to a plus ( + ) sign. Click on the slide 
to insert the shape with the default size. 

 A  Top (or Bottom) handle: It is used to increase 
or decrease the height of the shape.

 B  Left	(or	Right)	handle: It is used to increase 
or decrease the width of the shape. 

 C  Rotating handle: It is used to rotate the shape.

2

1

C

A

B

When you insert a shape, a new contextual Format tab appears. You may use the various options available to 
enhance the appearance of the shape. 

TIP
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USING QUICK STYLES 

The Quick Styles command enables you to apply theme styles to shapes, 
placeholders and text boxes, whereas the Shape Fill command allows you to 
change the background of the shape. 

To apply the Quick Styles, follow the steps given below:

1  Select the shape and click on the Quick Styles command from the Drawing 
group.

2  Select the desired style from styles gallery.

To change the background of the selected shape, follow the steps given below:

3  Click on the Shape Fill command from the Drawing group.
4  Choose the Texture option from the drop down list.
5  Select the desired texture style from the list.

3
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APPLYING SHAPE OUTLINE AND SHAPE EFFECTS 
The Shape Outline command allows you to add an outline to a shape with 
different line weight and colors. The Shape Effect command allows you to apply 
visual	effects	to	a	shape	such	as	shadow,	reflection,	3D	rotation.	

To apply the Shape Outline to the selected shape, follow the steps given below:
1  Click on the Shape Outline command from the Drawing group.
2  Select the desired outline color for the shape from the palette.
3  Point to the Weight option and choose the desired weight point from the list.
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To apply the Shape Effects to the selected shape, follow the steps given below:
4  Click on the Shape Effects command from the Drawing group.
5  Point to a Shape Effect option and choose the desired Effect from the list. 

EDITING GROUP
The	commands	in	the	Editing	group	of	the	Home	tab	help	you	to	find	and	replace	text. 
It further allows you to hide or show objects in the presentation.

FIND AND REPLACE TEXT 
The Replace command helps you to replace a particular text or phrase with 
another text or phrase.
 
To	 find	 and	 replace	 the	 text	 throughout	 the	 presentation,	 follow	 the	 steps	
given below: 

1  Click on the Replace 
command from the 
Editing group.

A  The Replace dialog box 
appears. 

2  Enter the text in the 
Find what: box.

3  Enter the text in the Replace with: box with what you want to replace the 
searched text with.

4  Click on the Find Next button to search and locate the text. 
5  Click on the Replace All button.
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SELECTING OBJECTS 
The Select command is especially useful to select 
objects that are behind text or other objects in the 
slide.You can select all or particular objects in a slide. 

To select all objects in a slide, follow the steps 
given below: 

1  Click anywhere in the Slide Area and click on 
the Select command from the Editing group.

2  Click on the Select All option from the list.

To select multiple objects, keep the Ctrl key pressed and click on objects from the selection pane.

TIP

USING THE SELECTION PANE
PowerPoint 2016 allows you to temporarily hide certain objects in a slide, 
enabling you to work on other overlapping objects. You can even select 
objects using the selection pane.

To hide the objects, follow the steps given below:

1   Click on the Select command 
from the Editing group.

2  Click on the Selection Pane 
option from the list.

3  Click on the hide/show 
button.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. You can change the layout of an existing slide by using the _____ command.

a. New slide

b. Layout

c. Reset

d. New	Layout

2. The _______ command is used to change the spaces between the characters.

a. Text Spacing

b. Text Shadow

c. Clear Spacing

d. Character Spacing

3. The _______ command is used to align the text vertically in a textbox. 

a. Text Direction

b. Justify	

c. Align Text

d. Align	Left

4. The ______ pane is used to temporarily hide the objects in a slide.

a. Slide

b. Thumbnails

c. Selection

d. Hide
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Section Quick Styles New Slide Formatting Slide Layout

1. The _______command is used to insert a slide after the active slide.

2. The ________ command is used to organize the slides into meaningful 
groups.

3. You can use the Clear All Formatting command to remove all ________ from 
the text.

4. The _______ command is used to apply various styles to selected shapes, 
placeholders and text boxes.

Activity 3

Practice the following tasks on your computer.
1. Create a presentation with 5 slides. Change the layout of slide 3 to “Title 
Only”	and	add	the	title	“King	Saud	University”.	

2. Enter the text “Welcome” as the title to the slide 1 and apply the text effect 
“Text	Shadow”	and	character	spacing	“Loose”.

3. Enter the random sample paragraph as a subtitle by typing the “=rand()” 
function in slide 2. Change the alignment of the paragraph to “justify”.

4. Insert the shape “sun” in the center position of the slide 4 and Change the 
Shape Fill color to “orange”.
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THE INSERT TAB AND THE DESIGN TABSession
22

In	this	session,	you	will	learn	about	Tables,	Links,	Text,	
Media groups of the Insert Tab and Themes, Customize 
groups of the Design Tab.

General Objectives

At the end of this session, you should be able to understand 
and Practice:

•	The Insert Tab
•	Tables Group
•	Links	Group
•	Text Group
•	Media Group

•	The Design Tab
•	Themes Group
•	Customize Group

Specific Objectives

OBJECTIVES
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 THE INSERT TAB

The Insert tab contains the commands that enable you to insert hyperlinks, tables, 
pictures, shapes, audio, and video, etc. It also enables you to add the screen 

recording to your presentation. In this section, you will learn about the following 
groups:

A B C D E

     Tables Group
 Images Group
	 Links Group
 Text Group
 Media Group

TABLES GROUP
The Tables group has only the Table command which you can use to insert a table 
in your slides.

INSERTING A TABLE
The Table command enables you to insert a table either 
by specifying or selecting the number of rows and columns 
in a slide.

To insert a Table, follow the steps given below: 

 Click on the Table command from the Tables 
group. 

     Select the number of rows and columns by moving 
the mouse pointer over the table grid.

 The Insert Table option enables you to manually 
specify the number of rows and columns in the 
table.
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LINKS GROUP

The	commands	in	the	Links	group	of	the	Insert	tab	enable	you	to	
create links and assign actions to the objects or text in a slide.

INSERTING HYPERLINK
Sometimes the presentations include URLs of websites that provide additional 
information related to the topic. The Hyperlink command allows you to create 
links	to	the	websites,	other	files,	or	other	slides	in	the	same	presentation.	When	
you run a slide show, the links can be directly accessed from the presentation.

To insert a hyperlink to a text, follow 
the steps given below:

            Select the text to which you 
want to insert a Hyperlink.

 Click on the Hyperlink command 
from the Links group.

 In the Insert Hyperlink dialog 
box,	 enter	 the	 URL	 in	 the	
Address box.

 Click the OK button.

ASSIGNING ACTIONS
The Action command is used to add action to an object, when you click on it 
or mouse over it. The action could be jump to another slide, playing a sound, 
or opening another program while running the slide show.

To assign an action to a selected object, follow the 
steps given below:

 Click on the Action command from the Links 
group. 

      Click on the Mouse Click tab from the Action 
Settings dialog box. 

 Select the Hyperlink to: option.
 Select the desired hyperlink method from the 

drop down list.
 Enable the play sound option.
 Click on the OK	button.
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 TEXT GROUP

The commands in the Text group of the Insert tab enable 
you to insert Text Box, Header & Footer, etc. to the slides.

INSERTING TEXT BOX
In PowerPoint 2016, you need text placeholder or text box  to enter text in 
slides. The Text Box command enables you to add text box anywhere in a slide.

To add a Text Box to a slide, follow 
the steps given below:  

     Click on the Text Box 
command from the Text 
group. 

 Click and drag to draw a text 
box of desired size in the 
slide.

INSERTING HEADER & FOOTER
Header or Footer are standard text that might include the company name, 
copyright symbol, date and time, etc. Normally, only Footer is inserted to the 
slides. However, both Headers and Footers can be added to your Handouts 
and Notes Page slides.  

To Insert Footer to a slide, follow the steps given below:
 Click on the Header & Footer command from the Text group.
 Click the Footer check box.
      Enter the desired text in 

the Footer box.
 The Date & Time check box 

inserts date and time in 
the footer.

 The Update automatically 
option updates the date & 
time when you open the 
presentation.

 The Slide number check 
box inserts slide numbers 
in the Footer.

 The Don't show on title slide check box allows you to skip the Footer 
on the title slide.     

     Click on Apply to All button if footer is required on all the slides.
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MEDIA GROUP

The commands in the Media group of the Insert tab enable you 
to	insert	video	and	audio	files	in	the	presentation.	Adding	videos	
and audios in a presentation help you to deliver the information 
easily	and	efficiently.

INSERTING VIDEO
Inserting a video to the presentation enables the presenter to show relevant 
and important information in a movie format. The Video command enables you 
to insert online videos or videos stored on your PC to the presentation.

To insert a Video from your PC, 
follow the steps given below:

 Click on the Video command 
from the Media group. 

 Click on Video on My PC option 
from the drop down list.  

     In the Insert Video dialog box, 
browse and select the video 
you want to insert to the 
presentation.

 Click on the Insert button.

TRIMMING VIDEO
You can use the Trim Video command to remove the unwanted parts of a video 
clip. The Trim Video command helps you to reduce the duration of the inserted 
video by specifying the start and the end time.

To trim a video inserted in the presentation, follow the steps given below:
    In the contextual Playback tab, click on the Trim Video command from 

the Editing group. Trim Video 
dialog box appears.

 Click and drag the green slider 
present at the beginning of the 
bar to set the new start point of 
the video.

 Click and drag the red slider 
present at the end of the bar 
to set the new end point of the 
video.

  Click on OK button.
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INSERTING AUDIO
Inserting	an	Audio	file	in	a	presentation	enhances	the	delivery	of	presentation.	
Unlike	 video	 files,	 audio	 files	 are	 smaller	 in	 size	 and	makes	 the	 sharing	 of	
presentation	 faster.	 The	 Audio	 command	 allows	 you	 to	 insert	 an	 audio	 file	
available on your PC or to record a new audio. 

To	Insert	an	Audio	file	from	your	PC,	follow	the	steps	given	below:	
 Click on the Audio command 

from the Media group.
 Choose the Audio on My PC 

option from the drop down 
list.

 In the Insert Audio dialog 
box, browse and select the 
audio	file	you	want	to	insert	
into the presentation.

 Click on the Insert button.

SCREEN RECORDING
Screen Recording command enables you to record the activities on the screen 
along with the Audio. The screen recording can be inserted as a video to any 
slide and can be viewed during the slide show.

To insert a screen recording in the slide, follow the steps given below:
        Click on the Screen Recording command from the Media group.

 In the Screen Recording Toolbar, click on the Select Area button to set the 
screen area for recording.

 By default, the Audio option is enabled for the recording.
 By default, Record pointer option is also enabled for the recording.
 Click on the Record button to start screen recording.

To stop recording, press Windows + Shift + Q keys.
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THE DESIGN TAB
The Design Tab commands allow you to control the look and the appearance of your 
presentation. You can apply a theme from the available themes and can also change 
the color schemes.

    Themes group
    Variants group
    Customize group

THEMES GROUP

Themes are used to simplify the process of creating professional presentations. 
Applying a new theme changes the look of your presentation such as the colors, 
font styles, effects, layouts and background of your slides. If you want to customize 
your presentation further, you can change the theme colors, theme fonts, or 
theme effects.

APPLYING THEMES
The Themes gallery contains a variety of themes having built in font colors, 
font effects, layouts and backgrounds. 

To apply a Theme to the slides, follow the 
steps given below:

      Click on the More Themes down arrow 
button of the Themes gallery.

 Select the desired Theme from the 
drop down themes gallery.
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APPLYING THEME VARIANTS
Variants gallery enables you to change the color combination, fonts styles, 
effects and background styles of the theme that you have selected.

To apply a Theme Variant to the slides, follow the steps given below:
 Click on the More Variants down arrow button of the Variants gallery.
 Point to the Colors option from the drop down list.
 Select the desired color combination from the displayed list.

CUSTOMIZE GROUP
The Customize group of the Design tab contains the commands to change the slide 
size and formatting the slide background.

CHANGING THE SLIDE SIZE
Changing the slide size is important depending on the way the presentation 
is viewed. The slide size can be set to Standard (4:3), Widescreen (16:9), A4 
Paper, Overhead, Banner, etc. 

To Change the Slide Size, follow the steps given below:
 Click on the Slide Size command from the Customize group.
 Click on the Customize Slide Size option from the dropdown list.
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 Select the suitable 
slide size from the 
Slides sized for drop 
down list.

 Select the Orientation 
for the slide from the 
options.

 Select the Orientation 
for notes, handouts & 
outline view slides.

 Click the OK to apply 
the changes.

 
FORMATTING SLIDE BACKGROUND
The	Format	Background	command	enables	you	to	fill	the	slide	background	with	
a Color, Picture, Texture or Pattern. 

To change the slide background, follow the steps given below:
 Click on the Format 

Background command 
from the Customize 
group. The Format 
Background pane 
appears in the right.

 Click on the Solid	 fill	
option.

 Click on the Fill Color 
button to choose the 
desired color.

 Choose the Gradient 
fill option to select the 
gradient color and design.

 Choose the Picture or	texture	fill	option to insert a Picture as the slide 
background.

 Click on Pattern	fill option to insert different pattern styles as the slide 
background.
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. The _______ command is used to jump to another slide, or opening another 

program during a slideshow.

a. Comment 

b. Table

c. Action

d. SmartArt

2. The _______ command is used to remove the unwanted parts of a video clip.

a. Video Effects

b. Corrections

c. Trim Video

d. Hide Video

3.	 Keyboard	shortcut	to	stop	the	recording	of	screen	activities	is	_____.	

a. Ctrl + Shift + Q

b. Windows + Shift + Q

c. Windows + Shift + R

d. Windows + Ctrl + Q

4. The ________ command enables you to apply a different background color 

to slides. 

a. Slide Color

b. Format Slide

c. Format Background

d. Slide Fill
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Insert Video Screen Recording Theme Hyperlink Insert Table
1. The _____ option enables you to manually specify the number of rows and    

columns in the table.

2. The _____ command is used to access websites directly from the 
presentation.

3. The _____ command changes the look of your presentation such as the 
colors, font styles, effects, layouts and background.

4. You can use the _______ command to record your computer screen along 
with the related audio.

Activity 3

Practice the following tasks on your computer.
1. Create a new blank presentation with 5 slides. Type the text “Class 

schedule” in slide 1 and hyperlink this text to slide 3. 

2. Enter your weekly class schedule details using the Table command in slide 3 
and apply the table style “Themed style 1-Accent 5”.

3. Change the presentation theme to “Facet”. 

4.	 Enter	the	text	“King	Saud	University”	as	footer	and	apply	it	to	all	the	slides	
in the presentation.
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THE TRANSITIONS TAB, THE ANIMATIONS TAB, 
THE SLIDE SHOW TAB AND THE VIEW TAB

Session
23

In this session, you will learn about the Transitions, 
Animations, Slide Show and View Tabs of PowerPoint 
2016.

General Objectives

At the end of this session, you should be able to understand 
and Practice:

•	The Transitions Tab
•	Transition to This Slide Group
•	Timing Group

•	The Animations Tab
•	Animation Group
•	Advanced Animation Group
•	Timing Group

•	The Slide Show Tab
•	Start  Slide Show Group
•	Set Up Group

•	The View Tab
•	Presentation Views Group
•	Master Views Group

Specific Objectives

OBJECTIVES
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THE TRANSITIONS TAB

Slide transitions are a classic element in PowerPoint that goes way back to its 
earliest versions. Slide transitions are the animation-like effects that occur when 

you move from one slide to the next during a presentation. You can control the 
speed, add sound, and customize the properties of transition effects.

 TRANSITION TO THIS SLIDE GROUP
This group consisits of a Transition gallery that contains built-in transition effects. 
Each	transition	has	different	options	to	make	the	transition	more	flashy	and	eye	
catching.

 APPLYING TRANSITIONS 
Transition enhance the moving between the slides during a presentation. You 
can easily apply the same transition to all the slides including its effect options.

To apply the Transition, follow the steps given below:
     Click on the More                       arrow of Transition gallery.
                    Select the desired transition from the displayed gallery.

To preview the applied transition,
 Click on the 

Preview command 
from the Preview 
group.
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EFFECT OPTIONS
The Effect Options command enables you to change the  properties of the 
applied transition. You can change the way the transition occurs – for example, 
the entrance direction of the slide.

To change the Effect Option for 
the selected transition, follow 
the steps given below:

 Click on the Effect Options 
command.

 Choose the desired effect 
from the list that appears. 

TIMING GROUP
Timing group of the Tranistion tab contains the commands that enable you to specify 
the duration of the transition and transition sounds and to control the slide entrance. 

 
DURATION AND SOUND EFFECTS  

You can set the time duration to specify how fast the transition should occur. 
For example, to make the transition go slower, you can set a higher time 
duration.

To set the time duration of the applied transition, 
 Increase or decrease the time duration using the buttons of the Duration 

box from the Timing group.

To apply a Sound effect to the applied transition,

 Select a suitable sound effect by clicking on the Sound box from the 
Timing group.

 The Apply to All button applies the transition settings to all the slides in 
the presentation.
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ADVANCE SLIDE
You can specify whether to move to the next slide on mouse click or automatically 
after	a	specified	time.

To change the Advance Slide settings, follow the steps given below: 
     Select the On Mouse Click check box to move 

to the next slide on mouse click.
 Select the After check box and specify the slide 

advance time using the buttons.

THE ANIMATIONS TAB

Animation refers to the special visual or sound effects that are applied to the 
objects of the slides. It is a great way to focus on important points, to control 

the	flow	of	 information,	and	to	increase	viewer	interest	 in	your	presentation.	An	
Animations tab is almost the mirror image of the Transitions tab. However, it 
contains the effects for objects instead of slides. 

ANIMATION GROUP

The Animation group contains four categories of animation effects such as 
Entrance, Emphasis, Exit, and Motion Paths. Each category contains different 
animation effects that can be applied to the objects on the slides.

1
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APPLYING ANIMATION EFFECTS
The Animation gallery provides you a lot of exciting animation effects for the 
text, pictures, shapes, and other objects in your presentation. You can also set an 
animation effect of the bullet points so that they appear one by one or at once.

To apply an Animation to the selected object, follow the steps given below:
     Click on the More arrow of the Animation gallery.
     Select the desired Animation effect from the displayed gallery.

To change the Effect option of the selected object, follow the steps given below:
 Click on the Effect Options command.
 Select the desired option from the drop down list.

To preview the applied animation effect,
 Click on the Preview command from the Preview group.

ADVANCED ANIMATION GROUP
The Advanced Animation group has the commands 
that allows you to add more animations to an 
object and to show the Animation pane where you 
can view or edit the animations. 
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ADDING MORE ANIMATIONS
You can add multiple animations to an object which occurs as per the desired 
order. The Add Animation command in the Advanced Animation group enables 
you to add a new animation after an existing one.

To add more animations to the selected object, 
follow the steps given below:

 Click on the Add Animation command from 
the Advanced Animation group.

 Choose the desired Animation from the 
displayed gallery.

ANIMATION PANE
Animation Pane helps you to view and edit the applied animations of the objects. 
You can re-order or remove the applied animations using the Animation Pane.

To show the Animation Pane,
 Click on the Animation Pane command from the Advanced Animation group.
 Animation Pane appears to the right of the screen.

To remove an Animation, follow the steps given below:
 Click on the arrow 

button of a Content 
Placeholder in the 
Animation pane.

 Click on the Remove 
option from the drop 
down list.
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TIMING GROUP
The commands of the Timing group allow you to choose the order, delay and 
duration of the applied animations.

START AND REORDER ANIMATION
The Start command in the Animation group enables you to choose whether to 
start an animation After Previous animation, On Click, or With Previous 
animation.

To set the Start of an Animation of the selected object, follow the steps given 
below:

 Click on the box of the Start command from the Timing group.
 Choose the desired option from the drop down list.

To reorder an Animation,
 Click on Move Earlier or Move	Later command from the Timing group.

THE SLIDE SHOW TAB

The Slide Show tab commands help you to control the way your presentation is 
displayed to the audience. This tab offers several commands and features to 

make your slide show smooth, engaging, and professional. Slide show tab is divided 
into three groups: Start Slide Show, Set Up and Monitors.
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Animations can also be reordered using the mouse, by dragging the selected animation in the Animation Pane to 
the desired location.

TIP
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START SLIDE SHOW GROUP
The	commands	of	this	group	allow	you	to	start	the	slide	show	either	from	the	first	
or the current slide. It also enables you to setup customized slide shows.

STARTING A SLIDE SHOW
Slide Show displays a single screen of information showing text, images or other 
objects along with associated transitions and animations during a presentation. 
The Start Slide Show group contains the following commands:

 From Beginning: This command allows you to start the slide show  from 
the	first	slide	of	the	presentation.

 From Current Slide: This command allows you to start the slide show 
from the current slide of the presentation. 

NAVIGATION IN THE SLIDE SHOW
You	can	use	the	Mouse	or	the	Keyboard	to	navigate	between	the	slides	during	
the slideshow.

To Navigate during the slide show, 
 Click on the Left	arrow button to move to 

the previous slide. 
 Click on the Right arrow button to move to 

the next slide.

A
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Keyboard Shortcuts:

Slide show from beginning – F5 key

Slide Show from current slide – Shift + F5

TIPS

Use the Left or Up arrow keys to move to the previous slide and Right or Down arrow keys to move to the next slide 

during the slide show.

TIP
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SETTING A CUSTOM SLIDESHOW
Custom Slide Show command allows you to create a customized slide show by 
choosing only the required slides of the presentation. This is a great way to 
shorten your presentation or alter it for different audiences.

To set a customized slide show, follow the steps given below: 
 Click on the Custom Slide Show command from the Start Slide Show 

group.
 Click on the Custom Shows option that appears.
 Click on the New button from the Custom Shows dialog box.
 Choose the required slides from the Define	Custom	Show dialog box.
 Click on the Add button to add only those slides that are required in the 

presentation.
 Click on the OK button.
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The Hide Slide command from the Set Up group is used to hide slides that you don’t want to display during the slide 

show.
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VIEW TAB  
You can view your PowerPoint slides in a variety of ways depending on the tasks in 
hand. For example, the Normal view is suitable to create or design your presentation 
whereas the Slide Sorter View lets you view the thumbnails of all the slides in your 
presentation.

PRESENTATION VIEWS GROUP
By default, PowerPoint 2016 starts in the Normal View. You can change the view 
either from the Presentation Views group of the View tab or from the Status bar.

Following are the presentation views available in PowerPoint 2016:
 Normal View: This view is the main editing 

view where you can create and design your 
presentations.

 Outline View: This view is used to 
create an outline or story board for your 
presentation. It displays only the text on 
your slides, hiding the pictures or other 
graphical objects.

 Slide Sorter View: This view allows you to 
see your slides in thumbnail form, enabling you to sort and organize the 
sequence of your slides.

 Notes Page View: This view enables you to type notes related to the 
current slide in the notes pane, located below the slide.

 Reading View: This view enables you to play a slide show in the PowerPoint 
window to see the animations and transitions without switching to full 
screen slide show.

MASTER VIEWS GROUP  
The Slide Master view allows you to set the look of your entire presentation, which 
includes fonts, colors, backgrounds and effects. A Slide Master is designed to help 
you create visually appealing presentations with less efforts and time. You can set 
particular fonts or images (such as logos) to all your slides using the Slide Master.

A

B

C

D

E

A B

C

D E

You can use the different view buttons available on the status bar to switch to the desired view or to Show the 

presentation.

TIP
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CREATING A SLIDE MASTER
Slide Master command enables you to make changes  to the slide master of 
your presentation. It is the top most slide in the thumbnails pane on the left 
side of the screen.  

To insert an image in the Slide Master, follow the steps given below:
 Click on the Slide Master 

command from the Master 
Views group. 

 The presentation switches 
to the Slide Master view 
and the contextual Slide 
Master tab appears.

 In the thumbnails pane, scroll up and select the first	slide.
 Click on the Insert tab, insert any picture on the first	slide and move or 

resize as desired.
 Inserted Picture is moved and resized to the desired location 
 When	you’re	finished,	click	on	the	Slide Master tab.
 Click on the Close Master View command. 
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ACTIVITIES

Activity 1

Choose the correct option for the following statements.
1. ________ are the effects that occur when slides move from one slide to the 

next during the slideshow.

a. Design

b. Transitions

c. Preview

d. Slide Master 

2.	 Keyboard	shortcut	to	start	slideshow	from	the	first	slide	is	______.

a. Shift + F5

b. Ctrl + F5

c. Alt + F5

d. F5

3. _______is the main editing view, used to create and design your presentations.

a. Outline View

b. Reading View

c. Normal View

d.  Outline View

4. You can set particular fonts or image to all your slides using the ____ 
command.

a.  Animations

b. Transitions

c. Preview

d. Slide Master 
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Activity 2

Fill in the blanks with the appropriate words provided in the 
box.

Reading View Animation Pane Duration Outline View Animations

1. ______ option is used to increase or decrease the time length of a transition.

2. ______ are the special visual or sound effects that are applied to the objects 
of the slides.

3. ______ view is used to display only the text on your slides.

4. ______ helps you to view and edit the applied animations of the objects.

Activity 3

Practice the following tasks on your computer.
1. Create a new blank presentation with 3 slides. Add the transition effect 

“Push” to all slides in the presentation. 

2. Insert the shape “sun” to the slide 2 and apply a “Wheel” entrance animation 
to it. Apply duration of 4 seconds and set effect option “2 Spokes”.

3. Add an additional animation “Grow/Shrink” to the shape “sun”.

4. Hide the slide 3 from the presentation and run the presentation in slide show 
view.
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